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FOREWORD

The National Instructional Media Institute (NIMI) is an autonomous body under the Directorate General of Em-
ployment and Training (DGE&T) Ministry of Labour and Employment has been developing, producing and dis-
seminating Instructional Media Packages (IMPs are extensively used in the Industrial Training Institutes/Train-
ing centres in  Industries to impart practical training and develop work-skills for the trainees and the trainers

The Ministry of Labour & Employment constituted Mentor Councils (MCs) to revampcourses run / to be run
under National Council of Vocational Training (NCVT) in 25 sectors. The MCs have representatives from thought
leaders among various stakeholders viz. one of the top ten industries in the sector innovative entrepreneurs who
have proved to be game-changers, academic/professional institutions (IITs etc.), experts from field institutes of
DGE &T, champion ITIs for each of the sectors and experts in delivering education and training through modern
methods like through use of IT, distance education etc. The technical support to the MCs is provided by Central
Staff Training and Research Institute (CSTARI), Kolkata and National Instructional Media Institute (NIMI), Chennai.
Some of the MCs are also supported by sector-wise Core Groups which were created internally in the Ministry
(in 11 sectors).

A Steering Committee to provide overall coordination and guidance to Mentor Councils has also been constituted
and has representation from the MCs, Chair positions to be endowed by the Ministry, trade unions, and experts
on distance education and training. The MCs are mandated to work towards revamping/suggesting new courses,
improving assessment systems, overall learning etc. for subjects under the purview of the NCVT.

Accordingly NIMI with the support and assistance of  MC has developed Architectural Assistant Trade Practical
2nd Semester in Construction, Construction Material & Real Estate sector to enhance the   employability of
ITI trainees across the country and also to meet the industry requirement.

I have no doubt that the trainees and trainers of ITIs & Training centres in industries will derive maximum benefit
from these books and that NIMI's effort will go a long way in improvement of Vocational Training.

I complement Director, Mentor Council members, Media Development Committee (MDC) members and staff of
NIMI for their dedicated and invaluable contribution in bringing out this publication.

ALOK KUMAR, I.A.S.,
Director General of Employment &

Training/ Joint Secretary
Ministry of Labour and Employment

Government of India

New Delhi - 110 001
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PREFACE

This National Instructional Media Institute (NIMI) was set up at Chennai by the Directorate General
of Employment and Training (DGE&T) Ministry of Labour and Employment, Government of India
with technical assistance from the Govt. of the Federal Republic of Germany. The prime objective
of this institute is to develop and disseminate instructional materials for various trades as per the
prescribed syllabi under the Craftsmen and Apprenticeship Training Schemes.

The instructional materials are developed and produced in the form of Instructional Media Packages
(IMPs). An IMP consists of Trade Theory book, Trade Practical book, Test and Assignment book,
Instructor guide, Wall Charts and Transparencies.

Hon'ble Union Minister of Finance during the budget speech 2014-2015 mentioned about developing
Skill India and made the following announcement

"A national multi-skill programme called Skill India is proposed to be launched. It would skill the
youth with an emphasis on employability and entrepreneur skills. It will also provide training and
support for traditional  professions like welders, carpenters, cobblers, masons, blacksmiths, weavers
etc. Convergence of various schemes to attain this objective is also proposed."

The Ministry of Labour & Employment constituted Mentor Councils (MCs) to revamp courses run /
to be run under National Council of Vocational Training (NCVT) in 25 sectors which will give a
sustained skill based employability to the ITI trainees  as the main objective of Vocational training.
The ultimate approach of NIMI is to prepare the validated IMPs based on the exercises to be done
during the course of study. As the skill development is   progressive the theoretical content on a
particular topic is limited to the requirement in every stage.  Hence the reader will find a topic
spread over a number of units. The test and assignment will enable the instructor to give assignments
and evaluate the performance of a trainee. If a trainee possesses the same it helps the trainee to
do assignment on his own and also to evaluate himself. The wall charts and transparencies are
unique, as they  not only help the instructor to effectively present a topic but also helps the trainees
to grasp the technical topic quickly. The instructor guide enables the instructor to plan his schedule
of instruction, plan the raw material requirement ,

Thus the availability of a complete Instructional Media Package in an institute helps the trainer and
management to impart an effective training. Hence it is strongly recommended that the Training
Institutes/Establishments should provide at least  one IMP per unit. This will be small, one time
investment but the benefits will be long lasting.

The Architectural Assistant Trade Practical 2nd Semester in Construction, Construction
Material & Real Estate sector is one of the book develop by the core group members of the
Mentor Councils (MCs). The 1st semester book includes Module 1 - , Module 2 - , Module 3 -  .

The Architectural Assistant Trade Practical 2nd semester is the outcome of the collective efforts
of Members of Mentor Council which includes academic/professional institutions (IITs etc.), experts
from field institutes of DGE&T, champion ITIs for each of the sectors, and also Media Development
Committee (MDC) members and staff of NIMI.

NIMI wishes that the above material (Trade Practical & Trade Theory) will fulfil to satisfy the long
needs of the Trainees and Instructor and helps the trainees for their employability in vocational
training.

NIMI would like to take this opportunity to convey sincere thanks to all the Mentor Council members and
Media Development Committee (MDC) members.

A.MAHENDIRAN
       Director, NIMI.

Chennai - 600 032
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INTRODUCTION

TRADE PRACTICAL

The trade practical manual is intented to be used in workshop . It consists of a series of practical exercies to
be completed by the trainees during the  Second  Semester course  of the Architectural Assistant trade
supplemented and supported by instructions/ informations to assist in performing the exercises. These
exercises are designed to ensure that all the skills in the  prescribed syllabus are covered.

The manual is divided into Three modules.  The distribution of Exercises for the practical in the four modules
are given below.

Module 1 21 Exercises

Module 2 19 Exercises

Module 3 06 Exercises

       Total 46 Exercises

The skill training in the shop floor is planned through a series of practical exercises centred  around some
practical project. However, there are few instance where the individual exercise does not form a part of project.

While developing the practical manual a sincere effort was made to prepare each exercise which will be easy
to understand and carry out even by below average traninee. NIMI, looks forward  to the suggestions from the
experienced training faculty for improving the manual.

TRADE THEORY

The manual of trade theory consists of  theoretical information for the Second Semester course of the
Architectural Assistant Trade.  The contents are sequenced according to the practical exercise contained in
the manual on Trade practical.  Attempt has been made to relate the theoretical aspects with the skill  covered
in each exercise to the extent possible. This co-relation is maintained to help the trainees to develope the
perceptional capabilities for performing the skills.

The Trade theory has to be taught and learnt along with the corresponding exercise contained in the manual
on trade practical. The indicating about the corresponding practical exercise are given in every sheet of this
manual.

It will be preferable to teach/learn the trade theory connected to each exercise atleast one class before
performing the related skills in the shop floor. The trade theory is to be treated as an integrated part of each
exercise.

The material is not the purpose of self learning and should be considered as supplementary to class room
instruction.
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  Exercise No.                                Title of the Exercise     Page No.

Module 1 :

2.1.01 Starting procedure of CAD 1

2.1.02 Basic CAD drafting commands - I 17

2.1.03 Drafting of furnitures (Three seater sofa) 25

2.1.04 Basic CAD drafting commands - II 26

2.1.05 Drafting of furniture (Door elevation - 2) 40

2.1.06 Basic CAD drafting commands - 2 42

2.1.07 Drafting of bed room interiors in CAD 54

2.1.08 Drafting settings in CAD 57

2.1.09 Advanced drafting commands - I 66

2.1.10 Advanced drafting  commands - II 80

2.1.11 Advanced drafting commands - III 96

2.1.12 Design bubble diagram (Manual) 118

2.1.13 Development of conceptual design (Manual) 121

2.1.14 Design single line ground floor plan (Manual) & first floor plan 123

2.1.15 Draw preliminary ground floor plan and first floor plan (CAD) 126

2.1.16 Draw final ground floor plan and first floor plan with furniture layout (CAD) 132

2.1.17 Design development of front elevation and one side elevation (Manual) 138

2.1.18 Draft preliminary front elevation and one side elevation (CAD) 141

2.1.19 Draw final front elevation and one side elevation with rendering (CAD) 144

2.1.20 Develop section of the building through staircase (CAD) 147

2.1.21 Draw final section of the building with rendering (CAD) 149

Module 2 :

2.2.01 Drawing of different types of arches 151

2.2.02 Drawing of different types of lintels 153

2.2.03 Draw plan and elevation of straight stairs 155

2.2.04 Draw plan and elevation of open well stairs 157

2.2.05 Draw plan and elevation of bifurcated stairs 160

2.2.06 Draw plan and elevation of geometrical stairs 162

2.2.07 Draw plan and elevation of circular stairs 163

CONTENTS
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2.2.08 Draw the construction details of RCC dog legged stairs 166

2.2.09 Draw the construction details of MS spiral stairs 169

2.2.10 Draw details of wooden stairs 171

2.2.11 Draw the different components of floor 175

2.2.12 Draw the details of cement concrete floor 176

2.2.13 Draw the details of wooden floor (Upper floor) 177

2.2.14 Draw lean to roof details 179

2.2.15 Draw flat roof details 180

2.2.16 Draw the fixing details of AC sheets and corrugated sheets 181

2.2.17 Draw details of king post truss 183

2.2.18 Draw details of queen post truss 185

2.2.19 Draw details of steel roof truss 187

Module 3 :

2.3.01 Draw the water supply layout plan for toilet and kitchen 190

2.3.02 Draw drainage layout plan for toilet and kitchen 193

2.3.03 Draw gully trap, details 194

2.3.04 Draw man hole details 196

2.3.05 Draw site plan showing building services 200

2.3.06 Draw rain water harvesting details 202

  Exercise No.                                Title of the Exercise     Page No.
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PROCEDURE

Screen appearance

1 2007 AutoCAD screen appearance (Screen is in AutoCAD Classic)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.01

Starting procedure of CAD
Objectives: At the end of this exercise you shall be able to
• screen appearance of CAD
• work spaces
• tool baras in AUTOCAD
• loading toolbars
• application button
• toolbars
• setting of units.

Fig 1
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2 2010 AutoCAD appearance (Screen is in 2D and annotation)

Point to be noted

1 Do not get confused with the screen appearance.

2 Screen appearance change according to the work
space selection.

Workspaces

You can switch between the workspaces from the menu
browser.

1 Click the workspace switching icon in the lower left
corner of the screen. (Fig 3)

Fig 2

Fig 3

2 Click on one of the following workspace options. (Fig
4)

Fig 4

CCM&RE : Architectural Assistant - Exercise 2.1.01
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AutoCAD classic workspace (Fig 5)

Fig 5

Toolbars in AutoCAD

Activating Toolbars:

Toolbars activate by clicking DTM (right-click) in the territory
where the Text menu, just below the zone where the other
toolbars, or via a text menu.

To set the Toolbar click on View => Toolbars on the text
menu.

The most widely used toolbars (toolbars) markup are bold.

CAD Standard

Camera Adjustment

Dimension

Draw

CCM&RE : Architectural Assistant - Exercise 2.1.01
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Order

Inquiry

Insert

Layers

Layers II

Layouts

Lights

Mapping

Modeling

Modify

Modify II

Object snap

Orbit

Properties

Refedit

CCM&RE : Architectural Assistant - Exercise 2.1.01
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Reference

Render

Solid Editing

Standard

Styles

Text

UCS

UCS II

View

View ports

Visual Styles

Walk and Fly

Web

Workspaces

Zoom

CCM&RE : Architectural Assistant - Exercise 2.1.01
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Loading Toolbars

Right - clicking on an icon in any toolbar

This will show a list of all available toolbars.

Note: To bring in tool bars to the screen. When no toolbar
appears on your screen do not panic, just go to "tools
option" which you can see on the top at your screen
(maintool bar). In that click "toolbar" now you can see an
image like the image shown in the figure, now select
whatever tool bars you need.

(or)

Just type in 'tool' in the command bar and follow the
instruction given in it. (Fig 6)

Application button (or) menu bar (or) popup menu
bar:

The large, red A at the top, left-hand corner of the screen
is the application button.  Use it to print files, to exit the
program etc.

1 Click on the A icon.

2 Click the desired pulldown menu.

3 Click on the command to be executed from the
pulldown. (Fig 8)

Help Tooltips

1 Move the mouse to the toolbar but do not pick the
button. (Fig 7)

The workspace in AutoCAD is divided into 2 distinct ar-
eas.  The drawing area covers most of the screen and tool
bars are anchored above and below the drawing area.  They
include:

Fig 7

Fig 6
Fig 8

2 Quick Access Toolbar

i) Click on one of the following icons for quick access to
commands QNEW, OPEN, SAVE, PLOT, and UNDO/
REDO. (Fig 9)

Right-click the Quick Access toolbar and click Cus-
tomize Quick Access Toolbar.  The Customize User
Interface dialog opens and displays the list of com-
mands available.

CCM&RE : Architectural Assistant - Exercise 2.1.01
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3 Ribbon

The ribbon provides a single, compact placement for
operations that are relevant to the current workspace.  It
eliminates the need to display multiple toolbars, reducing
clutter in the application window.  The ribbon maximizes
the area available for work using a single compact interface.
The ribbon can be displayed horizontally, vertically, or as
a floating palette.  The horizontal ribbon is displayed at
the top of the drawing window by default when you create
or open a drawing.  You can create your own panels to
display on the ribbon; you can also modify the commands
and controls on existing ribbon panels.(Fig 11)

4 Status bar

The toolbar across the bottom of the screen is the status
bar.  It mostly consists of control settings that allow you
to monitor changes in the drawing. (Fig 12)

Fig 9

Drag commands you want to add from the command
list pane in the Customize User Interface dialog box to
the Quick Access toolbar.

Info Center

Quickly search for a variety of information sources, access
product updates and announcements, and save topics with
InfoCenter. (Fig 10)

Fig 10

Fig 11

Fig 12

5 Command/prompt tool bar

Directly above the status bar is the command /prompt
toolbar. This is where the software communication with
you. (Fig 13)

6 Create a new drawing

From the quick-access toolbar, click "File," and then "New."
The new drawing will use 1 of 2 default settings, either
imperial or metric.  If you want to use specific settings for
a drawing, select "Templates" under the Options dialog
box. (Fig 14)

CCM&RE : Architectural Assistant - Exercise 2.1.01
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Fig 13

Fig 14

CCM&RE : Architectural Assistant - Exercise 2.1.01



9

7 Locate the small gear icon at the bottom of the
screen.

This is the Workspace icon.  Click it and select "AutoCAD
Classic". AutoCAD classic is user friendly. (Fig 15)

8 Plotting

When you have done the assignment, the next step is to
print (or plot) it out.  To do this, bring up the plot dialog box
using any method explained above (plot <enter> will work).
Set it up to print as shown below.  Follow these steps for
a successful plot (see diagram below) (Fig 16)

Fig 15

Fig 16

CCM&RE : Architectural Assistant - Exercise 2.1.01
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1 Select your printer - laser or inkjet will work fine.

2 Select the paper size - "Letter" (8-1/2" x 11") is needed
in this case.

3 For the "Plot Area", select "Extents" - that will plot
everything you drew.

4 Select the checkbox to "Center the Plot" on your sheet
of paper (looks better).

5 If "Fit to Paper" is selected by default, uncheck it and
select a scale of 1 inch to 1 paper unit (1:1). This will
make your printout 'life-sized'.

6 Now Preview your drawing.  I strongly recommend that
you preview EVERY drawing you will ever draw in
AutoCAD - a lot can go wrong, so you don't want to
waste paper (especially when you're using expensive
3' x 4' sheets!). If your preview looks good, Cancel out
of the preview by pressing ESC.

7 If you're sure that everything's ok (this is where good
habits begin), press the OK button.

Note : You may have to change the paper size
in your printer (Use the Windows printer
settings to do this.) You may also have to
change the rotation or origin of the plot.  Check
the Landscape radio button in the Drawing
Orientation section.

If everything worked out, you should be able to measure
your drawing and have it exactly the way you drew it (a
couple of 2" squares, an angled 1" square and a 1-1/
2"circle).

Save your drawing as you would any other Windows file.
CTRL+S will bring up the Save or Save as dialog box.

Status tool bar mod’s work

As part of the window AutoCAD is its status toolbar that
contains buttons for ON/OFF function groups during the
drawing.  When the button is pressed then the active group
of concerned functions to their preferences.  The status
bar contains buttons for the function: SNAP, GRID, ORTHO,
POLAR, OSNAP, OTRACK, DUCS, DYN, LWT, MODEL.

I usually start with the following function buttons including:
Ortho, Osnap, Otrack and Model.

During the work started drawing a line you can freely activate
and deactivate some of the buttons in the status bar, without
fear that will stop the action begun drawing a line.

For example: (AutoCAD tangent to the circle) when you
start to draw a line and clicking on the desktop and then
you want to connect to the line tangent to the circle already
drawn for which sight is not included, simply click on the
button OSNAP right mouse button, select the option for
the tangent sight click on OK and continue to target the
tangent circles in the drawing.

Note that once you start a drawing and you clicked first
click to start, no problem you can switch to another window
or a function button in the status bar (Help AutoCAD, IE,
OE, Photoshop, etc.) and then back into working AutoCAD
window and continue with his drawing. (Fig 17)

Fig 17

Right click on the blank area of the status bar to see the
tools to turn off/on. (Fig 18 , Fig 19 & Fig 20)

1 ORTHO : Orthogonal drawing or rectangular drawing,
it means that when you turn this feature lines that you
drag the mouse will be angled in relation to the UCS
and you can draw only the angle that is set and it is 90
degrees. (Fig 21)

2 POLAR : Polar coordinates follow when you draw the
line, if this function is activated then the Ortho
automatically turned off.  because when you draw with
the POLAR function of the mouse you can draw lines
at an angle to the set and you can also set up and
draw it with absolute or relative coordinates when
drawing lines. (Fig 22)

CCM&RE : Architectural Assistant - Exercise 2.1.01



11

Fig 18 Fig 19

Fig 20

CCM&RE : Architectural Assistant - Exercise 2.1.01
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Fig 21

Fig 22

Now wouldn't it be cool to draw angled lines (like the short
ones in the above image)? Well you can, but first you
have to make change in your settings.

Type in DSETTINGS and you get the Drafting Settings
dialog box, go to the "Polar Tracking" tab.

Then make sure that Polar Tracking is On

(press your
F10 key to toggle it on and off) and then select the

increment angle.  I recommend using polar settings

with 45° increments unless you specifically need something
else.

In the example above, I made 4 lines 1 unit long using
Direct Distance Entry (DDE). See if you can duplicate
this on the left end of the 10 unit line you just drew.  The
process is the same as you did for the DDE of the previous
line.  Make sure your increment angle is 30° and draw a
line 1 unit long using DDE. (Fig 23)

You cannot have Ortho and Polar Tracking on at the same
time.  As you start to draw more, you will see that these
two features are great time savers.  There will be times,
though, when you have to use absolute and relative
coordinate entry (especially in 3D). (Fig 24)

Fig 24

OSNAP Aiming (target) at a particular point of a line derived
from activated Osnap which contains some basic positions
on the line, circle, image, and the like.  Endpoint, midpoint,
and other sights for other points of attachment appear
only.

CCM&RE : Architectural Assistant - Exercise 2.1.01
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When we turn Osnap mode (and turn on each target).  All
lines in the figure, circles, etc.. have a connecting point
for the target, so to distinguish GRIP (grips) of the target.

BTW: Hindsight is like a magnet, when you approach a
point of attachment and appears hindsight, whether you're
precisely on a given point or not, just click and Autocad
will bind to the target presented.

SO pay attention! when you close more tombstones (zoom
in enough to see a drawing of a tombstone that bind)

OSNAP mod: F3 => Endpoint, Midpoint, Center, Node,
Quadrant, Intersection, Extension.

You may select whichever points you want to 'snap' on an
object.  Here is a list of your options.  Followed by the
command entry to invoke the needed Osnap.

Endpoint - snaps to either the beginning or the end of an
object such as a line - END

Midpoint - snaps to the exact middle of a line or an arc -
MID

Center - snaps to the center - point of a circle or arc - CEN

Node - snaps to 'nodes' (not covered in this course) - NOD

Quadrant - snaps to any of the four quadrants of a circle -
QUA

Intersection - snaps to the point where two object cross -
INT

Extension - Snaps to the phantom extension of an arc or
line -EXT

Insertion - snaps to the insertion point of an object (such
as a block or text) - INS

Perpendicular - will snap so that the result is perpendicular
to line selected - PER

Tangent - snaps to create a line tangent to a circle or arc
- TAN

Nearest - will find the closest point an object and snap to
that point - NEA

Parallel -  Snaps parallel to a specified line - PAR

M2P - This isn't technically an 'Object Snap' as you are
not snapping to specific point on an object, but it allows
you to select 2 points and it will calculate the midpoint
between those 2 points.  This is a very handy option to
have. (Fig 25)

6 OTRACK (object snap tracking) - F11 -  Intersection,
Perpendicular, Tangent, Nearest, Apparent intersection,
Parallel. (Fig 26)

Fig 25

Fig 26

If you turn OTRACK/POLAR mode then you have an
active extra dashed line that helps you draw the line to
align with a line (point) to the already drawn parts of the
drawings.

How does OTRACK mod?

Including button functions to incorporate the ancillary mode
OTRACK a line that helps in drawing the mouse and the
eventual completion of a placement - line, ie. its end point.
For instance: when you draw more lines and one line you
want to end up in the level of existing lines hover your

CCM&RE : Architectural Assistant - Exercise 2.1.01
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mouse on the desired line ( it will be dashed shed that will
create a temporary intersected lines and their intersec-
tion) and then move it to where you want to complete the
intended line.  See the picture below. (Fig 27)

Fig 27

So start drawing with the mouse and at some point
(item 4) when we want to end up in the vertical scale (for
drawing items 1) move the cursor to the endpoint of point
1 and then shifting it down (then appearing auxiliary dashed
lines) following the vertical dashed line while we mark the
intersection on her second set in a vertical line and click
the mouse.

Now we are confident that our 5 point within the vertical
line in the direction of the line item

7 DUCS : Turning Dynamic UCS and the adhesive on a
plane or surface of the body, while the included DUCS
and clicking on the icon on the toolbar Origin UCS and
then to position the cursor on any surface of the body,
it automatically means the surface (hatched) and when
clicking on it  UCS for ecological surface and
positioning. (Fig 28)

Fig 28

8 DYN : Turning Dynamic Input for information when
drawing (F12) (Fig 29)

Fig 29

9 LWT : Turning Lineweight, viewed thick lines.  When
this button is included then we have shown with their
line thicknesses, if you turn off all the lines the same
thickness.

Dimension Style

5 After setting the units set the dimension with the
instruction given below.

a Creating Dimension Styles

1 Choose Format, Dimension Style...

or

2 Choose Dimension, Style.

or

3 Choose Dimension Style icon from the
Dimension Style toolbar.

4 Type DDIM at the command prompt

Command: DDIM

5 Choose New... from the dialog box.

6 Create a new style from the existing styles.

7 Click the Continue button.

CCM&RE : Architectural Assistant - Exercise 2.1.01
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TIP

All dimension variables except for DIMSHO and DIMASO
can be saved as a style.

UNITS Command

1 Choose Format, Units...

   or

2 Type DDUNITS at the command prompt.

Command: DDUNITS or UN

3 Choose a units and angle setting.

4 Choose a precision setting. (Fig 30)

Fig 30

b Lines and Arrows

Edits Dimension Lines, Extension Lines, and Arrows.

1  Pick     the Lines and Arrows tab from the Dimension
   Variables and Styles dialog box. (Fig 31 & Fig
   32)

c Text

Edits Text Appearance, Text Placement and Text
Alignment.

1  Pick the Text tab from the Dimension Variables
and Styles dialog box. (Fig 33)

Fig 31

Fig 32

CCM&RE : Architectural Assistant - Exercise 2.1.01
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Fig 33

d Primary Units

Edits Unit options for dimension's primary units.

Fig 34

1  Pick the PRIMARY UNIT tab from the
dimension Variables and Styles
dialog box. (Fig 34)

2 Whatever unit format and precision you have entered
for units same thing you have to enter in primary units.

e  Alternate Units

Edits Unit options for dimension's alternate units.

1  Pick the ALTERNATE UNIT tab from the
Dimension Variables and Styles
dialog box. (Fig 35)

Fig 35

f  Tolerance

Edits Unit options for tolerances.

1  Pick the TOLERANCES tab from the
Dimension Variables and Styles
dialog box. (Fig 36)

Fig 36

CCM&RE : Architectural Assistant - Exercise 2.1.01
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PROCEDURE

TASK 1 : Line

Command alias Button Classic menu Ribbon/Application menu

L  Draw => Line    Home => Draw => Line

With LINE, you can create a series of continuous line
segments.  Each segment is a line object that can be
edited separately.

The following prompts are displayed.

Specify first point:  Specify a point or press Enter to
continue from the last drawn line or arc

Specify next point or [Close/Undo]:

Continue

Continue a line from the endpoint of the most recently
drawn line.

Close

Ends the last line segment at the beginning of the first line

segment, which forms a closed loop of line segments.
You can use Close after you have drawn a series of two or
more segments.

Undo

Erases the most recent segment of a line sequence.  Using
this option more than once backtracks through line
segments in the order you created them.

To start a new line at the endpoint of the last
line drawn, start the LINE command again and
press Enter at the specify start point prompt.

TASK 2 : Circle

Command alias Button Classic menu Ribbon/Application menu

C  Draw => Circle         Home => Circle

Drawing a circle in Auto CAD is rather simple. The default
method for drawing a circle is to specify a center point
and a radius. You can also choose to create a circle based
on a diameter, circumference, or area.

The following options are displayed;

Specify center point for circle or [3p/2p/Ttr (tan tan ra-
dius)]: Specify a point or enter an option

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.02

Basic CAD drafting commands - 1
Objectives: At the end of this exercise you shall be able to
• understand the basic drafting commands
• line
• circle
• arc
• ellipse
• copy
• move
• rotate
• erase
• undo
• mirror
• offset.
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Center Point

Draws a circle based on a center point and a diameter or
a radius.

Radius

Defines the radius of the circle.  For this, you are required
to enter a value, or specify a point. (Fig 1)

Diameter

Defines the diameter of the circle. Enter a value, or specify
a second point. (Fig 2)

TASK 3 : Arc

Command alias Button Classic menu Ribbon/Application menu

A  Draw => Arc    Home => Arc

To create an arc, you can specify combinations of center,
endpoint, start point, radius, angle, chord length, and
direction values.  Except the first method, arcs are drawn
counter clockwise from the start point to the endpoints.

The following options are displayed: (Fig 3)

Start, Center, End

This method helps to create an arc using a start point,
center, and a third point that determines the endpoint. The
distance between the start point and the center determines
the radius. The endpoint is determined by a line from the
center that passes through the third point. The resulting
arc is always created counterclockwise from the start point.
Using different options, you can specify either the start
point first or the center point first.

Start, Center, Angle

This method helps to create an arc using a start point,
center, and an included angle. This distance between the
sgtart point and the center determines the radius.  The
other end of the arc is determined by specifying an included
angle that uses the center of the arc as the vertex.  The
resulting arc is always created counterclockwise from the
start point.  Using different options, you can specify either
the start point first or the center point first

CENTRE RADIUS

3 Points

This method helps to create an arc by specifying three
points. (Fig 4)

Fig 3

CCM&RE : Architectural Assistant - Exercise 2.1.02
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3P (Three Points)

Draws a circle based on three points on the circumference
as shown in the Fig 5.

Tan, Tan, Tan

Creates a circle tangent to three objects.

2P (Two Points)

Draws a circle based on two endpoints of the diameter. As
shown in the Fig 6.

TTR (Tangent, Tangent, Radius)

Draws a circle with a specified radius tangent to two
objects. As shown in Fig 7.

Sometimes more than one circle matches the specified
criteria.  The program draws the circle of the specified
radius whose tangent points are closest to the selected
points.

Start, Center, Length

This method create an arc using a start point, center, and
the length of a chord.  The distance between the start
point and the center determines the radius.  The other end
of the arc is determined by specifying the length of a chord
between the start point and the endpoint of the arc.  The
resulting arc is always created counterclockwise from the
start point.  Using different options, you can specify either
the start point first or the center point first. The length of
the chord in the arc determines the included angle. (Fig 9)

Start, End, Angle

This method creates an arc using a start point, endpoint,
and an included angle. The included angle between the
endpoints of the arc determines the center and the radius
of the arc.

Start, End, Direction (Fig 10)

This method create an arc using a start point, endpoint,
and a tangent direction at the start point. The tangent
direction can be specified either by locating a point on the
desired tangent line, or by entering and angle.  You can
determine which endpoint controls the tangent by
changing the order in which you specify the two endpoints.

The included angle determines the endpoint of the arc.
Use the Start, End, Angle method when you know both
endpoints but cannot snap to a center point. (Fig 8)
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Start, End, Radius

This method creates an arc using a start point, endpoint,
and a radius.  The direction of the bulge of the arc is
determined by the order in which you specify its endpoints.
You can specify the radius either by entering it or by
specifying a point at the desired radius distance. (Fig 11)

Centre, Start, End

This method helps to create an arc using a center, start
point, and a third point that determines the endpoint. The
distance between the start point and the center determines
the radius.  The endpoint is determined by a line from the
center that passes through the third point. The resulting
arc is always created counterclockwise from the start point.
Using different options, you can specify either the center
point first or start the point first.  This method is same as
the start center and end method except that the first point
is specified is center instead of start.

Center, Start, Angle

This method helps to create an arc using a center, start
point, and an included angel.  The distance between the
start point and the center determines the radius.  The
other end of the arc is deermined by specifying an included
angle that uses the center of the arc as the vertex. The
resulting arc is always created counterclockwise from the
start point.  Using different options, you can specify either
the point first center or the start point first.

Start, Center, Length

This method create an arc using a center, start and the
length of a chord. The distance between the start point
and the center determines the radius. The other end of the
arc is determined by specifying and included angle that
uses the center of the arc as the vertex.  The resulting arc
is always created counterclockwise from the start point.
Using different options, you can specify either the point
first center or the start point first.

Start, Center, Length

This method create an arc using a center, start and the
length of a chord.  The distance between the start point
and the center determines the radius.  The other end of
the arc is determined by specifying the length of a chord
between the start point and the endpoint of the arc.  The
resulting arc is always created counterclockwise from the
start point.  Using different options, you can specify either
the start point first or the center point first.  The length of
the chord in the arc determines the included angle.

Continuous

Immediately  after the creation of an arc, you can start a
line that is tangent to the arc at an endpoint by starting
the LINE command and pressing Enter at the specify First
Point Prompt.  You need to specify only the line length.
Immediately after you create a line or an arc, you can
start an arc that is tangent to an endpoint by starting the
ARC command and pressing Enter at the Specify Start
Point prompt.  You need to specify only the endpoint of
the new arc. (Fig 12)

TASK 4 : Ellipse

The shape of ellipse is just an oblong or an oval, with the
major and minor axis.

The following prompts are displayed;

Specify axis endpoint of ellipse of [Arc/Center/Isocircle]:
Specify a point or enter an option

Command alias Button Classic menu Ribbon/Application menu

EL  Draw => Ellipse Home => Ellipse
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Axis End point

Defines the first axis by its two endpoints.  The angle of
the first axis determined the angle of the ellipse.  The first
axis can define either the major or the minor axis of the
ellipse.

Distance to Other Axis

Defines the second axis using the distance from the
midpoint of the first axis to the endpoint of the second
axis.

Rotation

Create the ellipse by appearing to rotate a circle about the
first axis.  Move the crosshairs around the center of the
ellipse and click.  If you enter a value, the higher the value,
the greater the eccentricity of the ellipse. Entering 0
defines a circular ellipse. (Fig 13)

Arc

It creates an elliptical arc. The angle of the first axis
determines the angle of the elliptical arc.  The first axis
can define either the major or the minor axis depending on
is size. The first two points of the elliptical arc determine
the location and length of the first axis.  The third point
determines the distance between the center of the elliptical
arc and the endpoint of the second axis.  The fourth and
fifth points are the start and end angles.

Axis Endpoint

It defines the start point of the first axis. (Fig 14)

Rotation

Defines the major to minor axis ratio of the ellipse by
rotating a circle about the first axis. The higher the value
from 0 through 89.4 degrees, the greater the ratio of minor
to major axis. Values between 89.4 degrees and 90.6

degrees are invalid because the ellipse would otherwise
appear as a straight line.  Multiples of these angle values
result in a mirrored effect every 90 degrees. (Fig 15)

Start Angle

Defines the first endpoint of the elliptical arc. The Start
Angle option toggles from Parameter mode to angle mode.
The mode controls how the ellipse is calculated.

Center

Creates an ellipse using a center point, the endpoint of
the first axis, and the length of the second axis. You can
specify the distances by clicking a location at the desired
distance or by entering a value for the length. (Fig 16)

Distance to other Axis

Defines the second axis as the distance from the center
of the ellipse, or midpoint of the first axis, to the point you
specify.

Rotation

Creates the ellipse by appearing to rotate a circle about
the first axis. Move the crosshairs around the center of
the ellipse and click.  If you enter a value, the higher the
value, the greater the eccentricity of the ellipse. Entering
0 defines a circle, for instance.

Isocircle

Creates an isometric circle in the current isometric
drawing plane.

The isocircle option is available only when you
set the style option of SNAP to isometric.

Radius

Creates a circle using a radius you specify.

Diameter

Creates a circle using a diameter you specify.
CCM&RE : Architectural Assistant - Exercise 2.1.02
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TASK 5 : Copy

Command alias Button Classic menu Ribbon/Application menu

CO  Modify => Copy Home => Modify => Copy

The copy tool allows copying an existing object. This tool
is used to make copies of the selected object and place
them at specified location.

The following Prompts are displayed;

Select objects:

Specify base point or [Displacement/mode/Multiple]
<Displacement>:

Specify second point or [Array] <use first point as
displacement>:

Displacement

Specifies a relative distance and direction using
coordinates.  The two points you specify define a vector
that indicates how far the copied objects are to be placed
from the original and also in what direction. If you press
Enter at the Specify Second Point prompt, the first point
is interpreted as a relative X, Y, Z displacement.

Mode

Controls the automatic repetition of the command.
(COPYMODE system variable).

Single

Creates a single copy of selected objects and ends the
command.

Multiple

Overrides the single mode setting. The COPY command
is set to repeat automatically for the duration of the
command.

Array

Arrange a specified number of copies in a linear array.

Number of items to Array

Specifies the number of items in the array, including the
original selection set.

Second point

Determines a distance and direction for the array relative
to the base point.  BY default, the first copy in the array is
positioned at the specified displacement. The remaining
copies are positioned in a linear array beyond that point
using the same incremental displacement.

Fit

Positions the final copy in the array at the specified
displacement.  The other copies are fit in a linear array
between the original selection set and the final copy.

TASK 6 : Move

Command alias Button Classic menu Ribbon/Application menu

CO  Modify => Copy Home => Modify => Copy

The move tool is used to move one or more objects from
their current location to new location without changing their
size or orientation.

The following prompts are displayed;

Select objects:

Specify base point or [Displacement/mode/Multiple]
<Displacement>:

Specify second point or [Array] <use first point as
displacement>:

After selection the objects by using any one of the
selection techniques, you will be prompted to specify the
base point.  The base point is the reference point with

respect to which the object will be picked and moved.  On
specifying the base point, you will be prompt to specify
the second point of displacement. The two points you
specify define a vector that indicates how far the selected
objects are to be moved and in what direction.

If you press Enter at the specify Second Point prompt,
the first point is interpreted as a relative X, Y, Z
displacement. For example, if you specify 2,3 for the base
point and press Enter at the next prompt, the objects move
2 units in the X direction and 3 units in the Y direction from
their current position.

Displacement

Enter coordinates to represent a vector.  The coordinate
values that you enter specify a relative distance and
direction.
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TASK 7 : Rotate

Command alias Button Classic menu Ribbon/Application menu

RO  Modify => Rotate Home => Modify => Rotate

While creating designs sometimes we have to rotate an
object or group of objects. This requirement can be
accomplished by using Rotate tool.

The following prompts are displayed;

Current positive angle in UCS: ANGDIR = Current
ANGBASE = current.

Select objects:
Specify base point:
Specify rotation angle or [Copy/Reference]:

Rotation Angle

Determines how far an object rotates around the base
point. The axis of rotation passes through the specified
base point and is parallel to the Z axis of the current UCS.

Copy

Creates a copy of the selected objects for rotation.

TASK 8 : Erase

Command alias Button Classic menu Ribbon/Application menu

E  Modify => Erase Home => Modify => Erase

Erase helps to remove the objects from a drawing. To erase
the unwanted objects;

1) Activate the command.

2) At the Select Objects prompt, use a selection method
to select the objects to be erased or enter an option.

3) Press Enter to end the command.

TASK 9 : Undo

  Command alias     Shortcut key     Button Classic menu Ribbon/Application menu

U Ctrl + Z Edit => Erase Home => Modify => Erase

UNDO displays the command or system variable name at
the Command prompt to indicate that you have stepped
past the point where the command was used.

Undo has no effect on some commands and
system variables, including those that open,
close, or save a window or a drawing, display
information, change the graphics display,
regenerate the drawing, or export the
drawing in a different format.

The command has the following options.

Number

Undoes the specified number or preceding operations.  The
effect is the same as entering 'U' multiple times.

Auto

Groups the commands in a macro, such as a menu macro,
into a single action, making them reversible by a single U
command.

Control

Limits or turns off UNDO.

All

Turns on the full UNDO command.

None

Turns off the U and UNDO commands and discards any
UNDO command information saved earlier in the editing
session.  The Undo button on the Standard toolbar is
unavailable.  The Auto, Begin, and  Mark options are not
available when None or One is in effect.

One

Limits UNDO to a single operation. The main prompt for
the UNDO command changes to show that only a control
option or a single step of the UNDO command is available
when that particular option is in effect.

Layer

Controls whether the layer dialog operations are combined
as a single undo operation.

Begin, End

Groups a sequence of actions into a set.  After you enter
the Begin option, all subsequent actions become part of
this set until you use the End option.  Entering undo begin
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while a group is already active ends the current set and
begins a new one.  UNDO and U treat grouped actions as
a single action.

If you enter undo begin without undo end, using the Num-
ber option undoes the specified number commands but
does not back up past the beginning point.  If you want to
go back to before the beginning point, you must choose
the End option, even if the set is empty. The same applies
to the U command.  Mark placed by the Mark option dis-
appears inside an UNDO group.

TASK 10 : Mirror

Command alias Button Classic menu Ribbon/Application menu

E  Modify => Mirror Home => Modify => Mirror

It creates a mirror image of the selected object.  The user
defines two points, along which Auto CAD generates a
"line of reflection" and the reflected object is generated
across this line with all components reversed.

The following prompts are displayed;

Select objects:

Specify first point of mirror line:

Specify a point:

Specify second point of mirror line:

Erase source objects? [Yes/No]<N>:

The two specified points become the endpoints of a line
about which the selected objects are mirrored.

When you select 'Yes' in the prompt 'Erase source
objects?', Auto CAD places the mirrored image into the
drawing and erase the original objects.  Otherwise places
the mirrored image into the drawing and retains the
original objects.

Mark, Back

Mark places a mark in the undo information.  Back
undoes all the work done back to this mark.  If you undo
one operation at a time, you are informed when you reach
the mark.  You can place as many marks necessary.  Back
moves back one mark at a time, removing the mark.  If no
mark is found, back displays the following prompt:

This will undo everything. OK? <Y>:

Enter y to undo all commands entered in the current ses-
sion.  Enter n to ignore the back option.  When you we the
Number option to undo multiple actions, UNDO stops if it
encounters a mark.

TASK 11 : Offset

Command alias Button Classic menu Ribbon/Application menu

O  Modify => Offset Home => Modify => Offset

This command creates concentric circles, parallel lines
and parallel curve at a specified offset distance.

The following prompts are displayed;

Current settings : Erase source = current layer = current
OFFSETGAPTYPE = current

Specify offset distance of [Through/Erase/Layer] <current>

Offset distance

Creates an object at a specified distance from an existing
object.

Multiple

Enters the multiple offset mode, which repeats the offset
operation using the current offset distance.

Undo

Reverses the previous offset.

Through

Creates an object passing through a specified point.

Erase

Erases the source object after it has been offer.

Layer

Determines whether offset objects are created on the
current layer or on the layer of the source object. (Fig 17)

For best results when you offset a polyline with
corners, specify the through point near the
midpoint of a line segment, not near a corner.
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PROCEDURE

TASK 1 to 4 : Draw the plan elevation of three seater sofa and circular side table

TASK 1 : Draw the plan of three seater sofa on computer

Data : Size of sofa 84 x 36 cm.

• With line command draw a square of size 24"X24"

• Copy the square touching square 'a' at point B and C

• Draw rectangle with the help of the command of size
74x6 and move it to touch the line DE.

• Draw another rectangle with line command and move
it to touch point F. Copy the rectangle to touch ling
EG.

TASK 2 :

• Draw plan of circular size table.

• Data - Dia of table 18" inner circle dia - a"

• Draw a circle of dia 18"

• Draw a circle of dia 9"

• Moving the circle of a" dia from centre point to the cen-
tre point of circle of 18" dia

• Draw a line of a" (Equal to the dia of circle)

• Move the line from mid point to the midpoint of circle of
a" dia.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.03

Drafting of furnitures (Three seater sofa)
Objectives: At the end of this exercise you shall be able to
• draw plan of a three seater sofa
• draw a plan of side table.
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PROCEDURE

TASK 1 : Explode

Command alias Button Classic menu Ribbon/Application menu

X  Modify => Explode Home => Modify

Explodes a compound object when you want modify its
components separately.  Objects that can be exploded
include blocks, polylines, and regions, among others.

The colour, line type, and line weight of any exploded ob-
ject might change.  Other results differ depending on the
type of compound object you're exploding.  See the fol-
lowing list of objects that can be exploded and the results
for each.

2D Polyline

Discards any associated width or tangent information.  For
wide poly lines, the resulting lines and arcs are placed
along the center of the polyline.

3D Polyline

Explodes into line segments.  Any line type assigned to
the 3D poly line is applied to each resulting line segment.

Annotative objects

Explodes the current scale representation into its con-
stituent parts which are no longer annotative.  Other scale
representations are removed.

Arc

If within a non-uniformly scaled block, explodes into ellip-
tical arcs.

Array

Explodes an associative array into copies of the original
objects.

Block

Removes one grouping level at a time.  If a block contains
a poly line or a nested block, exploding the block ex-
poses the polyline or nested block object, which must
then be exploded to expose its individual objects.

Blocks with equal X, Y and Z scales explode into their
component  objects.  Blocks with unequal X,Y and Z scales
(non-Uniformly scaled blocks) might explode into unex-
pected objects.

When non-uniformly scaled blocks contain objects that
cannot be exploded, they are collected into an anony-
mous block (named with as "E" prefix) and referenced
with the non-uniform scaling. If all the objects in such a
block cannot be exploded, the selected block reference
will not be exploded. Body, 3D Solid, and Region entities
in a non-uniformly scaled block cannot be exploded.

Exploding a block that contains attributes deletes the at-
tribute values and redisplays the attribute definitions.

Blocks inserted with external references (Xrefs) and their
dependent blocks cannot be exploded.

Blocks insert with MINSERT cannot be exploded.

Circle

If within a non-uniformly scaled block, explodes into el-
lipses.

Leaders

Explodes into lines, splines, solids (arrow heads), block
inserts (arrow heads, annotation blocks), multiline text, or
tolerance objects, depending on the leader.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.04

Basic drafting commands - 2
Objectives: At the end of this exercise you shall be able to
• to understand basic drafting commands listed

• rectangle
• polygon
• explode
• array
• scale
• stretch
• lengthen
• trim
• extend
• break
• join
• chanfer
• fillet.
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Mesh objects

Explodes each face into a separate 3D face object. Colour
and materials assignments are retained.

Multiline text

Explodes into text objects.

Multiline

Explodes into lines and arcs.

Polyface mesh

Explodes one-vertex meshes into a point object. Two-ver-
tex meshes explode into a line.  Three-vertex meshes
explode into 3D faces.

Region

Explodes into lines, arcs, or splines.

TASK 2 : Rectangle

Command alias Button Classic menu Ribbon/Application menu

REC  Draw => Rectangle Home => Rectangle

With this command, you can specify the rectangle
parameters (length, width, rotation) and control the type
of corners (fillet, chamber, or square).

The following prompts are displayed;

Current settings: Rotation = 0

Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/width]: specify a point or enter an option

First corner point

Specifies a corner point of the rectangle.

Other corner point

Creates a rectangle using the specified points as
diagonally opposite corners.

Area

Creates a rectangle using the area and either a length or a
width. If the Chamfer or Fillet option is active, the area
includes the effect of the chamfers or fillets in the corners
of the rectangle.

Dimensions

Creates a rectangle using length and  width values.

Rotation

Creates a rectangle at a specified rotation angle.

Chamfer

Sets the chamfer distances for the rectangle.

Elevation

Specifies the elevation of the rectangle.

Fillet

Specifies the fillet radius of the rectangle.

Thickness

Specifies the thickness of the rectangle.

Width

Specifies the polyline width of the rectangle to be drawn.

TASK 3 : Array

Command alias Button Classic menu Ribbon/Application menu

AR  Modify => Array Home =>  Modify => Array

It creates copies of objects arranged in both 2D as well as
3d pattern. You can create copies of objects in a regularly
spaced rectangular, polar, or path array.

The following prompts are displayed;

Select objects:

Enter array type [Rectangular/PAth/Polar] < Rectangu-
lar>:

Rectangular(ARRAYRECT)

Distributes object copies into any combination of rows,
columns, and levels.  The following prompts are displayed.

Select objects:

Specify opposite corner for number of items or [Base point/
Angle/Count] <Count>:

Press Enter to accept or [Associative/Base point/Rows/
Columns/Levels/eXit] <eXit>:

Items

Specifies the number of items in the array.

Count

Specifies the row and column values individually.

Space Items

Specifies the row and column spacing. (Fig 1)
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Spacing

Specifies the row and column spacing individually.

Base point

Specifies a base point for the array.

Key Point

For associative arrays, a valid constraint is specified (or
key point) on the source objects to be used as the base
point.  If you edit the source objects of the resulting array,
the base point of the array remains coincident with the
key point of the source objects.

Rows

Edits the number and spacing of rows in the array and
also the incremental elevation between them.

Expression

Derives a value using a mathematical formula or equation.

Total

Sets the total distance between the first and last rows.

Columns

Edits the number and spacing of columns.

Total

Specifies the total distance between the first and last col-
umns.

Levels

Specifies the number and spacing of levels.

Total

Specifies the total distance between the first and last lev-
els.

Exit

Exits the command.

Path (ARRAYPATH)

Evenly distributes object copies along a path or a portion
of a path.  The following prompts are displayed:

Select objects:

Select path curve:

Enter number of items along path or [Orientation/Expres-
sion] <Orientation>:

Specify base point or [Key point] <end of path curve>:

Specify direction to align with path or [2Points/Normal]
<current>:

Specify the distance between items along path or [Divide/
Total/Expression] <Divide evenly along path>:

Press Enter to accept or [Associative/Base point/Items/
Rows/Levels/Align items/Z direction/eXit] <eXit>:

Path curve

Specifies the object to use for the path of the array. Select
a line, ployline, 3D polyline, spline, helix, arc, circle, or
ellipse.

Number of Items

Specifies the number of items in the array.

Orientation

Controls whether the selected objects are reoriented (ro-
tated) relative to the starting direction of the path before
being moved to the beginning point of the path.

2. Points

Specifies two points to define the direction to be aligned
with the starting direction of the path.

Normal

Objects are aligned to be normal to the starting direction
of the path.

The align items option controls whether to
maintain the starting orientation or continue
reorienting items along the path, relative to
the starting orientation.

Expression

Derives a value using a mathematical formula or equation.

Key point

For associative arrays, specifies a valid constraint point
(or key point) on the source objects to use as the base
point. If you edit the source objects of the resulting array,
the base point of the array remains coincident with the
key point of the source objects.

Distance between Items

Specifies the distance between items.

Divide

Divide items evenly along the entire length of the path.

Total

Specifies the total distance between the first and last items.

Associative

Specifies whether to create items in the array as an asso-
ciative array object, or as independent objects.
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Yes: Contains array items in a single array object, similar
to a block. This allows you to quickly propagate changes
by editing the properties and source objects of the array.

No: Creates array items as independent objects.  Changes
made on one item do not affect the other items.

Items

Edits the number of items in the array. If the Method prop-
erty is set to Measure, you are prompted to redefine the
distribution method (Distance between Items, Divide, and
Total options).

Rows

Specifies the number and spacing of rows in the array,
and the incremental elevation between them.

Total

Specifies the total distance between the first and last rows.

Align items

Specifies whether to align each item to be tangent to the
path direction.  Alignment is relative to the first item's ori-
entation (Orientation option).

Z. Direction

Controls whether to maintain the items' direction or to
naturally bank the items along a 3D path.

Exit

Exits the command.

Polar (ARRAYPOLAR)

Evenly distributes object copies in a circular pattern around
a center point or axis of rotation.  The following prompts
are displayed;

Select objects:

Specify center point of array or [Base point/Axis of rota-
tion]:

Enter number of items or [Angle between/Expression] <last
count>:

Specify the angle to fill (+= ccw, -= cw) or [Expression]:

Press Enter to accept or [ASsociative/Base point/Items/
Angle between/Fill angle/ROWs/Levels/ROTate items/eXit]
<eXit>:

Center Point

Specifies the point around which to distribute the array
items.  The axis of rotation  axis of the current UCS.

Base Point

Specifies a base point for the array.

Key point

For associative arrays, a valid constraint is specified (or
key point) on the source objects to be used as the base
point.  If you edit the source objects of the resulting array,
the base point of the array remains coincident with the
key point of the source objects.

Axis of rotation

Specifies a custom axis of rotation defined by two
specified points.(Fig 2)

Items

Specifies the number of items in the array.

Expression

Derives a value using a mathematical formula or equation.

When defining the fill angle in an expression,
the (+ or -) mathematical symbol in the
resultant value does not affect the direction of
the array.

Angle between

Specifies the angle between items.

Fill angle

Specifies the angle between the first and last item in the
array.

Associative

Specifies whether to create items in the array as an
associative array object or as independent objects.

Yes: Contains array items in a single array object,
similar to a block. This allows you to quickly propagate
changes by editing the properties and source objects or
the array.

NO: Creates array items as independent objects.
Changes made on one item do not affect the other
items.

Rows

Edits the number and spacing of rows in the array and
the incremental elevation between them.

Total

Sets the total distance between the first and the last
rows.

Levels

Specifies the number and spacing of levels in the array.

Total

Specifies the total distance between the first and last
levels.
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Rotate Items

Controls whether items are rotated  as they are arrayed.

Exit

Exits the command. (Fig 3)

TASK 4 : Draft using rectangular array

1 Open array drawing (Fig 4)

2 Copy the C1 chair and place it in front of the table as
shown in Fig 5

3 Move the chair 3” down

4 Copy the chair towards X axis at the distance  of 4’2”
(Fig 6)
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5 Mirror both the chairs on the other side. (Fig 7)

6 In command prompt type “Array”

i. Select the 4 chairs and enter

ii. Choose rectangaluar option and click the right side
mid-point of the other  table to specify the  number
of items  as shown in Fig 8.

iii. Similarly click the bottom mid-point to specify
spacing between the items as shown below.

iv Now  press R to create rows, Enter number of rows
as 2.

v. Enter value as 12’2”  and press enter twice  to exit
the command.

vi. Now you view the arrayed  chairs.

7 Copy the arrayed chairs and place it on the other set
of table as shown in Fig 9.

8 To set the chair properly, pick the arrayed chairs and
change the row spacing as 9’8”. (Fig 10)
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TASK 5 : Draft using polar array (array 6 chairs around circular table)

1 Let us do the polar array

i. Copy the C1 chair and place near  the round table
as shown in Fig 11.

ii. Type array  command and enter “PO” to choose
polar array.

iii. Select the chair and choose the base point as table
center.

iv. Move the cursor around the table to array the chair.

v. Pick on the bottom left corner; press enter to accept
360 as sngle to fill. (Fig 12)

vi. Once again press enter to exit  the command.

vii. By  default items will arrayed. To modify the array
pick the arrayed objects.

viii.Change the number of items as 4 in ribbon and
view the result. (Fig 13)

TASK 6 : Array lamp posts or a curved road

1 Open the file road drawing. (Fig 14)

2 Copy the rotate the lamp  post as shown in the Fig 15.
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TASK 7 : Scale

Command alias Button Classic menu Ribbon/Application menu

SC  Modify => Scale Home =>  Modify => Scale

It Enlarges or reduces selected objects, keeping the
proportions of the object the same after scaling. The
object(s) are selected, and a base point and scaling
factor are defined.  An easy way of changing a drawing
from metres to millimetres is to scale everything up by a
factor of 1000.

The following prompts are displayed;

Select objects:

Specify base point:

Specify scale factor or [Copy/Reference]:

The base point you specify identifies the point that
remains in the same location as the selected objects
change size (and thus move away from the stationary base
point).

When you use the SCALE command with annotative
objects, the position or location of the object is scaled
relative to the base point of the scale operation, without
changing the size of the object.

Scale  Factor

Multiplies the dimensions of the selected objects by a
specified scale.  A scale factor greater than 1 enlarges the
objects.  A scale factor between 0 and 1 shrinks the ob-
jects.  You can also drag the cursor to make the object
larger or smaller.

Copy

Creates a copy of the selected objects for scaling.

References

Scales the selected objects based on a reference length
and a specified new length.

3 Type array command and enter “PA” for the path array
option

i. Select the lamp post object and press enter to se-
lect the path.

ii. Select the path curve and pick the right end point of
the path as shown in Fig 16.

iii. Press enter twice to exit the command

iv. To reduce the number of object pick the arrayed
object and enter value 12 in number of items.
(Fig 17)

4 Let us place the lamps on the other side of the road,

i. Copy the arayed object and place it on the other
side of the road. (Fig 18)

ii. Select the arrayed  object and click the eidt  source
from the ribbon as shown.

iii. Select the first  object to edit and click  OK to the
warning dialog box. (Fig 19)

iv. Rotate the object  by 180. Now all the objects will
rotate.

5 Enter zoom all to view all the objects.
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TASK 5 : Stretch

Command alias Button Classic menu Ribbon/Application menu

S  Modify => Stretch Home =>  Modify => Stretch

This command uses to lengthen object, shorten them and
to alter their shapes by a selection window or polygon.
STRETCH moves only the vertices and endpoints that lie
inside the crossing selection, leaving those outside un-
changed.  STRETCH does not modify 3D solids, poly line
width, tangent, or curve-fitting information.

The following prompts are displayed;

Select objects to stretch by crossing-window or crossing-
polygon...

Select objects:

Specify base point or [Displacement] <last displacement>;

Specify second point or <use first point as displacement>:

Specify displacement <last value>:

If you enter a second point, the objects are stretched over
the vector distance from the base point to the second
point.  If you press Enter at the Specify Second Point of
Displacement prompt, the first point is treated as an X, Y,
Z displacement.

TASK 6 : Lengthen

The Lengthen command can often be used instead of
either the Trim or Extend commands. Indeed the end
result is exactly the same. The lengthen command can
be used to either lengthen or shorten lines, Arcs, open
polylines, elliptical Arcs and open splines without the use
of cutting or boundary edges.

Select an object or [Delta/Percent/Total/Dynamic]:

Delta

This option is used if you want to add or remove extra
length to or from current length.  If you input as negative
value, the lengthen command will shorten the line. Follow-
ing options are displayed;

Select an object or [DElta/Percent/Total/Dynamic]:de

Enter delta length or [Angle] <0.0000>: 10

Select an object to change or [Undo]:

Percent

If you want to add or remove from the length, specify a
percentage of the current length. The number should be

positive, and non-zero number. If it is > 100 the object will
lengthen, if the value is < 100, the object will shorten. The
following prompts are displayed;

Select an object or [Delta/Percent/Total/Dynamic]: p

Enter percentage length<100.0000>:50

Select an object to change or [Undo]:

Total

Use the total option if you want the new total length of the
line to be equal to the number you input.  If the new length
is greater than current length the line will lengthen.  If the
new length is lesser than the current length, then the line
will shorten. The following prompts are displayed;

Select an object or [DElta/Percent/Total/Dynamic]: t

Specify total length or [Angle] <1.0000>:30

Select an object to change or [Undo]:

TASK 7 : Trim

Command alias Button Classic menu Ribbon/Application menu

TR                 Modify => Trim              Home =>  Modify => Trim

The trim command shortens an object so that it ends pre-
cisely at a certain boundary.

The following prompts are displayed;

Current settings: Projection = current, Edge = current

Select cutting edges....

Select objects or <select all>:

Select object to trim or shift-select to extend or [Fence/
Crossing/Project/Edge/eRase/Undo]:

Select the objects that define the cutting edges to which
you want to trim an object, or press Enter to select all
Displayed objects as potential cutting edges.  TRIM
projects the cutting edges and the objects to be trimmed
onto the XY plane of the current user coordinate system
(UCS).

Specify an object selection method to select the objects
to be trimmed.  If more than one trim result is possible,
the location of the first selection point determines the re-
sult.
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TASK 8 : Extend

Command alias Button Classic menu Ribbon/Application menu

EX Modify => Extend Home =>  Modify => Extend

Object to Trim

Specifies the object to be trimmed.

Shift select to extend

Extends the selected objects rather than trimming them.
This option provides an easy method to switch between
trimming and extending.

Fence

Selects all objects that cross the selection fence.  The
selection fence is a series of temporary line segments
that you specify with two or more fence points.  The se-
lection fence does not form a closed loop.

Crossing

Selects objects within and crossing a rectangular area
defined by two points.

Some crossing selections of objects to be
trimmed are ambiguous.  TRIM resolves the
selection by following along the rectangular
crossing window in a clockwise direction from
the first point to the first object encountered.

Project

Specifies the projection method used while trimming ob-
jects.

View

Specifies projection along the current view direction. The
command  objects that intersect the boundary in the cur-
rent view.

Edge

Determines whether an object is trimmed at another
object's extrapolated edge or only to an object that inter-
sects it in 3D space.

Extend

Extend the cutting edge along its natural path to intersect
an object in 3D space.

No extend

Specifies that the object is trimmed only at a cutting edge
that intersects it in 3D space.

When trimming hatches, do not set Edge to
Extend. If you do, gaps in the trim boundaries
will not be bridged when trimming hatches,
even when the gap tolerance is set to a
correct value.

Erase

Deletes selected objects.  This option provides a conve-
nient method to erase unneeded objects without leaving
the TRIM command.

Undo

Reverses the most recent change made by TRIM.

The Extend command allows increasing the length of an
object within the limits of object definition.

The following prompt are displayed;

Current settings: Projection = current, Edge = current

Select boundary edges...

Select objects or <select all>:

Select object to extend or shift-select to trim or [Fence/
Crossing/Project/Edge/Undo]:

TASK 9 : Break

Command alias Button Classic menu Ribbon/Application menu

BR             Modify => Break Home =>  Modify => Break

This command erases the part of an object.

The following prompts are displayed;

Select object:

The prompts that are displayed next depend on how you
select the object. If you select the object using your point-
ing device, the program both selects the object and treats
the selection point as the first break point.  At the next
prompt, you can continue by specifying the second point
or overriding the first point.

Specify second break point or [First point]:

Second break point

Specifies the second point to use to break the object.

First point

Overrides the original first point with the new point that
you specify.

The portion of the object is erased between the two points
specified by you. If the second point is not on the object,
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the nearest point on the object is selected; therefore, to
break off one end of a line, arc, or polyline, specify the
second point beyond the end to be removed.  To split an
object in two without erasing a portion, enter the same
point for both the first and second points.  You can do this
by entering  @ to specify the second point.

Lines, arcs, circles, polylines, ellipses, splines, donuts,
and several other object types can be split into two ob-
jects or have one end removed.

The program converts a circle to an arc by removing a
piece of the circle starting counter clockwise from the first
to the second point.

You can also break selected objects at a single point with
the break at point tool.

Valid objects include lines, open polylines, and arcs.
Closed objects such as circle cannot be broken at a single
point.

TASK 10 : Join

Command alias Button Classic menu Ribbon/Application menu

JO             Modify => Join Home =>  Modify => Join

This command joins the endpoints of linear and curved
objects to create a single object. The following prompts
are displayed.

Select sources object or multiple objects to join at once;

Source object

Specifies a single source object to which you can join
other objects. Press enter after selecting the source
object to begin selecting the objects to join.  The following
rules apply for each type of source object.

Line

Only line objects can be joined to the source line.  The
line objects must all be collinear, but can have gaps
between them.

Polyline

Lines, polylines, and arcs can be joined to the source
polyline.  All objects must be contiguous and coplanar.
The resulting object is a single polyline.

3D polyline

Any linear or curved object can be joined to the source 3D
polyline.  All the objects must be contiguous, but can be
non-coplanar. The resulting object is either a single 3D
polyline or a single spline, depending on whether you are
joining to a linear or a curved object respectively.

TASK 11 : Chamfer

Command alias Button Classic menu Ribbon/Application menu

CHA             Modify => Chamfer Home =>  Modify => Chamfer

The chamfer command draws a straight line segment be-
tween two given lines.  Chamfer is the name for machining
process of flattening a sharp corner to create a bevelled
edge.

The following prompts are displayed;

(Trim mode) Current chamfer Dist1 = current, Dist2 = cur-
rent select first line or [Undo/Polyline/Distance/Angle/Trim/
Method/Multiple]:

First line

Specifies the first of two edges required to define a 2D
chamfer, If you select lines or polylines, their lengths ad-
just to accommodate the chamfer line.  You can hold down
shift while selecting the objects to override the current
chamfer distances with a value of 0.

If the selected objects are line segments of a 2D polyline,
they must be adjacent or separated by no more than one
segment.  If they're separated by another polyline seg-
ment, CHAMFER deletes the segment that separates them
and replaces it with the chamfer.

Edge

Selects an individual edge to chamfer.

Loop

Switches to Edge Loop mode.

Edge Loop

Selects all edges on the base surface.

Undo

Reverses the previous action in the command.

Polyline

Chamfers an entire 2D polyline.

The intersecting polyline segments are chamfered at each
vertex of the polyline.  Chamfers become new segments
of the polyline. If the polyline includes segments that are
too short to accommodate the chamfer distance, those
segments are not chamfered.
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Distance

Sets the distance of the chamfer from the endpoint of the
selected edge.  If you set both distances to zero, CHAM-
FER extends or trims the two lines so they end at the
same point.

Angle

Sets the chamfer distances using a chamfer distance for
the first line and an angle for the second line.

Trim

Controls the trimming of selected edges to the chamfer
line endpoints, by CHAMFER.

Method

Controls whether CHAMFER uses two distances or a dis-
tance and an angle to create the chamfer.

Multiple

Chamfers the edges of more than one set of objects.

Expression

Determines the chamfer distance with a mathematical
expression.  See control Geometry with the parameters
manager for a list of operators and functions allowed.

TASK 12 : Fillet

Command alias Button Classic menu Ribbon/Application menu

F             Modify => Fillet Home =>  Modify => Fillet

This command fits a smooth arc between any
combination of lines, arcs or circles.  Once the radius
value is identified the direction of the fillet is determined
by the cursor location which is used to identify the two
objects.

The following prompts are displayed;

Current settings: Mode = current, Radius = current

Select first object or [Undo/Polyline/Radius/Trim/Multiple]:

First object

Selects the first of two objects required to define a 2D fillet
or fillet the edge.

Select second object or shift- select to apply corner:

Enter fillet radius <current>:

Select an edge or [Chain/Loop/Radius]:

Edge

Selects a single edge.  You can continue to select single
edges until you press Enter.  If you select three or more
edges that converge at a vertex to form the corner of a
box, FILLET computes a vertex blend that is part of a
sphere if the three incident fillets have the same radii.

Chain

Changes from selection of single edges to selection of
sequential tangent edges, called a chain selection.

Edge chain

Selects a tangential sequence of edges when you select
a single edge.  For example, if you select an edge on the
top of a 3D solid box, FILLET also selects the other tan-
gential edges on the top.

Edge

Switches to a single-edge selection mode.

Loop

Specifies a loop of edges on the face of a solid.  For any
edge, there are two possible loops.  After selecting a loop
edge, you are prompted to Accept the current selection,
or choose the Next loop.

Radius

Defines the radius of the rounded edge.

Undo

Reverse the previous action in the command.

Polyline

Inserts fillet arcs at each vertex of a 2D polyline where two
line segments meet. If one arc segment separates two
line segments that converge as they approach the arc
segment, FILLET removes the arc segment and replaces
it with a fillet arc.

Radius

Defines the radius of the fillet arc. The value you enter
becomes the current radius for subsequent FILLET com-
mands.  Changing this value does not affect existing fillet
arcs.

Trim

Controls whether FILLET trims the selected edges to the
fillet arc endpoints.

Multiple

Rounds the edges of more than one set of objects.
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Skill Sequence - 2

Objective :  This shall help you to
• draft plan of the chair using 2d commands.

1 Create two tectangles with the following dimensions.

I Length = 15; Width = 4

II Length = 12; Width = 7 (Fig 20)

2 Use the MOVE command to assemble the rectangles
as follows. (Fig 21)

Command: Move

Select object: select the second rectangle

Select object: <Null response>

Base point: <Pick the top midpoint>

Second point: from

Base point: <Pick the bottom midpoint of the first
rectangle> (Fig 22)

Offset: @2.5<270 (Fig 23)

3 Use the ARC and MIRROR commands to connect the
rectangles. (Fig 24)

Arc between P2 and P1

Command: ARC

Start Point: <Pick P2: Use 'Mid between two points' in
object snap>

Second point [Centre/End]: E

End Point: <Pick P1>

Centre Point [Angle/Direction/Radius]: R

Radius: 1.5

Create one more ARC as like as above which con-
nects P2 and P3. (Fig 25)
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MIRROR both the arcs to the opposite side.
Command: MIRROR
Select objects: <select both the arcs>
Select objects: <Null response>
First point of mirror line: <Pick the top middle point of
bottom rectangle>
Second point of mirror line: <Pick the bottom middle
point of the top rectangle> (Fig 26)

4 Trim the unwanted edges to get the following output.
Command: TRIM
Select cutting edges: <select all> (Fig 27)
Select object to trim: <select the unwanted edges>

5 Fillet the corners with radius 2. (Fig 28)

6 Create the back rest. (Fig 29)

Command: OFFSET

Offset distance: 1

Object to offset “ <select teh bottom rectangle of teh
created seat >

Side to offset: <pick in the outside of the seat>
Repeat the above two steps to create one more offset.
(Fig 30)

Connect the open ends with the help of LINE. (Fig 31)

Create the connection between the seat to the back rest
with the help of LINE. (Fig 32)
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PROCEDURE

TASK 1 :

Data : Size of the door

Height = 2100

Width = 100

1 Create a new metric file.

2 Draw a rectangle with the following dimensions.

i. Length = 100

ii. Width = 210

3 Offset the rectangle towards the inside for 2.5 units.

4 Create another rectangle with the dimension of 80, 170
as shown in Fig 1.

5 Create an ARC as follows with the help of start, End
and Direction method. (Fig 2)

i. Chord length = 40 units

ii. Tangent angle = -60 deg

6 Mirror the arc to the opposite side and trim the unwanted
portion to get the following result. (Fig 3)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.05

Drafting of furniture (Door elevation -2)
Objectives: At the end of this exercise you shall be able to
• draft the door elevation using basic CAD commands.
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7 Convert the inner loop as a single element with the
help of PEDIT.

8 Offset the inner loop to 2.5, 10 & 2.5 units. (Fig 4)

9 Complete the model as follows with the help of Circle,
Line, Offset and Trim. (Fig 5)
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PROCEDURE

TASK 1 : Mline

It creates multiple parallel lines.

Command alias Button Classic menu Ribbon/Application menu

ML             Draw => Multiline

The following prompts are displayed.

Specify start point or [] Justification/Scale/Style]:

Specify next point:

Specify next point or [Undo]:

Specify next point or [Close/Undo]:

Next point

Draws a multiline segment to the specified point using the
current multiline style and continues to prompt for points.

Undo

Undoes the last vertex point on the multiline.

Close

Closes the multiline by joining the last segments with the
first segments.

Justification

Determines how the multiline is drawn between the points
you specify.

Top: Draws the multiple below the cursor, so that the line
with the most positive offset is at the specified points.

Zero: Draws the multiline with its origin centered at the

cursor, so that the MLSTYLE element Properties offset of
0.0 is at the specified points.

Bottom: Draws the multiline above the cursor, so that the
line with the most negative offset is at the specified points.

Scale

Controls the overall width of the multiline.  This scale does
not affect line type scale. This scale factor is based on
the width established in the multiline style definition.  A
scale factor of 2 produces a multiline twice as wide as the
style definition.  A negative scale factor flips the order of
the offset line-the smallest on top when the multiline is
drawn from left to right. A negative scale value also alters
the scale by the absolute value.  A scale factor of 0 col-
lapses the multiline into a single line.

Style

Specifies a style to use for the multiline.

Style name

Specifies the name of a style that has already been loaded
or that has been defined in a multiline library (MLN) file
that you have created.

?-List styles

List the loaded multiline styles.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.06

Basic drafting commands - 3
Objectives: At the end of this exercise you shall be able to
• understand following drafting commands

• mine
• polyline
• spline
• xline
• ray
• rev cloud
• pan
• redraw
• reglx
• colours
• line type
• line type manager
• line weight
• properties
• match properties.
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TASK 2 : Polyline

Command alias Button Classic menu Ribbon/Application menu

PL             Draw => Polyline Home => Draw => Polyline

The PLINE command allows you to create "grouped"
objects that can be extruded, given line width on the
screen, and can contain arc segments.  A polyline is an
object in AutoCAD that consists of one or more line (or
arc) segments.

The following prompts are displayed.

Specify start point: Specify a point

Current line-width is <current>

Specify next point or [Arc/Close/Halfwidth/Length/Undo/
Width]: Specify a point or enter an option.

Next point

Draws a line segment.  The previous prompt is repeated.

Arc

Adds arc segments to the polyline.

Specify endpoint or arc or

[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/
Secondpt/Undo/Width]: Specify a point (2) or enter an
option

For the center option of the PLINE command,
enter ce; for the center object snap, enter cen
or center.

Endpoint of Arc

Draws an arc segment. The arc segment is tangent to the
previous segment of the polyline. The previous prompt is
repeated.

Angle

Specifies the included angle of the arc segment from the
start point.

Specify included angle:

Entering a positive number creates  counterclockwise arc
segments.  Entering a negative number creates clock-
wise arc segments.

Specify endpoint of arc or [Center/Radius]: specify a point
or enter an option

Endpoint of Arc

Specifies the endpoint and draws the arc segment.

Center

Specifies the center of the arc segment.

Specify center point of arc:

Radius

Specifies the radius of the arc segment.

Specify radius of arc: specify a distance

Specify direction of chord for arc <current>: specify a point
or press ENTER

Center

Specifies the center of the arc segment.

Specify center point or arc: specify a point

Specify endpoint of arc or [Angle/Length]:specify a point
or enter an option

End point or Arc

Specifies the endpoint and draws the arc segment.

Angle

Specifies the included angle of the arc segment from the
start point

Specify included angle:

Length

Specifies the chord length of the arc segment.  If the pre-
vious is an arc, the new arc segment is drawn tangent to
the previous arc segment.

Specify length of chord:

Close

Draws an arc segment from the last point specified to the
starting point, creating a closed polyline.  At least two
points must be specified to use this option.

Direction

Specifies a starting direction for the arc segment.

Specify the tangent direction from the start point of arc:
specify a point

Specify endpoint of arc: specify a point

Halfwidth

Specifies the width from the center of a wide polyline seg-
ment to one of its edges.

Specify starting half-width <current>: Enter a value or press
ENTER

Specify ending half-width <starting width>: Enter a value
or press ENTER

The starting half-width becomes the default ending half-
width.  The ending half-width becomes the uniform half-
width for all subsequent segments until you change the
half-width again. The starting and ending points of wide
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line segments are at the center of the line.

Typically, the intersections of adjacent wide polyline seg-
ments are bevelled.  No bevelling is performed for non-
tangent are segments or very acute angles or when a dot-
dash linetype is used.

Line

Exits the Arc option and returns to the initial PLINE com-
mand prompts.

Radius

Specifies the radius of the arc segment.

Specify radius of arc: specify a distance

Specify endpoint of arc or [Angle]: specify a point or enter
a

Endpoint of Arc

Specifies the endpoint and draws the arc segment.

Angle

Specifies the included angle for the arc segment.

Specify included angle:

Specify direction of chord for arc <current>:Specify an
angle or press ENTER

Second Pt

Specifies the second point and endpoint of a three-point
arc.

Specify second point on arc: specify a point

Specify end point of arc: specify a point

Undo

Removes the most recent arc segment added to the
polyline.

Width

Specifies the width of the next arc segment.

Specify starting width<current>: Enter a value or press
ENTER

Specify ending width<starting width>: Enter a value or
press ENTER

The starting width becomes the default ending width. The
ending width becomes the uniform width for all subse-
quent segments until you change the width again.  The
starting and ending points of wide line segments are at
the center of the line.

Typically, the intersections of adjacent wide polyline seg-
ments are beveled.  No beveling is performed for nontangent
arc segments, very acute angles, or when a dot-dash
linetype is used.

Close

Draws a line segment from the last point specified to the
starting point, creating a closed polyline.  At least two
points must be specified to use this option.

Halfwidth

specifies the width from the center of a wide polyline seg-
ment to one of its edges.

Specifify starting half-width <current>: Enter a value or
press ENTER

Specify ending half-width <current>: Enter
a value or press ENTER

The starting half-width becomes the default ending half-
width.  The ending half-width becomes the uniform half-
width for all subsequent segments until you change the
half-width again.  The starting and ending points of wide
line segments are at the center of the line.

Typically, the intersections of adjacent wide polyline seg-
ments are beveled.  No beveling is performed for non-tan-
gent arc segments or very acute angles or when a dot-
dash linetype is used.

Length

Draws a line segment of a specified length at the same
angle as the previous segment.  If theprevious segment is
an arc, the new line segment is drawn tangent to that arc
segment.

Specify length of line: Specify a distance

Undo

Removes the most recent line segment added to the
polyline.

Width

Specifies the width of the next line segment.

Specify starting width <current>: Enter a value or press
ENTER

Specify ending width <starting width>: Enter a value or
press ENTER

The starting width becomes the default ending width. The
ending width becomes the uniform width for all subse-
quent segments until you change the width again.  The
starting and ending points of wide line segments are at
the center of the line.

Typically, the intersections of adjaceng wide polyline seg-
ments are beveled.  No beveling is performed for non-tan-
gent arc segments or very acute angles or when a dot-
dash linetype is used.

CCM&RE : Architectural Assistant - Exercise 2.1.06



45

Command alias Button Classic menu Ribbon/Application menu

           SPL             Draw => Spline Home => Draw => Spline

To create curves in AutoCAD you can use spline
command.  Spline can be drawn by specifying series of fit
data poins through which the curve passes.  The curves
are quadratic or cubic curves.  The curves can be more
accurate than the spline fitted polylines because you
control the tolerance to which the spline curve is fit.  The
prompts that display depend on whether you create a
spline with fit points or with control vertices.

For splines created with the fit point method:

Specify first point or [Method/Degree/Object]:

For splines creted with the control vertices method:

Specifies first point or [Method/Knots/Object]:

First Point

Specifies the first point of the sline, either the first fit point
or the first control vertex, depending on the current method.

Method

Controls whether the spline is created with fit points or
with control vertices. (SPLMETHOD system variable)

Fit

Creates a degree 3 (cubic) B-spline by specifying fit points
that the spline must pass through.  When the tolerance
value is greater than 0, the spline must be within the
specified tolerance distance from each point.

Changing the Method updates the SPLMETHOD system
variable.

Control vertices

Creates a spline by specifying control vertices.  Use this
method to create splines of degree 1 (linear), degree 2
(quadratic), degree 3 (Cubic), and so on up to degree 10.
Adjusting the shape of a spline by moving  control vertices
often provides better results than moving the fit points.

This is the preferred method if you are creating geometry
to be used with 3D NURBS surfaces.

Object

Converts 2D or 3D quadratic or cubic spline-fit polylines to
equivalent splines.  The originl polyline is retained or dis-
carded depending on the setting of the DELOBJ system
variable.

Next point

Creates additional spline segments until you press Enter.

Undo

Removes the last specified point.

Close

Close the spline by defining the last point to be coincident

with the first.  By default, closed splines are periodic,
maintaining curvature continuity (C2) along the entire loop.

Options for splines with fit points

The following options are specific to the fit point method.

Knots

Specifies the knot parameterization, one of several
computational methods that  determines how the compo-
nent curves between successive fit points within a spline
are blended.  (SPLKNOTS system variable)

1 Chord or Chord-length method : Spaces the knots
connecting each component curve to be proportional
to the distances between each associated pair of
points.  An example is the green curve inthe illustra-
tion.

2 Square Root (or centripetal method): This method
spaces the knots connecting each component curve
to be proportional to the square root of the distance
between each associated pair of fit points. This method
usually produces “gentler”curves. An example is the
blue curve in the illustration.

3 Uniform (or Equidistant method): this method
spaces the knots of each component curve to be equal,
regardless of the spacing of the fit points. This method
often produces curves that overshoot the fit points.  An
example is the magenta curve in the illustration.

Start targency

specifies a tangent condition on the starting point of the
spline.

End tangency

Specifies a tangent conditon on the ending point of the
spline.

Tolerance

Specifies the distance by which the spline is allowed to
deviate from the specified fit points.  A tolerance value of 0
requires the resulting spline to pass directly through the
fit points.  The tolerance value applies to all fit points
except the starting and ending fit points, which always
have a tolerance of 0.

Options for Splines with Control Vertices

The following option is specific to the control vertices (CV)
method. (SPLMETHOD system variable)

Degree

sets the polynomial degree of the resulting spline.  Use
this option to create splines of degree 1 (linear), degree 2
(quadiatic), degree 3 (Cubic), and so on up to degree 10.

TASK 3 : Spline
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TASK 4 : Xline

Command alias Button Classic menu Ribbon/Application menu

           XL             Draw => Xline Home => Draw => Xline

Lines that extend to infinity in one or both directions, known
as rays and construction lines, respectively, can be used
as references for creating other objects. For example, you
can use construction lines to find the center of a triangle,
prepare multiple views of the same item, or create
temporary intersections to use for object snaps.  Infinite
lines do not change the total area of the drawing.
Therefore, their infinite dimensions have no effect on
zooming or viewpoints.  Hence they are ignored by
commands that display the drawing extends.  you can
move, rotate, and copy infinite lines just as you can move,
rotate, and copy other objects. You may want to create
infinite lines on a construction line layer that can be
frozen or turned off before plotting. (Fig 1)

The following prompts are displayed.

Specify a point or [Hor/Ver/Ang/Bisect/Offset]:
Point

Specifies the location of the infinite line using two points
through which it passes.  The xline is created through
the specified point.

Hor

It creates a horizontal x-line passing through a specified
point.  The xline is created parallel to the X axis.

Ver

It cretes a vertial X-line passing through a specified
point.  The xline is created parallel to the Y axis.

Ang

It creates an xline at a specified angle.

Angle of Xline

Specifies the angle at which to place the line.

Reference

Specifies the angle from a selected reference line. The
angle is measured counterclockwise from the reference
line.

Bisect

It creates an xline that passes through the selected
angle vertex and bisects the angle between the first and
second line.  The X-line lies in the plane determined by
the three poins.

Offset

Creates an xline parallel to another object.

Offset distance

Specifies the distance the xline is offset from the
selected object.

Through

Creates an xline offset from a line and passing through a
specified point.

TASK 5 :  Ray

Command alias Button Classic menu Ribbon/Application menu

           RAY             Draw => Xline Home => Draw => Xline

A ray is a line in three-dimensional space that starts at a
point you specify and extends to infinity. Unlike
construction lines, which extend in two directions, rays
extend in only one direction.  Using rays instead of
construction lines can help reduce visual clutter.  Like
construction lines, rays are ignored by commands that
display the drawing extents. (Fig 2)
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TASK 6 :  Pan

Command alias Button Classic menu Ribbon/Application menu

           Z             View=> Pan View => Navigate 2D => Pan

Often you cannot see the entire drawing on the screen.
So you need a way to see that part of the drawing which is
currently not visible.  The pan means to move the display
without changing the magnification.

The following prompts are displayed.

Press Esc or Enter to exit, or right-click to display a short-
cut menu.

If you enter-pan at the command prompt, PAN displays
command prompts, and you can specify a displacement
to pan the drawing display.  Position the cursor at the
start location and press the mouse button down. Drag the
cursor to the new location.  You can also press the mouse
scroll wheel or middle button down and drag the cursor to
pan.

TASK 7 :  Redraw

Removes temporary graphics left by VSLIDE and some
operations from the current viewpoint. To remove stray
pixels, use the REGEN command.

TASK 8 :  Regen

Command alias Classic menu

  REGEN View => Regen

By using this command all objects in the drawing are re-
calculated and re-drawn in the current viewport. One of
the advantages of this command is that the drawing is
refined by smoothening circles and arcs out.

TASK 9 :  Color

Command alias Button Classic menu Ribbon/Application menu

      COLOR             Format => Color      Home => Properties  => Object color

In AutoCAD the default color of object is white or dark
grey depending on the background color of the view port.
If the background color is black object will appear as white
if light then AutoCAD automatically changes objects to
dark (In drawing begun with acad3d.dwt the default color

is pale greyblue). In case, You don't want to confine to
black, white or pale greyblue, you can select from the 255
AutoCAD Color Index (ACI) colors, true colors, and Color
Book colors.

TASK 10 :  Revcloud

Command alias          Button Classic menu Ribbon/Application menu

      REVCLOUD      Draw => Revision cloud      Home => Draw=> Revision cloud

This command creates a revision cloud using a polyline.
This tool can be used to highlight the details of a drawing.
It is customary in many industries to submit a set of draw-
ings at different milestones of the project or stages of
completion and then submit them again later with revi-
sions-corrections, clarifications and requested changes.
Usually the recipients like to locate changed/corrected
stuff easily, and a common drafting convention is to call
attention to revised items by drawing freedom clouds
around them.

The following prompts are displayed

Minimum arc length : 0.5000 Maximum arc length : 0.5000

Specify start point or [Arc length/Object/Style]<Object>

Arc length

Specifies the length of the arcs in a revision cloud.  The
maximum arc length cannot be set to more than three
times the minimum arc length.

CCM&RE : Architectural Assistant - Exercise 2.1.06



48

Object

Specifies an object to be converted to a revision cloud.

Style

Specifies the style of the revision cloud.

Index color tab

Specifies color settings using the 255 AutoCAD color
Index (ACI) colors. (Fig 3)

Color

Specifies a color name, BYLAYER or BYBLOCK color or
an AutoCAD Color Index (ACI) number of 1 through 255.
The New color swatch shows the most recently selected
color.

Old color swatch

Displays the previously selected color.

New color swatch

Displays the currently selected color.

True color tab

Specifies color settings using true colors (24-bit color) with
the Hue, saturation, and Luminance (HSL) color model or
the  Red, Green, and Blue (RGB) color model.  Over six-
teen million colors are available when using true color func-
tionality. The options available on the True Color tab are
dependent on whether the HSL or RGB color model is
specified.

The following options are displayed. (Fig 4)

The following options are displayed.

AutoCAD color index (ACI) palettes

Specifies a color from the AutoCAD color Index. If you
hover over a color, the number of the color and its red,
green,blue value are displayed below the palette. Click a
color to select it, or enter the color number or name in the
Color box.

The large palette displays colors 10 through 249. The sec-
ond palette displays colors 1 through 9; these colors have
names as well as numbers.  The third  palette displays
colors 250 through 255; these colors are in shades of
gray.

Index color

Indicates the ACI color number when you hover a color.

Red, Green, Blue

Indicates the RGB color value when you hover over a color.

By layer

Specifies that new objects assume the color assigned to
the layer on which you create them.  When BYLAYER is
selected, the color of the current layer is displayed in the
Old and New color swathces.

Byblock

Specifies that new objects use the default color (While or
black, depending on your background color) until you group
the objects into a block and insert the block.  When you
insert the block into a drawing, the objects in the block
inherit the current Color setting.

The BYLAYER and BYBLOCK options do not
apply to the LIGHT command.

Color book

This option specifies the color book to be used when se-
lecting colors. The list consists of all the color books that
are found in the Color Book Locations specified in the
Options dialog box, Files tab. This Displays the pages of
the selected color book and the colors and color names
on each page.  Color books containing up to ten colors
per page are supported.  If a color book is not paginated,
the colors are organized into pages containing seven col-
ors per page. To view color book pages, select an area on
the color slider or use the up and down arrows to browse.

Color

Indicates the currently selected color book color.  You
can searach for a specific color in a color book by enter-
ing the number of the color swatch and pressing Tab. This
action updates the new color swatch with the requested
color number. if  the specified color is not found in the
color book, the closest number match is displayed.

Fig 3

Fig 4

CCM&RE : Architectural Assistant - Exercise 2.1.06



49

Old color swatch

Displays the previously selected color.

New color swatch

Displays the currently selected color.

TASK 11 :  Linetype

        Command alias      Button Classic menu Ribbon/Application menu

      LT           Format => Line type      Home => Properties => Line type

A non -continuous line type is a repetition pattern of dots,
dashes, and spaces.  Line type can also include repeat-
ing texts or shapes. You may find that the line type you
are using in your drawing are too long or short or requires
clarity.  The line type scale may even be so big or small
that the line type looks continuous. How often the pattern
is repeated is affected by three factors,

1) The line type definition

2) The global line type scale. Objects

3) The individual objects line type scale.

TASK 12 : Linetype manager

The following options are displayed.

Linetype filters (Fig 5)

Determines which linetype to display in the linetype list.
You can filter linetype based on wherther they are x ref-
dependent, or whether they are referred to by objects.

Invert filter

Displays linetypes based on the opposites of the criteria
you select. Linetypes that fit the inverse filter criteria are
displayed in the linetype list.

Load

Displays the Load or Reload Linetypes dialog box, in which
you can load into selected linetypes the drawing from the
acad.linfile and add them to the linetypelist. It also loads
a linetype whose definition exists in a linetype library (LIN)
file. (Fig 6)

The following options are displayed.

File button

Displays the select Linetype File dialog box, in which you
can select a different linetype (LIN) file.

File name

Displays the name of the current LIN file. You can enter
the name of another LIN file or click the File button to
select a file from the select Linetype File dialog box.

Available linetypes

Displays the linetypes available to load. To select or clear
all of the linetypes on the list, right-click and choose
select All or Clear All.

Current

Sets the selected linetype to be the current linetype.
Setting the current linetype to BYLAYER means that an
object assumes the linetype that is assigned to a

Fig 5

Fig 6
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particular layer.  Setting the linetype to BYBLOCK means
that an object assumes the CONTINUOUS linetype until
it is grouped into a block.  Whenever the block is inserted,
all objects inherit the block’s linetype. The CELTYPE
system variable stores the linetype name.

Delete

Deletes selected linetypes from the drawing.  You can
delete only unused linetypes. The BYLAYER, BYBLOCK,
and CONTINUOUS linetypes cannot be deleted.

Show details or hide details

Controls whether the Details section of the Line type
Manager is displayed.

Current linetype

Displays the current linetype name.

List of linetypes

Displays the loaded linetypes according to the option
specified in Linetype Filters. To quickly select all or clear
all linetypes, right-click in the linetype list for the shortcut
menu to be displayed.

Linetype

Displays names of loaded linetypes. To rename a linetype,
select it and then click it again and enter a new name.
BYLAYER, BYBLOCK, CONTINUOUS, and
xref-dependent linetypes cannot be renamed.

Appearance

Displays a sample of selected linetypes.

Description

Displays descriptions of the linetypes, which can be
edited in the Details area.

Details

Provides alternative access to properties and additional
settings.

Name

Displays the selected linetype name, which can be
edited.

Use paper space units for scaling

Scales linetypes in paper space and model space
identifically. Useful when working with multiple viewports.
(PSLTSCALE system variable)

Global scale factor

Displays the global scale factor for all linetypes. (LTSCALE
system variable)

Current object scale

Sets linetype scale for newly created objects.  The result-
ing scale is the global scale factor multiplied by the object’s
scale factor.  (CELTSCALE system variable)

ISO pen width

Sets the linetype scale to one of a list of standard ISO
values.  The resulting scale is the global scale factor mul-
tiplied by the object’s scale factor.

TASK 13 : Lineweight

    Command alias      Button Classic menu Ribbon/Application menu

            LW          Format => Line weight Home => Properties => Line weight

Line weight let  you represent objects with varying line
width.  The width can represent teh width of a pen.
Lineweight is  also used to distinguish certain type of ob-
jects just as colors and line types do.  Finally you can
use line weight to represent original property of an object
such as the width of wire in electrical schematics.

The following options are displayed.

Line weights

It displays the available lineweight values. Lineweight val-
ues consist of standard settings including BYLAYER,
BYBLOCK, and DEFAULT. The DEFAULT value is set by
the LWDEFAULT system variable, which has an initial value
of 0.01 inches or 0.25 mm. All new layers use the default
setting.  The lineweight value of 0 plots at  the thinnest
lineweight is available on a specified plotting device and is
displayed at one pixel wide in model space. (Fig 7)

Fig 7
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TASK 14 : Properties

 Command alias      Button Classic menu Ribbon/Application menu

            PR          Modify => Properties View => Pallettes => Properties

Current lineweight

Displays the current lineweight. To set the current
lineweight, select a lineweight from the lineweight list and
choose OK.

Display lineweight

Controls whether lineweight are displayed in the current
drawing. If this option is selected, lineweights are  dis-

played in model space and paper space.  You can also
set Display Lineweight by using the LWDISPLAY  system
variable. Regeneration time increases with lineweights that
are represented by more than one pixel.  Clear Display
Lineweight if performance slows down when working with
lineweights turned on in a drawing. This option does not
affect how objects are plotted.

As mentioned earlier each object has properties
associated with color, Line type, Line weight and so on.
You can modify these properties by using properties
pallette. It displays the properties of the selected object
or a set of objects. (Fig 8)

The following options are displayed.

Object type

Displays the type of object that is selected.

Select objects

Selects desired objects using any selection method. The
properties common to the selected objects are displayed

in the properties palette. You can then modify the
properties of the selected objects in the properties
palette, or you can make other changes to the selected
objects by entering an editing command.

Quick select

Displays the Quick Select dialog box.  Use Quick Select
to create selection sets based on filtering criteria.

Shortcut menu

The  following shortcut menu options are availabel when
you right-click the title bar.

Move

Displays a four-headed arrow cursor that you can use to
move the palette.  The palette does not dock.

Size

Displays a four-headed arrow cursor that you can use to
drag an edge or a corner to make the palette smaller or
larger.

Close

Closes the properties palette.

Auto-hide

Causes a floating palette to roll open and closed as the
cursor moves across it.  When this option is cleared, the
palette stays open.

Transparency

Displays the Transparency dialog box.

Line weight

Sets the lineweight to be used for borders that are
displayed. If you use a heavy lineweight, you may have to
change the cell margins.

Linetype

Sets the linetype to be used for borders that are displayed.

Color

Sets the color to be used for borders that are displayed.

Fig 8
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Double line

When checked, a double line border will be added to the
selected cells.

Spacing

Determining the spacing of double-line borders. The
default value is .1800.

Note Line type will not display in the preview.

All borders

Applies the border properties settings to all borders of the
selected table cells.

Outside borders

Applies the Border properties settings to the outside
borders of the selected table cells.

Inside borders

Applies the border properties settings to the inside
borders of the selected table cells.

No borders

Applies the border properties settings to none of the
borders of the selected table cells.

Top borders

Applies the border properties setting to the top borders of
the selected table cells.

Inside horizontal border

Applies the border Properties setting to the inside
horizontal borders of the seleted table cells.

Bottom border

Applies the border proerties setting to the bottom borders
of the selected  table cells.

Left border

Applies the border properties setting to the left borders of
the selected tabel cells.

Inside vertical border

Applies the border properties setting to the inside vertical
border of the selected table cells.

Right border

Applies the border properties setting to the right border of
the selected table cells.

TASK 15 : Matchprop

     Command alias      Button Classic menu Ribbon/Application menu

            MA          Modify => Match Home => Clipboard => Match Properties
    Properties

The match properties tool is used to apply properties like
color, line type, layer and line type scale of a source ob-
ject to selected objects.  The properties of the destination
object will be changes as the properties of the source
object.  This is a transparent tool and can be used when
another tool is active.

The following prompts are displayed.

Current active settings: Currently selected matchprop
 settings

Select destinaion Object(s) or [Settings]: Enter s or
select one or more objects to copy properties to

Destination object(s)

Specifies the objects to which you want to copy the prop-
erties of the source object.

Settings

Displays the Property Settings dialog box, in which you
can control which object properties to copy to the desti-
nation objects. By default, all object properties are se-
lected for copying.

Property settings

It specifies the properties that are copied from the select
source object to be destination objects.

Layer

The following options are displayed.

Basic properties

Color

Changes the color of the destination object to that of the
source object.  Available for all objects.

Fig 9
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Changes the layer of the destination object to that of the
source object.  Available for all objects.

Linetype

Changes the linetye of the destination object to that of the
source object.  Available for all objects except attributes,
hatches,  multiline text, points, and viewports.

Lineweight

Changes the lineweight of the destination object to that of
the source object. Available for all objects.

Transparency

Shifts are transparency of the destination object to the
source object.  Available for all objects.

Thickness

Shifts the thickness of the destination object to the source
object.  Available only for arcs, attributes, Circles, lines,
points, 2D polylines, regions, text, and traces.

Plot style

Shifts the plot style of the destination object to the source
object.  If you are working in color-dependent plot style
mode (PSTYLEPOLICY is set to1), this option is unavail-
able. Available for all objects, except those with the jitter
edge modifier applied.

Special properties

Dimension

In addition to basic object properties, this property when
availed changes the dimension style and annotative
properties from the destination object to the source ob-
ject.  Available only for dimension, leader, and tolerance
objects.
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PROCEDURE

TASK 1

1 Draw bed room size of 6400 x 6200 with help of line
comand,offset, hatch. dimension in different layers.

2 Draw ward robe with sliding shutters of 600mm width
at the entry of toilet with line command. (Fig 1)

TASK 2 :

Draw study table, chain with help of rectangle, design
centre. (Fig 1)

TASK 3 :

1 Draw cot, side table, carpet in specified dimensions
with help of rectangle, hatch commands.

2 Mention dimension of moving spaces. (Fig 1 & Fig 2)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.07

Draw bedroom interiors with help of CAD
Objectives: At the end of this exercise you shall be able to
• draw the layout design with help of CAD.
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PROCEDURE

TASK 1 : Data

Command alias Classic menu Ribbon/Application menu

          DS     Tools => Drafting settings        Command entry

Drafting settings contains set of traditional drafting tools,
that help draw easily. (Fig 1)

Grind and snap

Function key     Classic menu Ribbon/Application menu

         Grid F7, Snap F9                Status bar                                Status bar

To enhance drawing speed and efficiency, you can
display and snap the design to a rectangular grid.  You
can also control its spacing, angle, and alignment. (Fig 2)

Snap on

Turns snap mode on or off.  You can also turn snap mode
on or off by clicking snap on the statur bar pressing F9, or
by using the SNAPMODE system variable.

Snap spacing

Controls an invisible, rectangular grid of snap locations
that restricts cursor movement to specified XY intervals.

Snap X spacing

Specifies the snap spacing in the X direction.  The value
must be a positive real number (SNAPUNIT system
variable).

Equal X and Y spacing

Forces the X and Y spacing to the same values for snap
spacing and/or grid spacing.

Polar spacing

Controls the polar snap increment distance.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.08

Drafting settings in CAD applications
Objectives: At the end of this exercise you shall be able to
• do the editing/changes in the settings according to the requirement.

Fig 1

Fig 2
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Polar distance

Sets the snap increment distance when polar snap is
selected under snap type & style.  If this value is 0polar
snap distance assuemes the value for snap X spacing.
The polar distance setting is used in conjunction with polar
tracking and/or object snap tracking.  If neither of the
tracking feature is enabled, the I distance setting has no
effect(POLARDIST system variable)

Snap type

Sets the snap style and snap type.

Grid snap

Sets the snap type to grid.  When you specify points, the
cursor snaps along vertical or horizontal points.
(SNAPTYPE system variable).

Block editor

Sets the grid style to dotted grid for the block
editor(GRIDSTYLE system variable).

Sheet/Layout

Sets the grid style to dotted grid for sheet and layout
(GRIDSTYLE system variable).

Grid spacing

Controls the display of a grid that heps you visualize the
distances.

The limits of the grid are controlled by the
LIMITS command and the GRID DISPLAY
system variable.

Grid X spacing

Specifies the grid spacing in the X driection.  If this value
is 0, the grid assumes the value set for snap X
spacing(GRIDUNIT system variable).

Grid Y spacing

Specifies the grid spacing the Y direction.  If this value is
0, the grid assumes the value set for snap Y
spacing.(GRIDUNIT system variable)

Major line every

Specifies the frequency of major grid lines relative to
minor grid lines.  Grid lines rather than grid dots are
displayed when GRIDSTYLE is set to 0 (GRIDMAJOR
system variable).

Grid behaviour

Controls the appearance of the grid lines that are displayed
when GRIDSTYLE is set to 0.

Adaptive grid

Limits the density of the grid when zoomed out
(GRIDDISPLAY system variable).

Allow subdivision below grid spacing

Generates additional, more closely spaced grid lines when
zoomed in.  The frequency of these grid lines is
determined by the frequency of the major grid lines
(GRIDDISPLAY and GRIDMAJOR system variables).

Display grid beyond limits

Display the grid beyond the area specified by the LIMITS
command (GRIDDISPLAY system variable).

Rectangular snap

Sets the snap style to standard rectangular snap mode.
When the snap type is set to grid snap and the snap
mode is on, the cursor snaps to a rectangular snap grid.
(Fig 3)

Isometric snap

Sets the snap style to isometric snap mode.  When the
snap type is set to grid snap and snap mode is on, the
cursor snaps to an isometric snap grid. (Fig 4)

Polar snap

Sets the snap type to polar.  When snap mode is on and
you specify points with polar tracking turned on, the
cursor snaps along polar alignment angles set on the
polar tracking tab relative to the starting polar tracking
point.

Grid on

Turns the grid on or off.  You can also turn grid mode on or
off by clicking grid on the status bar, by pressing F7.

Grid style

Sets the grid style in 2D contexts.  You can also set grid
style.

2D model space

Sets the grid style to dotted grid for 2D model space.
(Fig 5)
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Follow dynamic UCS

Changes the grid plane to follow the XY plane of the
dynamic UCS(GRIDDISPLAY system variable).

Ortho

 Function key  Classic menu Ribbon
 /Application menu

        F8     Status bar         Status bar

Orthos is short for orthogonal, which means either vertical
or horizontal.  It is a drawing mode which can either be
turned on or off.  When ortho is turned on, the ortho button
appears pressed in.  You can see how this appears by
looking at the status bar illustration below.  In the
illustration below.  In the illustration, ortho is turned on.
(Fig 6)

Polar tracking

 Function key  Classic menu Ribbon
 /Application menu

 Polar tracking     Status bar         Status bar
       : F10

  Otrack : F11

Polar tracking restricts cursor movement to specified
angles. Polar Snap restricts cursor movement to
specified increments along a polar angle. (Fig 7)

Polar tracking on

Turns polar tracking on and off. You can also turn polar
tracking on or off by using the AUTOSNAP system
variable.

Polar angle settings

Set the alignment angles for polar tracking (POLARANG
system variable).

Increment angle

Sets the polar increment angle used to display polar
tracking alignment paths.  You can enter any angle, or
select a common angle of 90,45,30,22.5,18,15,10 or 5
degrees from the list (POLARANG system variable).

For example, if you set an increment angle of 30, it will
show tracking vector in all multiple angles of 30 as shown
in Fig 8.

Additional angles

Makes any additional angles in the list available for polar
tracking.  The additional angles check box is also
controlled by the POLARMODE system variable, and the
list of additional angles is also controlled by the
POLARADDANG system variable.
Additional angles are absolute, not incremental.

List of angles

If Additional Angles is selected, lists the additional angles
that are available. To add new angles, click New. To
remove existing angles, click Delete. (POLARADDANG
system variable)

New

Displays the Add New Angle dialog box. Up to 10 addi-
tional polar tracking alignment angles can be added.

Before adding fractional angles, you must set the
AUPREC system variable to the
appropriatedecimal precision to avoid
undesired rounding. For example, if the value of
AUPREC is 0 (the default value), all fractional
angles you enter are rounded to the nearest whole
number.

Fig 6

Fig 7
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Delete

Deletes selected additional angles.

Track orthogonally only

Displays only orthogonal (horizontal/vertical) object snap
tracking paths for acquired object snap points when ob-
ject snap tracking is on. (POLARMODE system variable)

Track using all polar angle settings

Applies polar tracking settings to object snap tracking.
When you use object snap tracking, the cursor tracks
along polar alignment angles from acquired object snap
points. (POLARMODE system variable)

Polar angle measurement

Sets the basis by which polar tracking alignment angles
are measured.

Absolute

Bases polar tracking angles on the current user
coordinate system (UCS).

Relative to last segment

Bases polar tracking angles on the last segment drawn.

Object snap and object snap tracking

 Function key  Classic menu Ribbon
 /Application menu

        F3     Status bar          Status bar

Object snap on

Turns running object snaps on and off.  The object snaps
selected under object snap modes are active while object
snap is on (OSMODE system variable)

Object snap tracking on

Turns object snap tracking on and off.  With object snap
tracking, the cursor can track along alignment paths based
on other object snap points when specifying points in a
command.   To use object snap tracking, you must turn
on one or more object snaps (AUTOSNAP system
variable).

Object snap modes

Lists object snaps that you can turn on as running object
snaps.

Object snap on

Turns running object snaps on and off. The object snaps
selected under Object Snap Modes are active while ob-
ject snap is on. (OSMODE system variable)

Object snap tracking on

Turns object snap tracking on and off. With object snap
tracking, the cursor can track along alignment paths based
on other object snap points when specifying points in a
command. To use object snap tracking, you must turn on
one or more object snaps. (AUTOSNAP system variable)

Object snap modes

Lists object snaps that you can turn on as running object
snaps.

Endpoint

Snaps to the closest endpoint of an arc, elliptical arc,
line, multiline, polyline segment, spline, region, or ray, or
to the closest corner of a trace, solid, or 3D face. (Fig 10)

The object snaps (Osnaps for short) are drawing aids which
are used in conjunction with other commands to help you
draw accurately. Osnaps allow you to snap onto a
specific object location when you are picking a point.  Press
TAB to cycle through the options. (Fig 9)

The following options are displayed;

Midpoint

Snaps to the midpoint of an arc, ellipse, elliptical arc, line,
multiline, polyline segment, region, solid, spline or xline.
(Fig 11)

Center

Snaps to the center of an arc, circle, ellipse, or elliptical
arc.  The cursor must pass over the circumference of the
circle or the arc so that the center can be found. (Fig 12)

Fig 9
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Node

Snaps to a point object, dimension definition point, or
dimension text origin.  The node osnap snaps to the center
of a point object.  This osnap can be useful if you have
created a number of points with the measure or divide
commands.  You could, for example insert a number of
regularly spaced tree symbols(blocks) along a line using
the node osnap for the insertion point of each block.
(Fig 13)

Quadrant

The quadrant osnap snaps to one of the four circle quadrant
points located at north, south, east and west or 90,270,0
and 180 degrees respectively. (Fig 14)

Intersection

The intersection osnap snaps to the physical intersection
of any two drawing objects (ie. where lines, arcs or circles
etc. cross each other) and to polyline vertices.  However,
this osnap can also be used to snap to intersection points
which do not physically exist.  This feature is called the
extended. (Fig 15)

You might get varying results if you have both
the intersection and apparent intersection
running object snaps turned on at the same
time.  Intersection and extended intersection
do not work with edges or corners of 3D solids.

Extension

Causes a temporary extension line or arc to be displayed
when you pass the cursor over the endpoint of objects, so
you can specify points on the extension. (Fig 16)

When working in perspective view, you
cannot track along the extension line of an arc
or elliptical arc.

Insertion

Snaps to the insertion point of an attribute, a block, a
shape, or text. (Fig 17)
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Perpendicular

Snaps to a point perpendicular to an arc, circle, ellipse,
elliptical arc, line, multiline, polyline, ray, region, solid,
spline, or xline.  As with the tangent osnap, perpendicular
can be used to draw a line to a perpendicular point (as in
the illustration), or from a perpendicular point, known as
the “Deferred perpendicular” snap mode. (Fig 18)

cross, as in the illustration.  However, since AutoCAD is a
3 dimensional drawing environment, the two line may not
physically intersect.  One line may be at ground level and
teh other may be 10 meters or more above or below ground
level.  As with the intersection osnap, apparent intersection
also has an “Extended”  mode. (Fig 21)

Tangent

Snaps to the tangent of an arc, circle, ellipse, elliptical
arc, or spline.  This osnap works in two ways.  You can
either draw a line from a point to the tangent point(See
illustration) or you can draw a line from a tangent point,
the latter is referred to as the “Deferred tangent” snap
mode.(Fig 19)

When you use the from option in conjunction
with the tangent snap mode to draw objects
other than lines from arcs or circles, the first
point drawn is tangent to the arc or circle in
relation to the last point selected in the
drawing area.

Nearest

Snaps to the nearest point on an arc, circle, ellipse,
elliptical arc, line, multiline, point, polyline, ray, spline, or
x-line.  Osnap is useful in making sure that a pick point
lies on a drawing object but you don;t necessarily mind
exactly where it is located. (Fig 20)

Apparent intersection

Apparent intersection snaps to the point where objects
appear to intersect in the current view.  For example you
may be looking at a drawing in plan view where two lines

You might get varying results if you have both
the intersection and apparent intersection
running object snaps turned on at the same
time.

Parallel

Constrains a line segment, polyline segment, ray or xline
to be parallel to another linear object. After you specify
the first point of a linear object, specify the parallel object
snap. Unlike other object snap modes, you move the
cursor and hover over another linear object until the angle
is acquired. Then, move the cursor back toward the object
that you are creating. When the path of the object is
parallel to the previous linear object, an alignment path is
displayed, which you can use to create the parallel
object. (Fig 22)

Turn off ORTHO mode before using the
parallel object snap. Object snap tracking and
polar snap are turned off automatically during
a parallel object snap operation. You must
specify the first point of a linear object before
using the parallel object snap.

Select All

Turns on all object snap modes.

Clear All

Turns off all object snap modes.

Dynamic input

 Function key Classic menu Ribbon/Application
menu

        F12  Status bar    Status bar
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It controls pointer input, dimension input, dynamic
prompting, and the appearance of drafting tooltips.
(Fig 23)

Fig 23

Enable pointer input

Turns on pointer input. When pointer input and
dimensional input are both turned on, dimensional input
supersedes pointer input when it is available.
(DYNMODE system variable) (Fig 24)

Fig 24

Pointer input

Displays the location of the crosshairs as coordinate values
in a tooltip near the cursor. When a command prompts
you for a point, you can enter coordinate values in the
tooltip instead of in the Command window.

Preview area

Shows an example of pointer input.

Settings

Displays the pointer input settings dialog box. (Fig 25)

Format

Controls coordinate format in the tooltips that are displayed
when pointer input is turned on.

Polar format

Displays the tooltip for the second or next point in polar
coordinate format.  Enter a comma (,) to change to Carte-
sian format. (DYNPIFORMAT system variable)

Cartesian format

Displays the tooltip for the second or next point in Carte-
sian coordinate format. Enter an angle symbol (<) to
change to polar format. (DYNPIFORMAT system variable)

Fig 25

Relative coordinates

Displays the tooltip for the second or next point in relative
coordinate format.  Enter a pound sign (#) to change to
absolute format. (DYNPICOORDS system variable)

Absolute coordinates

Displays the tooltip for the second or next point in
absolute coordinate format.  Enter an at sign ( ) to change
to relative format. Note that you cannot use the direct
distance method when this option is selected.
(DYNPICOORDS system variable)

Visibility

Controls when pointer input is displayed. (DYNPIVIS
system variable)

As soon as I Type coordinate data

When pointer input is turned on, displays tooltips only
when you start to enter coordinate data. (DYNPIVIS
system variable)

When a command asks for a point

When pointer input is turned on, displays tooltips when-
ever a command prompts you for a point. (DYNPIVIS
system variable)

Always—Even when not in a command

Always displays tooltips when pointer input is turned on.
(DYNPIVIS system variable)

Enable dimension input

Turns on dimension input.  Dimensional input is not
available for some commands that prompt for a second
point. (DYNMOD system variable) (Fig 26)
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Dimension input

Displays a dimension with tooltips for distance value and
angle when a command prompts for a second point or a
distance.  The values in the dimension tooltips change as
you move the cursor.  You can enter values in the tooltip
instead of on the command line.

Preview area

Shows an example of dimensional input.

Settings

Displays the dimension input settings dialog box. (Fig 27)

input tooltips when you are using grip editing to stretch an
object. (DYNDIVIS (page 911) system variable)

Show the following dimension input fields
simultaneously

When you are using grip editing to stretch an object,
displays the dimensional input tooltips that are selected
below. (DYNDIVIS and DYNDIGRIP system variables)

Resulting dimension

Displays a length dimensional tooltip that is updated as
you move the grip.

Length change

Displays the change in length as you move the grip.

Absolute angle

Displays an angle dimensional tooltip that is updated as
you move the grip.

Angle change

Displays the change in the angle as you move the grip.

Arc radius

Displays the radius of an arc, which is updated as you
move the grip. (Fig 28)

Fig 26

Fig 27

Visibility

Controls which tooltips are displayed during grip
stretching  when dimensional input is turned on. (DYNDIVIS
system variable)

Show only 1 dimension input field at a time

Displays only the length change dimensional input tooltip
when you are using grip editing to stretch an object.
(DYNDIVIS (page 911) system variable)

Show 2 Dimension input fields at a time

Displays the length change and resulting dimensional

Fig 28

Dynamic prompts

Displays prompts in a tooltip near the cursor when neces-
sary in order to complete the command. You can enter
values in the tooltip instead of on the command line.

Preview area

Shows an example of dynamic prompts.

Show command prompting and command input near
crosshairs

Displays prompts in Dynamic Input tooltips. (DYNPROMPT
system variable)

Show additional tips with command prompting

Controls whether tips for using Shift and Ctrl for grip
manipulation are displayed. (DYNINFOTIPS  system
variable)

Drafting tooltip appearance

Displays the Tooltip appearance dialog box. (Fig 29)
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Fig 29
Previews

Displays an example of the current tooltip appearance
settings.

Size

Specifies a size for tooltips. The default size is 0. Use the
slider to make tooltips larger or smaller.

Transparency

Controls the transparency of tooltips. The lower the setting,
the less transparent the tooltip. A value of 0 sets the tooltip
to opaque.

Apply to

Specifies whether the settings apply to all drafting tooltips
or only to dynamic input tooltips. (DYNTOOLTIPS system
variable)

Override OS settings for all drafting tooltips

Applies the settings to all tooltips, overriding the settings
in the operating system.

Use settings only for dynamic input tooltips

Applies the settings only to the drafting tooltips used in
Dynamic Input.
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PROCEDURE

TASK 1 : Layers
New layer
Creates a new layer.  The list displays a layer named
LAYER1.  The name is selected so that you can enter a
new layer name immediately.
Set current
Sets the selected layer as the current layer.  Objects you
create are drawn on the current layer.
Current layer
Displays the name of the current layer.
Search for layer
Filters the layer list by name quickly as you enter
characteristics.
Status line
Shows the name of the current filter, the number of layers
displayed in the list view, and the number of layers in the
drawing.
Invert filter
Displays all layers that do not meet the criteria in the
selected layer property filter.
Refresh
Refreshes the layer usage information  by scanning all
the entities in the drawing.
Settings
Displays the layer settings dialog box, in which you can
set new layer notification settings, if layer filter changes
are applied to the layer toolbar, and change the back-
ground color for layer property overrides.
Apply
Applies changes that have been made to layers and filters
but does not close the dialog box.
Layer states manager
While working on a drawing, you can save the properties
of all layers under one name and restore the properties

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.09

Advanced drafting commands - I
Objectives: At the end of this exercise you shall be able to
• understand following advanced commands

• layers
• Q select
• filter
• group
• block
• insert
• write block
• divide
• measure.

New property filter
Displays the layer filter properties dialog box, where you
can create a layer filter based on one or more properties
of the layers.
New group filter
Creates a layer filter that conatins layers that you select
and add to the filter
Layer states manager
Displays the layer states manager, in which you can save
the current property settings for layers in a named layer
state and then restore these settings later.

Layer is a concept that allows grouping of drawn
geometry in distinct and separate categories according to
similar features and a common theme.  This allows
control over drawing, by applying properties to the layers
such as assigning colors and linetypes.  You can also
manipulate each individual layer making it visible and
invisible for clarity as well as being able to lock them to
prevent editing.

For example, all the walls on floor plan will exist in “wall”
layer, all the doors on “door” layer, windows on “window”
layer and so on.  Layer is like transparent sheets with
each sheet having unique and distinct data.  But when
viewed at once, they show the complete picture. (Fig 1)

The following options are displayed.

Fig 1
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later.  The properties you saved can be imported to other
drawings.  This saves times in setting properties for
layers in new drawing.
The following options are displalyed. (Fig 2)

Delete
Removes the selected named layer state.

Import
Displays a standard file selection dialog box, where you
can load a previously exported layer state (LAS) file into
the current drawing.  Layer states in files (DWG, DWS, or
DWT) can be imported.

Export
Displays a standard file selection dialog box, where you
can save the selected named layer state to a layer state
(LAS) file.

Restore

Restore state and property settings of all layers in a draw-
ing to their previously saved settings.

Close

Closes the layer states manager and saves changes.

Restore options

Turn off layers not found in layer state

Where a layer state is restored, turns off new layers for
which settings were not saved so that the drawing looks
the same way it did when the named layer state was saved.

Apply properties as viewport overrides

Applies layer property overrides to the current viewport.
This option is available when the layer states manager is
accessed when a layout viewport is active.

More options

Controls the display of additional options in the layer states
manager dialog box.

Layer properties to restore

Restores the selected layer settings and  properties to
their previously saved state.  The visibility in current viewport
option is available only for layout viewports, while the On/
Off and frozen/thawed options are available only for model
space viewports.

Select all

Selects all the settings.

Clear all

Removes selection from all the settings.

Layer states
Lists the named layer states that have been saved in the
drawing, the space in which they were saved (model space,
layout, or xref), whether the layer list is the same as in the
drawing, and an optional description.

Don't list layer states in Xrefs
Controls whether layer states in xrefs are displayed.

New
Displays the new layer state to save dialog box, where
you can provide a name and  a description for the new
named layer state.

Save
Saves the selected named layer state.

Edit
Displays the edit layer state dialog box, where you can
modify  a selected named layer state.

Rename
Allows in place editing of the layer state name.

TASK 2 : Select

Procedure

It places selected objects in the previous selection set.  A
small box, called the object selection target or pickbox,
replaces the crosshairs on the graphics cursor. At the
select objects prompt in a subsequent command, use the
previous option to retrieve the previous selection set.  You

can also press and hold the ctrl key to select original
individual forms that are part of composite solids or verti-
ces, edges, and faces on 3D solids. You can select one
of these subobjects, or create a selection set of more
than one subobject.  Your  selection set can include more
than one type of subobject. To view all options, enter? at
the command prompt.
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Window

Window all objects completely inside a rectangle defined
by two points.  Specifying the corners from left to right
creates a window selection (specifying the corners from
right to left creates a crossing selection).

Last

Selects the most recently created visible object.  The ob-
ject must be in the current space, that is, model space or
paper space, and its layer must not be set to frozen or off.

Crossing

Selects objects within and crossing an area defined by
two points.  A crossing selection is displayed as dashed
or otherwise highlighted to differentiate it from window se-
lection.

Box

Selects all objects inside or crossing a rectangle speci-
fied by two points.  If the rectangle's points are specified
from right to left, box is equivalent to crossing.  Other-
wise, box is equivalent to window.

All

Selects all objects in either model space or the current
layout, except those objects on frozen or on locked lay-
ers.

Fence

Selects all objects crossing a selection fence.  The fence
method is similar to Cpolygon except that the fence is not
closed and a fence can cross itself.  Fence is not affected
by the pickadd system variable.

Wolygon

Selects objects completely inside a polygon defined by
points.  The polygon can be of any shape but can neither
cross nor touch itself.  The last segment of the polygon is
drawn so that it remains closed at all times.  Wpolygon is
not affected by the pickadd system variable.

Cpolygon

Selects objects within and crossing a polygon defined by
specifying points.  The polygon can be of any shape but
cannot cross or touch itself.  The last segment of the
polygon is drawn so that it remains closed at all times.
Cpolygon is not affected by the Pickadd system variable.

Group

Selects all objects within a specified group.

Add

Switches to the add method: selected objects can be

added to the selection set by using any of the object se-
lection methods. Auto and add are the default methods.

Remove

Switches to the remove method: objects can be removed
from the current selection set using any object selection
method.  An alternative to remove mode is to hold down
shift while selecting single objects or use the automatic
option.

Multiple

Selects objects individually without highlighting them dur-
ing object selection.  This speeds up object selection for
highly complex objects.

Previous

Selects the most recent selection set.  The previous se-
lection set is cleared by operations that delete objects
from the drawing.

Note The previous selection set is ignored, if
you switch spaces.

Undo

Cancels the selection of the object most recently added
to the selection set.

Auto

Switches to automatic selection: pointing to an object,
this option selects the object.  Whereas, pointing to a
blank area inside or outside an object forms the first cor-
ner of a box defined by the box method.  Auto and add are
default methods.

Single

Switches to the single method: selects the first object or
set of objects designated rather than continuing to prompt
for further selections.

Subobject

Allows you to select original individual forms that are part
of composite solids or vertices, edges, and faces on 3D
solids.  You can select one of these subobjects or create
a selection set of more than one subobject.  Your selec-
tion set can include more than one type of subobject.
Pressing and holding the ctrl key is the same as select-
ing the select command's subobject option.

Object

Ends the ability to select subobjects.   Allows you to use
object selection methods.

TASK 3 : Qselect

The quick selection tool is used to create a new selection
set that will include or exclude all objects whose object
type and property criteria matches as specified for the

selection set. The quick select can be used to select the
entities in the entire drawing or in the existing selection
set.
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Procedure

The quick select dialog box is displayed. (Fig 3)

Object type

Specifies the type of objects to be included in the filtering
criteria.  If the filtering criteria are being applied to the
entire drawing, the object type list includes all object types,
including custom.  Otherwise, the list includes only the
object types of the selected objects.

Properties

Specifies the object property for the filter.  This list in-
cludes all searchable properties for the selected object
type.  The property you select determines the options
available in operator and value.

Operator

Controls the range of the filter.  Depending on the selected
property, options can include equals, not equal to, greater
than, less than, and wildcard match.  Wildcard match is
available only for text fields that can be edited.  Use the
select all option to ignore all properties filters.

Value

Specifies the property value for the filter.

How to apply

Specifies whether you want the new selection set to in-
clude or exclude objects that match the specified filtering
criteria.  Select include in new selection set to create a
new selection set composed only of objects that match
the filtering criteria.  Select exclude from new selection
set to create a new selection set composed only of ob-
jects that do not match the filtering criteria.

Append to current selection set

Specifies whether the selection set created by Qselect
replaces or is appended to the current selection set.

Note : Qselect supports custom objects (objects
created by another application) and their
properties.  If a custom object uses properties
other than AutoCAD properties, the custom
object's source application must be running in
order for the properties to be available to
qselect.

Data

Command alias Short key Button Classic menu Ribbon/Application
menu

qselect End any active commands, Tools=> Home => Utilities
right-click in the drawing area, Quick select => Quick select
and choose quick select.

Fig 3

The following options are displayed;

Apply to

Applies  the filtering criteria to the entire drawing or to the
current selection set (if one exists)

If append to current selection set is selected, the filtering
criteria is applied to the entire drawing.

Select objects

Temporarily closes the quick select dialog box so that
you can select the objects to which you want to apply the
filter criteria.

TASK 4 : Filter

Procedure

We had already discussed using quick select before.
Qselect is very useful if you just use it occasionally with

not many properties to filter.  These is one more utility
that we can use, very powerful even it's not as pretty as
qselect.
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1 You can set multiple conditional filters at once.  Qselect
allows you to apply only one conditional filter at a time.
Then you need to apply another filter to your selection.

2 You can save the filter setting and use it again later.
(Fig 4)

For example, the following filter selects all circles except
the ones with a radius greater than or equal to 1.0:

Object = circle

**Begin NOT

Circle radius >= 1.00

**End NOT

X, Y, Z parameters

Define additional filter parameters depending on the ob-
ject.  For example, if you select line start, you can enter
the X, Y, and  Z coordinate values that you want to filter.

In the filter parameters, you can use relative operators
such as < (less than) or > (greater than). For example,
the following filter selects all circles with center points
greater than or equal to 1,1,0 and radii greater than or
equal to 1:

Object = circle

Circle center X > = 1.0000 Y > = 1.0000 Z > = 0.0000

Circle radius > = 1.0000

Select

Displays a dialog box listing all items of the specified type
in the drawing and selects the items to be filtered.  For
example, if you select the object type color, 'select' dis-
plays a list of colors to choose to be filtered.

Add to list

Adds the current select filter property to the filter list.  Fil-
ter properties that you add to the unnamed filter remain
available during the current work session unless you manu-
ally delete them.

Substitute

Replaces the filter property selected in the filter property
list with the one displayed in select filter.

Add selected object

Adds one selected object in the drawing to the filter list.

Edit item

Moves the selected filter property into the select filter area
for editing. The edited filter replaces the selected filter
property.

Delete

Deletes a selected filter property from the current filter.

Clear list

Deletes all the listed properties from the current filter.

Named filters

Displays, saves, and deletes filters.

Current

Displays saved filters.  Select a filter list to make it current.
The named filter and its list of properties are loaded from
the default file, filter, nfl.

Fig 4

To create filter, type 'Fi' on the command line to open the
object selection filter dialogue box.  If you have already
chosen a command, type 'filter' at the select object: prompt
to create a filter transparently.

Note : The selection filter finds only colors and
linetypes of objects that have been specifically
set as such, rather than part of the layer
definition.

The following options are displayed.

Filter property list

Displays a list of the filter properties that compose the
current filter.  The current filter is the filter that you select
in current at the named filters area.

Select filter

Adds filter properties to the current filter.

Object types and logical operators

Object types that you can filter and logical operators (AND,
OR, XOR, and NOT) that could be used for grouping the
filter expressions are listed when this option is availed.

Logical operators

Starting Encloses Ending
operators operator

Begin AND One or more operands End AND

Begin OR One or more operands End OR

Begin XOR Two operands End XOR

Begin NOT One operand End NOT

If you use logical operators, make sure that you pair and
balance them correctly in the filter list.  The number of
operands you can enclose depends on the operation.
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Save as

Saves a filter and its list of properties.  The filter is saved
in the filter.nfl file.  Names can contain up to 18 charac-
ters.

Delete current filter list

Deletes a filter and all its properties from the default filter
file.

Apply

Exits the dialog box and displays the select objects
prompt, where you create a selection set. The current
filter is used on the objects you select.

TASK 5 : Group

Procedure

The following prompts are displayed.

Enter a group option [?- List Groups/Order/Add/Remove/
Explode/Rename/Selectable/Create] <Create>:

? - List groups

Lists names and descriptions of groups defined in the
drawing.

Order

Changes the numerical order of objects within a group.
Re-ordering is useful while creating tool paths.  For
example, you can change the cut order for the horizontal
and vertical lines of a tool path pattern.

Position number

Specifies the position number of the object to reorder.  To
reorder a range of objects, specify the first object's position
number.

Reverse order

Reverses the order of all members in a group.

Add

Adds objects to a group.

Remove

Removes objects from a group.

If you remove all the group's objects, the group remains
defined.  You can remove the group definition from the
drawing by using the explode option.

Explode

Deletes a group definition by exploding the group into its
component objects.

Rename

Assigns a new name to an existing group.

Selectable

Specifies whether a group is selectable.  When a group is
selectable, selecting one object in the group selects the
whole group. Objects on locked or frozen layers are not
selected.

Create

Creates a group.

Note : Group names can be up to 31 characters
long and can include letters, numbers, and
special characters like dollar sign ($), hyphen
(-), and underscore (_) but not spaces.  The
name is converted to uppercase characters.

TASK 5 : Block

Data

Command alias Button Classic menu Ribbon/application menu

G Draw => Block => Make Draw => Block => Create

Data

Command alias Button Classic menu Ribbon/application menu

G Tools => Group Home => Groups => Group

Procedure

A block is a collection of objects (lines, arcs, circles, text,
etc.) that form a more complex entity that normally repre-
sents an object in the real world, e.g. a door, a chair, a
window, or a computer. (Fig 5)

There are many advantages of using blocks, the major
ones being described as follows:

• Blocks are a single entity. This means that you can
modify (move, copy, rotate) a block by selecting only
one object in it.

• You can build up a library of blocks consisting of the
parts that you require many times in your workday.
These blocks can be stored in a separate folder and
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even on a network so that all drafters have access to
them. Think of plumbing parts, valves, elbows, etc.

• Using blocks can help keep your file size down.
AutoCAD stores block definitions in its database.
When you insert a block, AutoCAD only stores the
name of the block, its location (insertion point), scale
and rotation.  This can be very noticeable in large draw-
ings.

• If you wish to change something, you can redefine a
block.  For instance, you draw a chair and turn it into a
block, in the diagram.  Later, you're told that the size
of the chair has changed.  Since you used a block you
can re - define the block and all the chairs are updated
automatically.  This saves a lot of time and labour, as
in other cases, if you had placed (or copied) 100 chairs
in your drawing, you would have to manually change
each one.

• Blocks can also contain non-graphical information,
which are text objects called attributes.  For instance,
you have made blocks of different chairs.  You can add
information to the block such as the manufacturer, cost,
weight, etc.  This information stays with the block, but
can also be extracted to a database or spreadsheet.
This would be useful for things such as a bill of materi-
als.  Attributes can also be visible or invisible in your
drawing.  Another good use of attributes could be a
title block.

• You can also add internet hyperlinks to blocks with
ease so you can connect a block to a page onto a
supplier's online catalog.

• There are two types of blocks you can create: blocks
that are internal to your current drawing and those that
are external, or saved as a separate file.  To create the
different types, different commands are used.  Many
companies use a template that will include a number
of blocks for use in the project.

The following options are displayed.

Name

It names the block.  The name can have up to 255
characters and can include letters, numbers, blank spaces,

and/or any special character not used by the operating
system or the program for other purposes.

The block name and definition are saved in the current
drawing.

Preview

If an existing block is selected under Name, this option
displays a preview of the block.

Base point

Specifies an insertion base point for the block.  The default
value is 0, 0, 0.

Specify on-screen

Prompts you to specify the base point when the dialog
box is closed.

Pick insertion base point

Temporarily closes the dialog box so that you can specify
an insertion base point in the current drawing.

X

Specified the X coordinate value.

Y

Specifies the Y coordinate value.

Z

Specifies the Z coordinate value.

Objects

Specifies the objects to be included in a new block and
also whether to retain or delete the selected objects or
convert them to a block instance after you create the block.

Specify  on-screen

Prompts you to specify the objects when the dialog box is
closed.

Select objects

Closes the block definition dialog box temporarily while
you select the objects for the block.  When you finish
selecting the objects, press enter to return to the dialog
box.

Quick select

Displays the quick select dialog box, which defines a
selection set.

Retain

Retains the selected objects as distinct objects in the
drawing after you create the block.

Convert to block

Converts the selected objects to a block instance in the
drawing after you create the block.

Delete

Deletes the selected objects from the drawing after you
create the block.

Fig 5
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Object selected

Displays the number of selected objects.

Behavior

Specifies the behavior of the block.

Annotative

Specifies that the block is annotative.

Match block orientation to layout

Specifies that the orientation of the block references in
paper space viewports, matches the orientation of the
layout.  However, this option is unavailable if the annotative
option is cleared.

Scale uniformly

Specifies whether or not the block reference is prevented
from being non-uniformly scaled.

Allow exploding

Specifies whether or not the block reference can be
exploded.

Settings

Specifies settings for the block.

Block unit

Specifies the insertion units for the block reference.

Hyperlink

Opens the insert hyperlink dialog box, which you can use
to associate a hyperlink with the block definition.

Description

Specifies the text description of the block.

Open in block editor

Opens the current block definition in the block editor when
you click ok.

TASK 6 : Insert

Data

Command alias Button Classic menu Ribbon/application menu

I Insert => Block => Make Draw => Block => Insert

Procedure

The following options are displayed. (Fig 6)

Name

Specifies the name of a block to be inserted, or the name
of a file to be inserted as a block.

Browse

Opens the select drawing file dialog box (a standard file
selection dialog box) where you can select a block or
drawing file to be inserted.

Path

Specifies the path to the block.

Locate using geographic data

Inserts drawing using geographic data as the reference.

Specifies if the current and attached drawing contain
geographic data. This option is available only if both
drawings have geographic data.

Description

Displays the description that was saved with the block.

Preview

Display a preview of the specified block to be inserted. A
lightning bolt icon in the lower-right corner of the preview
indicates that the block is dynamic.  An icon indicates
that the block is annotative.

Insertion point

Specifies the insertion point for the block.

Specify on-screen

Specifies the insertion point of the block using the pointing
device.

Input coordinates

Allows you to manually enter the X, Y, and Z coordinate
value for the insertion point of the block.

X

Sets the X coordinate value.

Y

Sets the Y coordinate value.

Fig 6

CCM&RE : Architectural Assistant - Exercise 2.1.09



74

Z

Sets the Z coordinate value.

Scale

Specifies the scale for the inserted block.  Specifying
negative values for the Z, Y, and Z scale factors inserts a
mirror image of a block.

Specify on-screen

Specifies the scale of the block using the pointing device.

Input scale factor

Allows you to manually enter a scale factor for the block.

X

Sets the X scale factor.

Y

Sets the Y scale factor.

Z

Sets the Z scale factor.

Uniform scale

Specifies a single scale value for X, Y, and Z coordinates.

Rotation

Specifies the rotation angle for the inserted block in the
current UCS.

Specify on-screen

Specifies the rotation of the block using the pointing device.

Input angle

Allows you to manually enter an angle of rotation for the
block.

Angle

Sets a rotation angle for the inserted block.

Block unit

Displays information about the block units.

Unit

Specifies the insunits value for the inserted block.

Factor

Displays the unit scale factor, which is calculated based
on the insunits value of the block and the drawing units.

Explode

Explodes the block and inserts the individual parts of the
block.  When explode is selected, you can specify a
uniform scale factor only.

Component objects of a block drawn on layer 0 remain on
that layer.  Objects having color Byblock are white.  Objects
with linetype byblock have the continuous linetype.

TASK 7 : Write block

Data

Command alias Button Classic menu Ribbon/application menu

          WBLOCK Draw => Block => Insert

Procedure

The write block dialog box displays different default settings
depending on whether nothing is selected, a single block
is selected, or objects other than blocks are selected.
(Fig 7)

Source

Specifies blocks and objects, saves them as a file, and
specifies insertion points.

Block

Specifies an existing block to be saved as a file.  Select a
name from the list.

Entire drawing

Selects the current drawing to be saved as another file.

Objects

Selects objects to be saved as a file.  Specify a base
point and selects the objects below.

Fig 7
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Base point

Specifies a base point for the block.  The default value is
0,0,0.

Pick point

Temporarily closes the dialog box so that you can specify
an insertion base point in the current drawing.

X

Specifies the X coordinate value for the base point.

Y

Specifies the Y coordinate value for the base point.

Z

Specifies the Z coordinate value for the base point.

Objects

Sets the effect of block creation on objects used to create
a block.

Retain

Retains the selected objects in the current drawing after
saving them as a file.

Convert to block

Converts the selected object or objects to a block in the
current drawing after saving them as a file.  The block is
assigned the name in file name.

Delete from drawing

Deletes the selected objects from the current drawing af-
ter saving them as file.

Select objects button

Temporarily closes the dialog box so that you can select
one or more objects to save to the file.

Quick select button

Opens the quick select dialog box, which you can use to
filter your selection set.

Objects selected

Indicates the number of objects selected.

Destination

Specifies the new name and location of the file and the
units of measurement to be used when the block is in-
serted.

File name and path

Specifies a file name and path where the block or objects
will be saved.

[...]

Displays a standard file selection dialog box.

Insert units

Specifies the unit value to be used for automatic scaling
when the new file is dragged from design center or in-
serted as a block in a drawing that uses different units.
Select unit less if you do not want to automatically scale
the drawing when you insert it.

TASK 8 : Divide

Data

Command alias Button Classic menu Ribbon/application menu

DIV Draw => Point => Divide Home tab => Draw panel => Divide

Procedure

Creates evenly spaced point objects or blocks along the
length or perimeter of an object. (Fig 7)

Select object to divide: Use an object selection method

Enter number of segments or [Block]: Enter a value from
2 through 32,767, or enter b

Number of segments

Places point objects at equal intervals along the selected
objects.

Use DDPTYPE to set the style and size of all point ob-
jects in a drawing.

Block

Places blocks at equal intervals along the selected ob-
ject.  If the block has variable attributes, these attributes
are not included.

Enter name of block to insert: Enter the name of a block
currently defined in the drawing

Align block with object? [Yes/No] <Y>: Enter y or n or
press ENTER

-Yes
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Specifies that the X axes of the inserted blocks be tan-
gent to, or collinear with, the divided object at the dividing
points.

-No

Aligns the blocks according to their normal orientation.

Enter number of segments: Enter a value from 2 through
32,767 (Fig 8)

TASK 9 : Measure

The illustration shows an arc divided into five equal parts
using a block consisting of a vertically oriented ellipse.

Data

Creates point objects or blocks at measured intervals along
the length or perimeter of an object.

Command alias Button Classic menu Ribbon/application menu

         Measure                                          Draw => Point => Measure       Home tab => Draw panel => Measure

Procedure

Select object to measure

Specify length of segment of [Block]: Specify a distance
or enter b

The resulting points or blocks are always located on the
selected object and their orientation is parallel to the XY
plane of the UCS.

Use DDPTYPE to set the style and size of all point objects
in a drawing. (Fig 9)

The points or blocks are placed in the previous selection
set, so you can select them all by entering p at the next
select objects prompt.  You can use the node object snap
to draw an object by snapping to the point objects.  You
can them remove the points by entering erase previous.

Length of segment

Places point objects at the specified interval along the
selected object, starting at the endpoint closest to the
point you used to select the object.  Measurement of
closed polylines starts at their initial vertex (the first one
drawn).

Measurement of circles starts at the angle from the center
set as the current snap rotation angle.  If the snap rotation
angel is 0, then the measurement of the circle starts to
the right of center, on its circumference. (Fig 10)

The illustration shows how measure marks 0.5 - unit
distances along a polyline, with the PDMODE system
variable set to 35. (Fig 11)

Block

Places blocks at a specified interval along the selected
object.

Enter name of block to insert: Enter the name of a block
currently defined in the drawing.

Align block with object? [Yes/No]  <Y>: Enter or n or press
enter
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If you enter y, the block is rotated about its insertion point
so that its horizontal lines are aligned with, and drawn
tangent to, the object being measured. If you enter n, the
block is always inserted with a 0 rotation angle.

Specify length of segment

After you specify the segment length, the block is inserted
at the specified interval.  If the block has variable attributes,
these attributes are not included.

Hands on -1

1 Open block1.dwg (Fig 12)

Fig 12

Command: BE

Select block: Select block 1 from list => ok (Fig 13)

Fig 13

2 Assign visibility parameter to the block1

i. Parameter => Visibility => Place it on screen. (Fig 14)

Fig 14

ii. The visibility tab activated now. (Fig 15)

iii. Click on manage visibility states,

a. New => visibility state 0

b. New => visibility state 1

c. New => visibility state 2

d. New => visibility state 3

iv. Set the visibility state 1 as current.

v.. Click on make invisible => Select the model shown in
the screen => Enter. (Fig 16)

Fig 17

vi. Create a new drawing there. (Fig 17)

Fig 16

vii. Set the visibility state as visibility state 2
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Hands on - 2

1 Open elevation.dwg. (Fig 18)

2 Create the parapet design with the divide command.

Command: DIVIDE

Select object to divide: <Select the 4th line from top of
the parapet>

Enter the number of segments or [Block]: b

Enter name of block to insert: design1

Align block with object? [Yes/No] <Y>:

Enter the number of segments: 30 (Fig 19)

3 Save the file and exit.
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PROCEDURE

TASK 1 : Block attribute manager

Procedure

Manages the attribute definitions for blocks in the current
drawing. You can edit the attribute definitions in blocks,
remove attributes from blocks, and change the order in
which you are prompted for attribute values while inserting
a block. (Fig 1)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.10

Advanced drafting commands - II
Objectives: At the end of this exercise you shall be able to
• understand following advanced commands

• block attribute manager
• design centre
• text
• text style
• scale text
• hatch
• gradient.

Data

Command alias Button Classic menu Ribbon/application menu

BATTMAN Insert  => Attributes panel Modify  => Object  => Attribute
 => Manage  => Block Attribute Manager

Attributes of the selected block are displayed in the at-
tribute list.  By default, Tag, Prompt, Default, Mode, and
annotative attribute properties are displayed in the attribute
list.  You can specify which attribute properties you want
to be displayed in the list by choosing settings.

Fig 1

For each selected block, a description below the attribute
list identifies the number of its instances in the current
drawing and in the current layout.

Select block

Allows you to use your pointing device to select a block
from the drawing area.  When you choose select block,
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the dialog box closes until you select a block from the
drawing or cancel by pressing ESC.

If you modify attributes of a block and then select a new
block before you save the attribute changes you have
made, you will be prompted to save the changes before
selecting another block.

Block

Lists all block definitions in the current drawing that have
attributes.  Select the block whose attributes you want to
modify, first.

List of attributes

Displays the properties of each attribute in the selected
block.

Blocks found in drawing

The number of instances of the selected block in the cur-
rent drawing.

Blocks found in current space

The number of instances of the selected block in the cur-
rent model space or layout.

Hands on - 1

1 Open file plan.dwg. (Fig 2)

2 Turn off the layer DIMENSION  and set '0' as the cur-
rent layer. (Fig 3)

3 Command: ATTDIA

Enter new value for ATTDIA <0>:

4 Insert => Block => door => place this block on the
plan. (Fig 4)

Fig 4

i. Fill with the attribute values as shown in Fig 5.

ii. Select the block and adjust the text position with the
help of grip editing. (Fig 6 & Fig 7)
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Fig 5

5 Insert => Block => door => Place it as shown in Fig 8.

i. Select block => click on the flip button, to get the door
as shown.

6 Use these methods to place all doors for this plan is
shown in Fig 9.

7 Place all the windows as shown in the following table.

i. Insert => block => window (Fig 10)

a. Place it on the W1 position also specify attribute
values as per the above table.

ii. Select the window, and use rotate icon to rotate window
to correct position. (Fig 11)

iii. insert => Block => window

a. Place it on the W2 position with suitable attribute
values.

Name ID Material Size Count

Window W1 TEAK 150 x 150 9

Window W2 TEAK 60 x 90 2

Door D1 TEAK 100 x 210 9
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Fig 10

iv Select the window, and use rotate icon to rotate window
to correct position. (Fig 12)

a. Click and drag on stretch icon to reduce its size to
90. (Fig 13)

8 Repeat the steps for all windows and make the final
drawing like this. (Fig 14)

9 Save the file and use the attribute extraction to create
the joinery details. (Fig 15)

Fig 15

i. COMMAND: EATTEXT

ii. Check create a new data extraction => Next

iii. Save the.dxe file with a name => Next (Fig 16)

10 Check include current drawing => Next (Fig 17)
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Fig 16

Fig 17

Fig 18

11 Check display blocks only and display blocks with
attributes only as shown => Next. (Fig 18)

12 Choose attribute alone from the category filter => Next
(Fig 19)

13 Drag the columns and arrange it in proper order =>
Next. (Fig 20)

Fig 19

Fig 20

i. Check the option insert data extraction table into
drawing => Next (Fig 21)

ii. Click on Next => Finish

Fig 21

iii. Specify the insertion point on the screen to get a table
as shown below

Name ID Material Size Count

Window W1 TEAK 150 x 150 9

Window W2 TEAK 60 x 90 2

Door D1 TEAK 100 x 210 9
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iv Click on the top row and add a title as joinery details.
(Fig 21)

When pausing for using input

Restores the view prior to the playback of an action macro
when a request for user input occurs.

Once playback finishes

Restores the view prior to the playback of an action macro
when playback is complete.

Check for inconsistencies when playback begins

Specifies if the action macro should be scanned for incon-
sistencies between the current drawing state and the draw-
ing state when the macro was recorded.

More options

Controls the display of additional options in the action
macro dialog box.

Restore pre-playback view

Check for inconsistencies when playback begins.

TASK 2 : Design center

Data

Command alias Button Classic menu Ribbon/application menu

DC Tools  => Palettes Insert tab => Content panel =>
 => Design center Design center

Procedure

Browses, finds, and previews content, and inserts content,
which includes blocks, hatches, and external references
(xrefs).

Use the buttons in the toolbar at the top of design center
for display and access options.

When you click the folders tab or the open drawings tab,
the following two panes are displayed from which you can
manage the drawing content. (Fig 22)

• Content area (right pane)

• Tree view (left pane)

Fig 22
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Note The design center online (DC online tab)
is disabled by default.  You can enable it from
the CAD manager control utility.

Content area (Design center)

Displays the content of the "container" currently selected
in the tree view. A container is a network, computer, disk,
folder, file, or web address (URL) containing information
accessible by design center.  Depending on the container
selected in tree view, the content area displays the
following:

• Folders containing drawings or other files

• Drawings

• Named objects contained in drawings (named objects
include blocks, xrefs, layouts, layers, dimension
styles, table styles, multi leader styles, and text styles)

• Images or icons representing blocks or hatch patterns.

• Web-based content

• Custom content developed by third-party applications

From the content area, you can insert blocks or hatch
patterns or attach external references in a drawing by
dragging, double-clicking, or right-clicking and choosing
insert block, Attach Xref, or copy.  You can drag or right-
click to add other content to drawings, such as layers,
dimension styles, and layouts. You can drag blocks and
hatches from design center to tool palettes.

Note You can access relevant content area and
tree view options on a shortcut menu by right-
clicking in the tree view or the content area.

Load

Displays the load dialog box (a standard file selection dialog
box). Use load to navigate to files on local and network
drives or on the web, and then to select content to load in
the content area.

Back

Returns to the most recent location in the history list.

Forward

Returns to the next latest location in the history list.

Up

Displays the contents of the container one level above the
current container.

Stop (DC online tab)

Stops the current transfer.

Reload (DC online tab)

Reloads the current page.

Search

Displays the search dialog box, where you can specify
search criteria to locate drawings, blocks, and nongraphical

objects within drawings.  Search also displays custom
content saved on your desktop.

Favorites

Displays the contents of the favorites folder in the content
area.  The favorites folder contains shortcuts to items you
often access.  You can add items to favorites either by
right-clicking the content area or right-clicking an item in
the tree view, and then clicking add to favorites.  To delete
an item from favorites, use the organize favorites option
on the shortcut menu and then use the refresh option on
the shortcut menu.

Note : The designcenter folder is automatically
added to favorites.  This folder contains draw-
ings with discipline-specific blocks which you
can insert in drawings.

Home

Returns designcenter to your home folder.  Upon installa-
tion, the home folder is set to ....\sample\ Designcenter.
Change the home folder using the shortcut menu in the
tree view.

Tree view toggle

Displays and hides the tree view.  Hide the tree view if you
need more space in your drawing area.  When the tree
view is hidden, you can use the content area to navigate
to containers and to load content.

The tree view toggle button is not available while you're
using the history list in the tree view.

Preview

Displays and hides a preview of the selected item in a
pane below the content area.  If there is no preview image
saved with the selected item, the preview area is empty.

Description

Displays and hides a text description of the selected item
in a pane below the content area.  If a preview image is
also displayed, the description is displayed below it.  If
there is no description saved with the selected item, the
description area is empty.

Views

Provides different display formats for the content that is
loaded in the content area.  You can select a view from
the views list or click the views button repeatedly to cycle
through the display formats.  The default view varies for
the type of content currently loaded in the content area.

Large icon

Displays the names of the loaded content in large icon
format.

Small icon

Displays the names of the loaded content in small icon
format.
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List view

Displays the names of the loaded content in a list.

Detail view

Displays additional information regarding the loaded con-
tent.  You can sort the items by name, size, type, and
other properties, depending on the type of content that is
loaded in the content area.

Refresh (Shortcut menu only)

Refreshes the display in the content area to reflect any
changes you have made.  Right-click the content area
background and click refresh on the shortcut menu.

Autodesk seek design content

Opens a web browser and displays the Autodesk seek
(SEEK) home page.  Product design information available
on Autodesk seek depends on what content providers,
both corporate partners and individual contributors, publish

to Autodesk seek (SHAREWITHSEEK).  Such content
could include 3D models, 2D drawings, specifications,
brochures, or descriptions of products or components.

Tree view (Design center)

Displays the hierarchy of files and folders on your computer
and network drives, a list of open drawings, custom content,
and a history of the last locations you accessed.  Select
an item in the tree view to display its contents in the content
area.

Note : In the sample designecenter folder are
drawings containing discipline-specific blocks
that you can insert in drawings.  These
drawings are called symbol library drawings.

Use the buttons in the toolbar at the top of design center
to access tree view options.

TASK 3 : Text

Data

Command alias Button Classic menu Ribbon/application menu

Single line - DT Draw  => Text Home => Annotation => Text
Multiline - T

AutoCAD provides two options to create notes.  For simple
entries you can use single line text, whereas for longer
entries with internal formatting multiline text can be used.
The procedures for both these commands are self-
explanatory.

Single line text

The single line text is used to enter several lines of text
that can be rotated and resized.  The text we type can be
displayed on the screen.  Each line of text is treated as a
separate object in AutoCAD.

The following prompts are displayed,

Current text style: <current>

Current text height: <current>

Annotative: <current>

Specify start point of text or [Justify/Style]:

When you pick the start point (also called the insertion
point) for the text, the relationship between the start point
and actual letters is determined by the justification.

When you want to refer text by using object snaps, we
can use insertion object snap.

The specify height prompt is displayed only when the current
text style is not annotative and does not have a fixed height.
Whereas the specify paper text height prompt is displayed
only when the current text style is annotative.

Justify

Be default the text is left justified.  Hence there is no
option for left justification.

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/
ML/MC/MR/BL/BC/BR]:

Align

Specifies both text height as well as text orientation by
designating the endpoints to the baseline.  The size of the
characters adjusts in proportion to their height.  The longer
the text string, the shorter the characters.

Fit

Specifies that text fits within an area and at an orientation
defined with two points and a height.  Available for hori-
zontally oriented text only.

Center

Aligns the text from the horizontal center of the baseline,
which you specify with a point.  The rotation angle speci-
fies the orientation of the text baseline with respect to the
center point.  You can designate the angle by specifying a
point.  The text baseline runs from the start point toward
the specified point.  If you specify a point to the left of the
center point, the text is drawn upside down.

Middle

Aligns text at the horizontal center of the baseline and the
vertical center of the height you specify.  Middle aligned
text does not rest on the baseline.  The middle option
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differs from the MC option in that it uses the midpoint of all
text, including decenters.  The MC option uses the midpoint
of the height of uppercase letters.

Right

Text is right justified from the insertion point.  The insertion
point is on the base line.

TL, TC, TR

Top left, top center, top right justifications.  The insertion
point is at the top of the highest  possible letter, and the
text is either left center or right justified accordingly.

ML, MC, MR

Middle left, middle center, middle right justifications.  Text
is centered vertically.  The vertical center point is measured

from the bottom of the lower to the top of the tallest possible
letter.  Text is left, center or right justified accordingly.

BL, BC, BR

Bottom left, bottom center, bottom right justifications.  The
insertion point is below the lowest descending letter.  Text
is left, center or right justified accordingly.

Style

Specifies the style of the text, which determines the ap-
pearance of the text characters.  The text you create uses
the current text style.  Entering "?" lists the current text
styles, associated font files, height, and other parameters.

TASK 4 : Text style

Command alias Button Classic menu Ribbon/application menu

  ST Format => Text style Home => Annotation => Text style

The default text style in AutoCAD is standard.  This text
style is assigned with a default text font txt.shx.  Another
text style available as default is annotative.  If you need to
write a text using some other fonts and other parameters
you need to use the text editor.  It is very difficult to use
text editor each and every time you write a text and change
its properties.  That is why AutoCAD provides an option to
modify or to create a new style.  After creating a style you
can make it as current and the text will be using this
current style to write.

The following options are displayed. (Fig 23)

Fig 23

Current text style

Lists the current text style.

Styles

Displays the list of styles in the drawing.  An icon before
the style name indicates that the style is annotative.   Style
names can be up to 255 characters long.  They can con-
tain letters, numbers, and the special characters dollar
sign ($), underscore (_), and hyphen (-).

Style list filter

The drop-down list specifies whether all styles or only the
styles in use are displayed in the styles list.  Preview:
Displays sample text that changes dynamically as you
change fonts and modify the effects.

Font

Changes the style's font.

Note : If you change the orientation or font file
of an existing text style, all text objects with
that style use the new values when the drawing
is regenerated.

Font name

Lists the font family name for all registered true type fonts
and all compiled shapes (SHX) fonts in the fonts folder.
When you select a name from the list, the program reads
the file for the specified font.  The file's character defini-
tions are loaded automatically unless the file is already in
use by another text style.  You can define several styles
that use the same font.

Font style

Specifies font character formatting, such as italic, bold, or
regular.  When use big font is selected, this option changes
to big font name and is used to select a big font file name.

Use big font

Specifies an Asian language big font file.  Only SHX files
are valid file types for creating big fonts.

Size

Changes the size of the text.

Annotative

Specifies that the text is annotative.  Click the information
icon to learn more about the annotative objects.

CCM&RE : Architectural Assistant - Exercise 2.1.10



89

Match text orientation to layout

Specifies that the orientation of the text in paper space
viewports matches the orientation of the layout.  This option
is unavailable if the annotative option is cleared.

Height or paper text height

Sets the text height based on the value you enter.  Entering
a height greater than 0.0 sets the text height for this style
automatically.  If you enter 0.0, the text height defaults to
the last text height used, or the value stored in the drawing
template file.  True type fonts might be displayed at a
smaller height than SHX fonts with the same height setting.
If the annotative option is selected, the value entered sets
the text height in paper space.

Effects

Modifies characteristics of the font, such as its height,
width factor, and oblique angle and whether it is displayed
upside down, backwards, or vertically aligned.

Upside down

Displays the characters upside down.

Backwards

Displays the characters backwards.

Vertical

Displays the characters aligned vertically.  Vertical is
available only if the selected font supports dual orientation.
Vertical orientation is not available for true type fonts.

Width factor

Sets the character spacing.  Entering a value less than
1.0 condenses the text.  Entering a value greater than 1.0
expands it.

Oblique angle

Sets the oblique angle of the text.  Entering a value between
85 and 8 italicizes the text.

Note : Truetype fonts using the effects
described in this section might appear bold
on the screen.  On-screen appearance has no
effect on plotted output.  Fonts are plotted as
specified by applied character formatting.

Set current

Sets the style selected under styles to current.

New

Displays the new text style dialog box and automatically
supplies the name "stylen" (where n is the number of the
supplied style) for the current settings.  You can accept

the default or enter a name and choose ok to apply the
current style settings to the new style name.

Delete

Deletes unused text styles.

Apply

Applies style changes made in the dialog box to the current
style and to the text of the current style in the drawing.

? list styles

Lists  text style names and characteristics.  The previous
prompt is redisplayed until you specify the opposite corner
of the text boundary.

Width

It specifies the width of the text boundary.  If you use the
pointing device to specify a point, the width is calculated
as the distance between the start point and the specified
point.  Words within each line of the multiline text object
wrap to fit the width of the text boundary.  If you specify a
width of 0, word wrap is turned off and the width of the
multiline text object is as wide as the longest line of text.
You can end a line of text at a specific point by typing the
text and pressing enter.  To end the command, press enter
at the mtext prompt.

Columns

It specifies the column options for an mtext object.

Static

Specifies the total column width, the number of columns,
the gutter width (the space between the columns), and
the height of columns.

Dynamic

Specifies column width, gutter width and column height.
Dynamic columns are text driven.  Adjusting columns affect
text flow and text flow causes columns to be added or
removed.

No columns

Sets no column mode to current mtextobject.  The default
column setting is stored in the mtextcolumn system
variable.

Note : Although the box boundary you specify
controls the width of the paragraph, A single
word is not broken to adjust the limits.  This
means that if you write a single word whose
width is more than the box boundary specified
autocad will write the word irrespective of the
box width and therefore, will exceed the
boundary limits.
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TASK 5: Scale text

Command alias Button Classic menu

SCALETEXT Modify => Object => Text => Scale

This tool enlarges or reduces selected text objects without
changing their locations.

The following prompts are displayed.

Select objects

Enter a base point option for scaling [Existing/Left/Center/
Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]
<Existing>:

The base point is a location relative to a text object that
serves as a fixed point for the resizing or scaling operation,
which is applied individually to each selected text object.
Specifying a base point for the operation does not change
the insertion point relative to the text.  The base point
options shown above are described in the text command.
The base point options for both single line text and multiline
text are similar except that the align, fit, and left text options
are equivalent to the bottom left (BL) multiline text
attachment point.

Specify new model height or [Paper height/Match object/
Scale factor] <0.5000>:

Note : You can only specify a model height for
non-annotative objects.

Paper height

Scales the text height depending on the annotative
property.

Note : You can only specify a paper height for
annotative objects.

Match object

Scales the text objects that you originally selected to
match the size of a selected text object.

Note : This option only affects like objects
(annotative or nonannotative).

Scale factor

Scales the selected text objects based on a reference
length and a specified new length.

Reference

Scales the selected text objects relative to a reference
length and a new length.  The selected text is scaled by a
ratio of the values that you entered for the new length and
the reference length.  If the new length is less than the
reference length, the selected text objects are reduced in
size.

TASK 6 : Hatch

Command alias Button Classic menu Ribbon/application menu

  H Draw => Hatch Home => Draw => Hatch

Drafters and designers use repeating patterns called
hatching to fill regions in a drawing for various purposes.
In a cross section view hatch patterns helps the viewer
differentiate between components of an assembly and
indicate the material of each.

The following options are displayed. (Fig 24)

Type and pattern

Specifies the hatch's type, pattern, color, and background
color.

Type

Specifies whether to create a predefined, user-defined, or
custom hatch pattern.

Predefined patterns are stored in the acad. pator
acadiso.pat  files supplied with the program.

User-defined patterns are based on the current linetype in
your drawing.  A custom pattern is a pattern that is defined
in any custom PAT files that you have added to the search
path.

Fig 24
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Pattern

Displays a selection of ANSI, ISO, and other industry-
standard hatch patterns.  Select SOLID to create solid fill.
The pattern option is available only when type is set to
predefined. (HPNAME system variable)

[...] Button

Displays the hatch pattern palette dialog box, in which
you can preview images for all predefined patterns.

Color

Overrides the current color with a specified color for hatch
patterns and solid fills.  (HPCOLOR system variable)

Background color

Specifies the background color for new hatch objects.
Choose none to turn off the background color.
(HPBACKGROUND COLOR system variable)

Swatch

Displays a preview of the selected pattern.  Click the swatch
to display the hatch pattern palette dialog box.

Custom pattern

Lists the available custom patterns.  The most recently
used custom patterns appear at the top of the list.  The
custom pattern option is available only when type is set to
custom. (HPNAME system variable)

[...] Button

Displays the hatch pattern palette dialog box, in which
you can preview images for all custom patterns.

Angle and scale

Specifies an angle and scale for the selected hatch pattern.

Angle

Specifies  an angle for the hatch pattern relative to the X
axis of the current UCS.  (HPANG system variable)

Scale

Expands or contracts a predefined or custom pattern.  This
option is available only when type is set to predefined or
custom.  (HPSCALE system variable)

Double

For user-defined patterns, draws a second set of lines at
90 degrees to the original lines, creating a crosshatch.
This option is available only when type is set to user
defined.  (HPDOUBLE system variable)

Relative to paper space

Scales the hatch pattern relative to paper space units.
This allows you to display hatch patterns at a scale that
is appropriate for your named layout.  This option is available
only from a named layout.

Spacing

Specifies the spacing of lines in a user-defined pattern.
This option is available only when type is set to user
defined.  (HPSPACE system variable)

ISO pen width

Scales an ISO predefined pattern based on the selected
pen width.  This option is available only when type is set
to predefined and pattern is set to one of the available ISO
patterns.

Hatch origin

Controls the starting location of hatch pattern generation.
Some hatches, such as brick patterns, are meant to be
aligned with a point on the hatch boundary.  By default, all
hatch origins correspond to the current UCS origin.

Use current origin

Uses the hatch origin point stored in the HPORIGIN system
variable.

Specified origin

Assigns a new hatch origin using the following options.

Click to set new origin

Specifies the new hatch origin point directly.

Default to boundary extents

Calculates a new origin based on the rectangular extents
of the boundary for the hatch object.  Choices include
each of the four corners of the extents and its center.
(HPORIGINMODE system variable)

Store as default origin

Stores the value of the new hatch origin in the HPORIGIN
system variable.

Boundaries

The following options are displayed.

Pick points

Determines a boundary from existing objects that form an
enclosed area around the specified point.  While picking
internal points, you can right-click in the drawing area at
any time to display a shortcut menu that contains several
options.

Select

Determines a boundary from selected objects that form
an enclosed area.

When you use the select objects option, interior objects
are not detected automatically.  You must select the
objects within the selected boundary to hatch or fill those
objects according to the current island detection style.
Each time you click select objects, hatch clears the
previous selection set.  While selecting objects, you can
right-click at any time in the drawing area to display a
shortcut menu.  You can undo the last selection or all
selections, change the selection method, change the
island detection style, or preview the hatch or gradient fill.

Remove

Removes from the boundary definition any of the objects
that were added previously.
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Recreate

Creates a polyline or region around the selected hatch or
fill, and optionally associates the hatch object with it.

Display boundary objects

Displays the boundary grip controls for the selected hatch
so that you can use to grip-edit both the boundary and the
hatch object.  When you select or use the display boundary
objects option to select a non-associative hatch, the hatch
boundary grips are displayed.

When you select an associative hatch, it displays only a
single grip point of the hatch.  To display the boundary
grip controls of the objects associated with the hatch, use
the display boundary objects option.  You can only edit an
associative hatch by grip-editing the associated boundary
objects.

Options

Controls several commonly used hatch or fill options.

Annotative

Specifies that the hatch is annotative.  This property
automates the process of scaling annotations so that they
plot or display at the correct size on the paper.
(HPANNOTATIVE system variable)

Associative

Specifies that the hatch or fill is associative.  A hatch or fill
that is associative is updated when you modify its boundary
objects.  (HPASSOC system variable)

Create separate hatches

Controls whether a single hatch object or multiple hatch
objects are created when several separate closed
boundaries are specified.  (HPSEPARATE system variable)

Draw order

Assigns a draw order to a hatch or fill.  You can place a
hatch or fill behind all other objects, in front of all other
objects, either behind the hatch boundary, or in front of
the hatch boundary.  (HPDRAWORDER system variable)

Layer

Assigns new hatch objects to the specified layer, overriding
the current layer.  Select use current to use the current
layer.  (HPLAYER system variable)

Transparency

Sets the transparency level for new hatch or fills, overriding
the current object transparency.  Select use current to
use the current object transparency setting.
(HPTRANSPARENCY system variable).

Inherit properties

Hatches or fills specified boundaries using the hatch or fill
properties of a selected hatch object.  After selecting the
hatch object whose properties you want the hatch to inherit,
right-click in the drawing area and use the options on the
shortcut menu to switch between the select objects and
pick internal point options.  The HPINHERIT system variable
controls whether the hatch origin of the resulting hatch is
determined by HPORIGIN or by the source object.

Islands

Specifies the methods used to hatch or fill boundaries
within the outermost boundary.

Island detection

Controls detection of internal closed boundaries, also called
as islands.  (HPISLANDDETECTIONMODE system
variable)

TASK 7 : Gradient

Command alias Button Classic menu

Gradient Draw => Gradient

A gradient fill is a solid hatch fill that gives the blended
color effect of a surface with light on it.  The color in gradient
fill makes a smooth transition from light to dark or from
dark to light.  In a two color gradient fill the color with the
transition from light color to dark and from first color to the
second color.  The hatch and gradient dialog box includes
the same options.

The following options are only for gradient tab.

Color

Specifies whether to fill the hatch boundary with a
monochromatic or two-color blend.

One color

Specifies a fill that uses a smooth transition between a
color and a specified tint (the color mixed with white) or

between a color and a specified shade (the color mixed
with black).  (GFCLRSTATE system variable)

Two color

Specifies a fill that uses a smooth transition between two
colors.  (GFCLRSTATE system variable)

Color swatches

Specifies the colors for the gradient fill (either one color or
two colors).  Click the browse button [...] to display the
select color dialog box, where you can select an AutoCAD
color index (ACI) color, true color, or color book color.
(GFCLR1 and GFCLR2 system variables)

Shade and tint slider

Specifies the tint (the selected color mixed with white) or
shade (the selected color mixed with black) of a color to
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be used for a gradient fill of one color. (GFCLRLUM system
variable)

Gradient patterns

Displays fixed patterns for gradient fills.  These patterns
include linear sweep, spherical, and parabolic.

Orientation

Specifies the angle of the gradient and also whether it is
symmetrical.

Centered

Specifies a symmetrical gradient configuration.  If this
option is not selected, the gradient fill is shifted up and to
the left, creating the illusion of a light source to the left of
the object.  (GFSHIFT system variable)

Angle

Specifies the angle of the gradient fill.  The specified angle
is relative to the current UCS.  This option is independent
of the angle specified for hatch patterns.  (GFANG system
variable) (Fig 25)

Hands on -1

1 Open the given file section.dwg. (Fig 26)

2 Apply hatch on footing.

i. Command: HATCH

ii. Select ANSI32 hatch and click ok.(Fig 27 & Fig 28)

iii. Specify the scale as 25

iv. Choose add pickpoints and click the internal points of
walls. (Fig 29)
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Fig 27 Fig 28

v. Press enter to apply hatch the wall. (Fig 30) 3 Repeat the steps to apply hatches as shown below.
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Position Name Scale

1 ANSI133 25

2 GRAVEL 25

3 AR-CONC 4

4 AR-SAND 10
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Dimensions

As the name suggests the linear dimension commands
are used to provide dimensions to straight lines.  It
measures a distance from one point to another, but it always
measures along the x or y axis.  To use it, clock the top
button on the dimension toolbar (or go to dimension =>
linear), and then click your first point.  After you click you
first point, click the second point, and move the cursor
away from the part.  The length of the extension will be the
distance from the actual measurement to you third click.

The following prompts are displayed. (Fig 1)

Specify first extension line origin or <select object>:

Specify second extension line origin:

Specify dimension line location or [Mtext/Text/Angle/
Horizontal/Vertical/Rotated]:

Dimension text = The dimensions will be displayed

Mtext

Displays the In-place text editor, which you can use to
edit the dimension text.  Use control codes and unicode
character strings to enter special characters or symbols.
If alternate units are not turned on in the dimension style,
you can display them by entering square brackets ([]).
The current dimension style determines the appearance
of the generated measurements.

Text

Customizes the dimension text at the command prompt.
The generated dimension measurement is displayed within
angle brackets.

To include the generated measurement, use angle
brackets (<>) which are used to represent them.  If alternate
units are not turned on in the dimension style, you can
display alternate units by entering square brackets ([]).

Dimension text properties are set on the text tab of the
new, modify, and override dimension style dialog boxes.

Angle

Changes the angle of the dimension text. (Fig 2)

Horizontal

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.11

Advanced drafting commands - III
Objectives: At the end of this exercise you shall be able to
• understand following advanced command.

• Dimension linear
• Dimension aligned
• Dimension arc length
• Dimension ordinate
• Dimension radius
• Dimension diameter
• Dimension angular
• leader
• Mleader
• Dimension style
• Symbols and arrow tab
• Primary unit tab
• Alternate unit tab
• Tolerance tab
• Layouts
• Model space view ports
• Mview.

Command Button Classic menu Ribbon /
alias Application

menu
DIMLIN Dimensions Annotate =>

=> aligned Dimensions
=> Aligned
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Creates horizontal linear dimensions. (Fig 3)

Vertical

Creates vertical linear dimensions. (Fig 4)

Rotated

Creates rotated linear dimensions. (Fig 5)

Object selection

Automatically determines the origin points of the first and
second extension lines after you select an object.
For polylines and other explodable objects, only the
individual line and arc segments are given dimensions.

You cannot select object in a non-uniformly scaled block
reference.
If you select a line or an arc, the line or arc endpoints are
used as the origins of the extension lines.  The extension
lines are offset from the endpoints by the distance you
specify in offset from origin in the lines and arrows tab of
the new, modify, and override dimension style dialog boxes.

Dimension aligned

Command Button Classic menu Ribbon /
alias Application

menu
DIMALI Dimensions Annotate =>

=> aligned Dimensions
=> Aligned

Generally, the drawing consists of various objects that are
neither parallel to the X axis nor the Y axis.  Dimensioning
of such objects can be done using aligned dimensioning.

The following prompts are displayed. (Fig 6)

Specify first extension line origin or <select object>:
After you specify either manual or automatic extension
lines, the following prompt is displayed.
Specify dimension line location or [M text/Text/Angle]:

Dimension arc length

Command Button Classic menu Ribbon /
alias Application

menu
DIMARC Dimensions Annotate =>

=> Arc length Dimensions
=> Arc length

The arc length dimensioning is used to dimension the
length of an arc or the polyline arc segment.  You are
required to select an arc or a ployline arc segment and
the dimension location. (Fig 7)
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The following prompts are displayed.
Select arc or polyline arc segment:
Specify arc length dimension location or [Mtext/Text/Angle/
Partial/Leader]:

Dimension ordinate

Ordinate dimensions are not really dimensions at all in
that they do not indicate a measurement.  Rather they
annotate known co-ordinate points.  The DIMORDINATE
command is used to indicate the X and Y ordinate values
at any point. (Fig 8)

The following prompts are displayed.
Specify feature location:
Specify leader endpoint or [Xdatum/Ydatum/Mtext/Text/
Angle]:
Angle
Changes the angle of the dimension text.

Dimension radius

Command Button Classic menu Ribbon /
alias Application

menu
DIMARODINATE Dimensions Annotate =>

=> Ordinate Dimensions
=> Ordinate

The radius dimensioning is used to dimension a circle or
an arc.  Radius and diameter dimensioning are similar;
the only difference is that instead of dimension line, a
radius line is drawn, which is measured from the center to
any point on the circumference. (Fig 9)

Dimension diameter
Command alias Button Classic menu Ribbon/Appli-
cation menu

Command Button Classic menu Ribbon /
alias Application

menu
DIMRADIUS Dimensions Annotate =>

=> Radius Dimensions
=> Linear =>
Radius

  Command Button Classic menu Ribbon /
  alias Application

menu
DIMDIAMETER Dimensions Annotate =>

=> Diameter Dimensions
=> Linear =>
Diameter

Diameter dimensioning is used to dimension circle or an
arc.  Here the measurement is done between two
diametrically opposite points on the circumference of the
circle or an arc.  The dimension text is generated in
AutoCAD commence with   symbol to indicate diameter
dimension. (Fig 10)

Dimension angular

The angular dimensioning is used when you want to
dimension an angle.  This command generates a dimension
arc.  The location of the dimension line and dimension arc
is determined by the way you locate the dimension arc.
We can place dimension text outside the quadrant in which
you measure the angle by extending the dimension arc.
Choose the quadrant option from the short cut menu.  Next
you will be prompted to specify the quadrant in which you
want to measure the angle.  Then specify the quadrant
with the mouse. (Fig 11)

Command Button Classic menu Ribbon /
alias Application

menu
DIMANG Dimensions Annotate =>

=> Angular Dimensions
=> Linear =>
Angular
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Dimensioning the angle of arc

Angular dimensioning can also be used to provide a
dimension to the angle of an arc.  In this case the center
point of the arc is considered as the vertex and end point
of arc is the extension line origin.
Dimension jogged

Command Button Classic menu Ribbon /
alias Application

menu
DIMJOGGED Dimensions Annotate =>

=> Jogged Dimensions
=>Jogged

The necessity of the jogged dimension arises because of
the space constraint.  Also the jogged dimension is used
when you want to avoid merging of the dimension line with
other dimensions.  Also there are instances when it is not
possible to show the centre of circle in the sheet.  In such
situations, jogged dimensions are of immense use.  Jogged
dimensions are added using the jogged tool.  Note that
with this command you can add dimensions to only jogged
radius dimensions.

Leader

Command alias Button

LEADER

The leader command can be used to annotate any point
on a drawing.  Unlike other dimension commands the
leader and annotation text are drawn as separate objects.
So, if you need to move or edit the text, you can do so
without affecting the leader line.

The following prompts are displayed.

Specify leader start point:

Specify next point:

A leader line segment is drawn and prompts for points and
options are displayed.

Specify next point of [Annotation/Format/Undo] <Annota-
tion>:

Mleader

Command Button Classic menu Ribbon /
alias Application

menu

 MLEADER Dimensions Annotate =>
=> Mleader Leaders

=>Multi leader

The following prompts are displayed.

Specify leader arrowhead location or [leader landing first/
Content first/Options] <Options>:

Leader Arrowhead first

Specifies a location for the arrowhead of the multileader
object.

Specify leader landing location

Sets placement of the leader landing for the new multileader
object.

If you exit the command at this point, then no text is
associated with the multileader object.

Leader landing first

Specifies a location for the landing line of the multileader
object.

Specify leader arrowhead location

Sets placement of the arrowhead for the new multileader
object.

If you exit the command at this point, then no text is
associated with the multileader line.

Content first

Specifies a location for the text or block associated with
the multileader object.

Point selection

Sets placement for the text box for the text label associated
with the multileader object.  When you finish entering the
text, click ok or click outside the text box.

If you choose end at this point, then no landing line is
associated with the multileader object.

Options

Specifies options for placing the multileader object.

Leader type

Specifies a straight, spline, or no leader line.

• Straight.

• Spline.

• None.

Leader landing

Changes the distance of the horizontal landing line

• Yes.

• No.

If you choose no at this point, then no landing line is
associated with the multileader object.

Content type

Specifies the type of content that will be used for the
multileader.

• Block

• Mtext

• None

Leader

Specify leader association point <next>: Specify an object
snap location, or press enter to skip to the next dimension
object, if any
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Ordinate

Specify feature location <next>: Specify an object snap
location, or press enter to skip to the next dimension
object, if any

Radius

Select arc or circle <next>: Select an arc or a circle, or
press enter to skip to the next dimension object, if any

Dimension style

Command Button Classic menu Ribbon /
alias Application

menu

       DS Dimensions Home =>
=> Dimension Annotation
     style =>Dimension style

The dimension style command can be used to change
the appearance of dimensions.  The best method is to
create a new style before creating dimensions so that you
can leave the STANDARD style as a default option.  Having
created a new style from STANDARD you can then apply
any modifications you generally require to the parent style
and then more specific modifications to the child styles in
order to create a style family.

Dimension styles are created using the dimension styles
dialogue box.  As you can see from the dialogue box, a
style is applied to a family of dimensions.  By default, any
style changes are made to the parent.  Each style parent
has six child styles.  The child styles, linear, radial, angular,
diameter, ordinate and leader can be used to modify the
parent style when that particular dimension is used.  For
example, you may like to use a tick rather than an arrow
head for your dimensions but this isn't really appropriate
for a leader, so the leader child style can be changed so
that leaders will always be drawn with an arrow head whilst
all other dimensions of the same style family are drawn
using ticks. (Fig 12)

The following options are displayed.

Current dimension style

Displays the name of the dimension style that is current.
The default dimension style is STANDARD.  The current
style is applied to dimensions you create.

Styles

Lists dimension styles in the drawing.  The current style
is highlighted.  Right-click in the list to display a shortcut
menu with options to set the current style, rename styles,
and delete styles.  You cannot delete a style that is current
or in use in the current drawing.  An icon before the style
name indicates that the style is annotative.

Unless you select the option, 'Don't list styles in Xrefs',
dimension styles are displayed in externally referenced
drawings using the syntax for externally referenced named
objects.  Although you cannot change, rename, or make
current externally referenced dimension styles, you can
create new styles based on them.

The item selected in list controls the dimension styles
being displayed.

List

Controls the display of styles in the styles list.  Select all
styles if you want to see all dimension styles in a drawing.
Select styles in use if you want to see only the dimension
styles being currently used by the dimensions in the
drawing.

Don't list styles in Xrefs

When selected, suppresses display of dimension styles
in externally referenced drawings in the styles list.

Preview

Shows a graphic representation of the style selected in
the styles list.

Description

Describes the style selected in the styles list relative to
the current style.  If the description is longer than the
space provided, you can click in the pane and use arrow
keys to scroll down.

Set current

Sets the style selected under styles to current.  The current
style is applied to dimensions you create.

New

Displays the create new dimension style dialog box, in
which you can define a new dimension style.

Modify

Displays the modify dimension styles dialog box, in which
you can modify dimension styles.  Dialog box options are
identical to those in the new dimension style dialog box.

Override

Displays the override current style dialog box, in which
you can set temporary overrides to dimension styles.
Dialog box options are identical to those in the new
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dimension style dialog box.  Overrides are displayed as
unsaved changes under the dimension style in the styles
list.

Compare

Displays the compare dimension styles dialog box, in
which you can compare two dimension styles or list all
the properties of one dimension style.

New

Names the new dimension style, sets the style on which
to start the new one, and indicates the dimension types
to which you want the new style to apply. (Fig 13)

Fig 13

The following options are displayed.

New style name

Specifies the new dimension style name.

Start with

Sets a style to use as a basis for the new one.  For the
new style, you need to change only the properties that
differ from the properties you start with.

Annotative

Specifies that the dimension style is annotative.

Use for

Creates a dimension substyle that applies only to specific
dimension types.  For example, you could create a version
of the STANDARD dimension style to be used only for
diameter dimensions.

Continue

Displays the new dimension style dialog box, in which
you define the new dimension style properties.

Lines tab

The following options are displayed. (Fig 14)

Dimension lines

Color

Displays and sets the color for the dimension line.  If you
click select color (at the bottom of the color list), the select
color dialog box is displayed.  You can also enter a color
name or number. (DIMCLRD system variable)

You can select colors from the 255 AutoCAD color index
(ACI) colors, true colors, and color book colors.

Line type

Sets the linetype of the dimension line.  (DIMLTYPE
system variable)

Lineweight

Sets the lineweight of the dimension line.  (DIMLWD
system variable)

Extend beyond ticks

Specifies a distance to extend the dimension line past the
extension line when you use oblique, architectural, tick,
integral, and no marks for arrowheads.  (DIMDLE system
variable)

Baseline spacing

Sets the spacing between the dimension lines of a baseline
dimension.  Enter a distance.  (DIMDLI system variable)

Suppress

Suppress display of dimension lines.  Dim line 1
suppresses the first dimension line; dim line 2 suppresses
the second dimension line. (DIMSD1 and DIMSD2 system
variable)

Extension lines

Controls the appearance of the extension lines.

Color

Sets the color for the extension line.  If you click select
color (at the bottom of the color list), the select color dialog
box is displayed.  You can also enter a color name or
number. (DIMCLRE system variable)

You can select colors from the 255 AutoCAD color index
(ACI) colors, true colors, and color book colors.

Linetype Ext line 1

Sets the linetype of the first extension line.  (DIMLTEX1
system variable)

Fig 14
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Linetype Ext line 2

Sets the linetype of the second extension line.  (DIMLTEX2
system variable)

Line weight

Sets the lineweight of the extension line. (DIMLWE system
variable)

Suppress

Suppress the display of extension lines. Ext line 1
suppresses the first extension line; ext line 2 suppresses
the second extension line.  (DIMSE1 and DIMSE2 system
variables)

Extend beyond dim lines

Specifies a distance to extend the extension lines above
the dimension line.  (DIMEXE system variable)

Offset from origin

Sets the distance to offset the extension lines from the
points on the drawing that define the dimensions. (DIMEXO
system variable)

Fixed length extension lines

Enables fixed length extension lines.  (DIMFXLON system
variable)

Length

Sets the total length of the extension lines starting from
the dimension line toward the dimension origin.  (DIMFXL
system variable)

Preview

Display sample dimension images that show the effects
of changes you make to dimension style settings.

Symbols and arrows tab (Fig 15)

Fig 15

Arrowheads

First

Sets the arrowhead for the first dimension line.  When you
change the first arrowhead type, the second arrowhead
automatically changes to match it.  (DIMBLK1 system
variable)

To specify a user-defined arrowhead block, select user
arrow.  The select custom arrow block dialog box is
displayed.  Select the name of a user-defined arrowhead
block.  (The block must be in the drawing)

Second

Sets the arrowhead for the second dimension line.
(DIMBLK2 system variable)

To specify a user-defined arrowhead block, select user
arrow.  The select custom arrow block dialog box is
displayed.  Select the name of a user-defined arrowhead
block.  (The block must be in the drawing)

Leader

Sets the arrowhead for the leader line.  (DIMLDRBLK
system variable)

To specify a user-defined arrowhead block, select user
arrow.  The select custom arrow block dialog box is
displayed.  Select the name of a user-defined arrowhead
block.  (The block must be in the drawing)

Arrow size

Displays and sets the size of arrowheads.  (DIMASZ
system variable)

Note : Annotative blocks cannot be used as
custom arrowheads for dimensions or leaders.

Center marks

Controls the appearance of center marks and centerlines
for diameter and radial dimensions.  The DIMCENTER,
DIMDIAMETER, and DIMRADIUS commands use center
marks and centerlines.  For DIMDIAMETER, and
DIMRADIUS, the center mark is drawn only if you place
the dimension line outside the circle or arc.

Type

Sets the type of center mark or line to use.

None

Creates no center mark or centerline.  The value is stored
as 0 in the DIMCEN system variable.

Mark

Creates a center mark.  The size of the center mark is
stored as a positive value in the DIMCEN system variable.

Line

Creates a centerline.  The size of the centerline is stored
as a negative value in the DIMCEN system variable.
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Size

Displays and sets the size of the center mark or centerline.
(DIMCEN system variable)

Dimension break

Controls the gap width of dimension breaks.

Break size

Displays and sets the size of the gap used for dimension
breaks.

Arc length symbol

Controls the display of the arc symbol in an arc length
dimension.  (DIMARCSYM system variable)

Preceding dimension text

Places arc length symbols above the dimension text.
(DIMARCSYM system variable)

Above dimension text

Places arc length symbols above the dimension text.
(DIMARCSYM system variable)

None

Suppresses the display of arc length symbols.
(DIMARCSYM system variable)

Radius jog dimension

Controls the display of jogged (zigzag) radius dimensions.

Jogged radius dimensions are often created when the
center point of a circle or arc is located off the page.

Jog angle

Determines the angle of the transverse segment of the
dimension line in a jogged radius dimension.
(DIMJOGANG system variable)

Linear jog dimension

Controls the display of the jog for linear dimensions.

Jog lines are often added to linear dimensions when the
actual measurement is not accurately represented as the
dimension.  Typically the actual measurement is smaller
than the desired value.

Jog height factor

Determines the height of the jog, which is determined by
the distance between the two vertices of the angles that
make up the jog.

Preview

Displays sample dimension images that show the effects
of changes you make to dimension style settings.

Text Tab (Fig 16)

Text appearance

It controls the dimension text format and size.

Text style

Lists the available text styles.

Fig 16

Text style button

Displays the text style dialog box where you can create
or modify text styles.  (DIMTXSTY system variable)

Text color

Sets the color for the dimension text.  If you click select
color (at the bottom of the color list), the select color dialog
box is displayed.  You can also enter color name or number.
(DIMCLRT system variable)

You can select colors from the 255 AutoCAD color Index
(ACI) colors, true colors, and color book colors.

Fill color

Sets the color for the text background in dimensions.  If
you click select color (at the bottom of the color list), the
select color dialog box is displayed.  You can also enter
color name or number.  (DIMTFILL and DIMTFILLCLR
system variables)

You can select colors from the 255 AutoCAD color index
(ACI) colors, true colors, and color book colors.

Text height

Sets the height of the current dimension text style.  Enter
a value in the text box.  If a fixed text height is set in the
text style (that is, the text style height is greater than 0),
that height overrides the text height set here.  If you want
to use the height set on the text tab, make sure the text
height in the text style is set to 0.  (DIMTXT system variable)

Fraction height scale

Sets the scale of fractions relative to dimension text.  This
option is available only when fractional is selected as the
unit format on the primary units tab.  The value entered
here is multiplied by the text height to determine the height
of dimension fractions relative to dimension text.
(DIMTFAC system variable)
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Draw frame around text

When selected, draws a frame around dimension text.
Selecting this option changes the value stored in the
DIMGAP system variable to a negative value.

Text placement

Controls the placement of dimension text.

Vertical

Controls the vertical placement of dimension text in relation
to the dimension line.  (DIMTAD system variable)

Vertical position options include the following

• Centered : Centers the dimension text between the
two parts of the dimension line.

• Above: Places the dimension text above the dimension
line.  The distance from the dimension line to the
baseline of the lowest line of text is the current text
gap. See the offset from dim line option.

• Outside : Places the dimension text on the side of the
dimension line farthest away from the first defining point.

• JIS : Places the dimension text to conform to a
Japanese Industrial Standard (JIS) representation.

• Below : Places the dimension text under the
dimension line.  The distance from the dimension line
to the baseline of the lowest line of text is the current
text gap.  See the offset from dim line option.

Horizontal

Controls the horizontal placement of dimension text along
the dimension line, in relation to the extension lines.
(DIMJUST system variable)

Horizontal position options include the following:

• Centered : Centers the dimension text along the
dimension line between the extension lines.

• At ext line 1 : Left-justifies the text with the first
extension line along the dimension line.  The distance
between the extension line and the text is twice the
arrowhead size plus the text gap value.  See arrowheads
and offset from dim line.

• At ext line 2 : Right-justifies the text with the second
extension line along the dimension line.  The distance
between the extension line and the text is twice the
arrowhead size plus the text gap value.  See arrowheads
and offset from dim line.

• Over Ext line 1 : Positions the text over or along the
first extension line.

• Over Ext line 2 : Positions the text over or along the
Second extension line.

View direction

Controls the dimension text viewing direction.
(DIMTXTDIRECTION system variable)

View direction includes the following options:

• Left-to-right: Places the text to enable reading from left
to right.

• Right-to-left: Places the text to enable reading from
right to left.

Offset from dim line

Sets the current text gap, which is the distance around
the dimension text when the dimension line is broken to
accommodate the dimension text.

This value is also used as the minimum length required for
dimension line segments.

Text is positioned inside the extension lines only if the
resulting segments are at least as long as the text gap.
Text above or below the dimension line is placed inside
only if the arrowheads, dimension text, and a margin leave
enough room for the text gap.  (DIMGAP system variable)

Text alignment

Controls the orientation (horizontal or aligned) of dimension
text whether it is inside or outside the extension lines.
(DIMTIH and DIMTOH system variables)

Horizontal

Places text in a horizontal position.

Aligned with dimension line

Aligns text with the dimension line.

ISO standard

Aligns text with the dimension line when text is inside the
extension lines, but aligns it horizontally when the text is
outside the extension lines.

Preview

Displays sample dimension images that show the effects
of changes you make to the dimension style settings.

Fit tab (Fig 17)

Fig 17
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Fit options

Controls the placement of text and arrowheads based on
the space available between the extension lines.  When
space is available, text and arrowheads are placed between
the extension lines.  Otherwise, text and arrowheads are
placed according to the fit options. (DIMATFIT, DIMTIX,
and DIMSOXD system variables)

Either text or arrows (Best fit)

Moves either the text or the arrowheads outside the
extension lines based on the best fit (DIMATFIT system
variable).

• When enough space is available for text and
arrowheads, this option places both between the
extension lines.  Otherwise, either the text or the
arrowheads are moved based on the best fit.

• When enough space is available for just the text alone,
places text between the extension lines and places
arrowheads outside the extension lines.

• When enough space is available for just arrowheads
alone, the option places them between the extension
lines and places text outside the extension lines.

• When space is available for neither the text nor the
arrowheads, it places them both outside the extension
lines.

Arrows

Moves the arrowheads outside the extension lines first,
followed by the text (DIMATFIT system variable).

• When enough space is available for both the text and
the arrowheads, it places both between the extension
lines.

• When space is available for just the arrowheads alone,
this option places them between the extension lines
and places the text outside them.

• When enough space is not available for the arrowheads,
the option places both text and arrowheads outside
the extension lines.

Text

Moves text outside the extension lines first, followed by
the arrowheads (DIMATFIT system variable).

• When space is available for both the text and the
arrowheads, it places both between the extension lines.

• When space is available for just the text alone, the
option places the text between the extension lines,
whereas the arrowheads are placed outside them.

• When enough space is not available for the text, it
places both the text as well as the arrowheads outside
the extension lines.

Both text and arrows

When enough space is not available for both the text and
the arrowheads, this option moves both outside the
extension lines (DIMATFIT system variable).

Always keep text between ext lines

Always places the text between extension lines.  (DIMTIX
system variable)

Suppress arrows if they don't fit inside extension lines

Suppresses the arrowheads if not enough space is available
inside the extension lines.  (DIMSOXD system variable)

Text placement

Sets the placement of dimension text when it is moved
from the default position, that is, the position defined by
the dimension style.  (DIMTMOVE system variable)

Beside the dimension line

If selected, moves the dimension line whenever dimension
text is moved.  (DIMTMOVE system variable)

Over the dimension line, with leader

If selected, the dimension lines are not moved while the
text is being moved.  If the text is moved away from the
dimension line, a leader line is created connecting the
text to the dimension line.  The leader line is omitted when
the text is too close to the dimension line.  (DIMTMOVE
system variable)

Over the dimension line, without leader

If selected, dimension lines are not moved while the text
is being moved.  The text moved away from the dimension
line is not connected to the dimension line with a leader.
(DIMTMOVE system variable)

Scale for dimension features

Sets the overall dimension scale value or the paper space
scaling.

Annotative

Specifies that the dimension is annotative.  Click the
information icon to learn more about annotative objects.

Scale dimensions to layout

Determines a scale factor based on the scaling between
the current model space viewport and paper space.
(DIMSCALE system variable)

When you work in paper space, but not in a model space
viewport, or when TILEMODE is set to 1, the default scale
factor of 1.0 is used or the DIMSCALE system variable.

Use overall scale of

Sets a scale for all dimension style settings that specify
size, distance, or spacing, including text and arrowhead
sizes.  This scale does not change dimension
measurement values.  (DIMSCALE system variable)

Fine tuning

Provides additional options for placing dimension text.

Place text manually

Ignores any horizontal justification settings and places
the text at the position you specify upon the dimension
line location prompt.  (DIMUPT system variable)
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Draw dim line between ext line

Draws dimension lines between the measured points even
when the arrowheads are placed outside the measured
points.  (DIMTOFL system variable)

Preview

Displays sample dimension images that show the effects
of changes you make to dimension style settings.

Primary Units Tab (Fig 18)

Fig 18

Linear dimensions

Sets the format and precision for linear dimensions.

Unit format

Sets the current units format for all dimension types except
angular.  (DIMLUNIT system variable).

The relative sizes of numbers in stacked fractions are based
on the DIMTFAC system variable (in the same way that
tolerance values use this system variable).

Precision

Displays and sets the number of decimal places in the
dimension text.  (DIMDEC system variable)

Fraction format

Sets the format for fractions.  (DIMFRAC system variable)

Decimal separator

Sets the separator for decimal formats.  (DIMDSEP system
variable)

Round off

Sets rounding rules for dimension measurements for all
dimension types except angular.  If you enter a value of
0.25, all distances are rounded to the nearest 0.25 unit.  If
you enter a value of 1.0, all dimension distances are
rounded to the nearest integer.  The number of digits
displayed after the decimal point depends on the precision
settings.  (DIMRND system variable)

Prefix

Includes a prefix in the dimension text.  You can either
enter a text or use control codes to display special
symbols.  For example, entering the control code %%c
displays the diameter symbol.  When you enter a prefix, it
overrides any default prefixes such as those used in
diameter and radius dimensioning.  (DIMPOST system
variable)

If you specify tolerances, the prefix is added to the
tolerances as well as to the main dimension.

Suffix

Includes a suffix in the dimension text.  You can enter text
or use control codes to display special symbols.  For
example, entering the text mm results in dimension text
similar to that shown in the illustration.  When you enter a
suffix, it overrides any default suffixes.  (DIMPOST system
variable)

If you specify tolerances, the suffix is added to the
tolerances as well as to the main dimension.

Measurement scale

Defines linear scale options.  Applies primarily to legacy
drawings.

Scale factor

Sets a scale factor for linear dimension measurements. It
is recommended that you do not change this value from
the default value of 1.00.   For example, if you enter 2, the
dimension for a 1-inch line is displayed as two inches.
The value does not apply to angular dimensions and is not
applied to rounding values or to the plus or minus tolerance
values.  (DIMLFAC system variable)

Apply to layout dimensions only

Applies the measurement scale factor only to dimensions
created in layout viewport.  Except while using for non-
associative dimensions, this setting should remain
unchecked.  (DIMLFAC system variable)

Zero suppression

Controls the suppression of leading and trailing zeros and
of feet and inches that have a value of zero. (DIMZIN system
variable)

Leading

Suppresses leading zeros in all decimal dimensions.  For
example, 0.5000 becomes.  5000.  Select leading to enable
display of dimension distances less than one unit in sub
units.

Sub-units factor

Sets the number of sub units to a unit.  It is used to calculate
the dimension distance in a sub unit when the distance is
less than one unit.  For example, enter 100 if the suffix is
m and the sub-unit suffix is to display in cm.

Sub-unit suffix

Includes a suffix to the dimension value sub unit.  You can
either enter a text or use control codes to display special
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symbols.  For example, enter cm for .96m to display as
96 cm.

Trailing

Suppresses trailing zeros in all decimal dimensions.  For
example, 12.5000 becomes 12.5, and 30.0000 becomes
30.

0 feet

Suppresses the feet portion of a feet-and-inches dimension
when the distance is less than one foot.  For example, 0*-
6 ½ " becomes 6 ½ ".

0 inches

Suppresses the inches portion of a feet-and-inches
dimension when the distance is an integral number of feet.
For example, 1*-0" becomes 1*.

Angular dimensions

Displays and sets the current angle format for angular
dimensions.

Units format

Sets the angular units format.  (DIMAUNIT system variable)

Precision

Sets the number of decimal places for angular dimensions.
(DIMADEC system variable)

Zero suppression

Controls the suppression of leading and trailing zeros.
(DIMAZIN system variable)

Leading

Suppresses leading zeros in angular decimal dimensions.
For example, 0.5000 becomes .5000.

You can also display dimension distances less than one
unit in sub units.

Trailing

Suppresses trailing zeros in angular decimal dimensions.
For example, 12.5000 becomes 12.5, and 30.0000
becomes 30.

Preview

Displays sample dimension images that show the effects
of changes you make to dimension style settings.

Alternate units tab (Fig 19)

Display alternate units

Adds alternate measurements units to dimension text.
Sets the DIMALT system variable to 1.

Alternate units

Displays and sets the current alternate units format for all
dimension types except angular.

Unit format

Sets the unit format for alternate units.  (DIMALTU system
variable)

Fig 19

The relative sizes of numbers in stacked fractions are based
on DIMTFAC  (in the same way that tolerance values use
this system variable).

Precision

Sets the number of decimal places for alternate units.
(DIMALTD system variable)

Multiplier for alt units

Specifies the multiplier used as the conversion factor
between primary and alternate units.  For example, to
convert inches to millimeters, enter 25.4.  The value has
no effect on angular dimensions, and it is not applied to
the rounding value or the plus or minus tolerance values.
(DIMALTF system variable)

Round Distance to

Sets rounding rules for alternate units for all dimension
types except angular.  If you enter a value of 0.25, all
alternate measurements are rounded to the nearest 0.25
unit.  If you enter a value of 1.0, all dimension
measurements are rounded to the nearest integer.  The
number of digits displayed after the decimal point depends
on the precision setting.  (DIMALTRND  system variable)

Prefix

Includes a prefix in the alternate dimension text.  You can
either enter text or use control codes to display special
symbols.  For example, entering the control code %%c
displays the diameter symbol.  (DIMAPOST system
variable)

Suffix

Includes  a suffix in the alternate dimension text.  You can
either enter text or use control codes to display special
symbols.  For example, entering the text cm results in
dimension text similar to that shown in the illustration.
When you enter a suffix, it overrides any default suffixes.
(DIMAPOST system variable)
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Zero Suppression

Controls the suppression of leading and trailing zeros and
of feet and inches that have a value of zero. (DIMALTZ
system variable)

Leading

Suppresses leading zeros in all decimal dimensions.  For
example, 0.5000 becomes.  5000.

Sub-units factor

Sets the number of sub units to a unit.  It is used to calculate
the dimension distance in a sub unit when the distance is
less than one unit.  For example, enter 100 if the suffix is
m and the sub-unit suffix is to display in cm.

Sub-unit suffix

Includes a suffix to the dimension value sub unit.  You can
enter the text or use control codes to display special
symbols.  For example, enter cm for .96m to display as
96 cm.

Trailing

Suppresses trailing zeros in all decimal dimensions.  For
example, 12.5000 becomes 12.5, and 30.0000 becomes
30.

0 Feet

Suppresses the feet portion of a feet-and-inches dimension
when the distance is less than 1 foot.  For example, 0*-6
1/2" becomes 6 ½ ".

0 Inches

Suppresses the inches portion of a feet-and-inches di-
mension when the distance is an integral number of feet.
For example, 1*-0" becomes 1*.

Placement

Controls the placement of alternate units in the dimension
text.

After primary value

Places alternate units after the primary units in the di-
mension text.

Below primary value

Places alternate units below the primary units in the di-
mension text.

Preview

Displays sample dimension image that show the effects
of changes you make to dimension style settings.

Tolerances tab (Fig 20)

Tolerance format

Controls the tolerance format.

Method

Sets the method for calculating the tolerance.  (DIMTOL
system variable)

• None : this feature does not add a tolerance.  The
DIMTOL system variable is set to 0.

• Symmetrical : Adds a plus/minus expression of toler-
ance in which a single value of variation is applied to
the dimension measurement.  A plus-or-minus sign ap-
pears after the dimension.  Enter the tolerance value in
upper value.  The DIMTOL system variable is set to 1.
The DIMLIM system variable is set to 0.

• Deviation : Adds a plus/minus tolerance expression.
Different plus and minus values of variation are applied
to the dimension measurement.  A plus sign (+) pre-
cedes the tolerance value entered in upper value, and
a minus sign (-) precedes the tolerance value entered
in lower value.  The DIMTOL system variable is set to
1.  The DIMLIM  system variable is set to 0.

• Limits : Creates a limit dimension.  A maximum and a
minimum value are displayed, one over the other.  The
maximum value is the dimension value plus the value
entered in upper value.  The minimum value is the di-
mension value minus the value entered in lower value.
The DIMTOL system variable is set to 0.  The DIMLIM
system variable is set to 1.

• Basic: Creates a basic dimension, which displays a
box around the full extents of the dimension.  The dis-
tance between the text and the box is stored as a
negative value in the DIMGAP system variable.

Precision

Sets the number of decimal places.  (DIMTDEC system
variable)

Upper value

Sets the maximum or upper tolerance value.  When you
select symmetrical in method, this value is used for the
tolerance.  (DIMTP system variable)

Fig 20
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Lower value

Sets the minimum or lower tolerance value.  (DIMTM sys-
tem variable)

Scaling for height

Sets the current height for the tolerance text.  The ratio of
the tolerance height to the main dimension text height is
calculated and stored in the DIMTFAC system variable.

Vertical position

Controls text justification for symmetrical and deviation
tolerances.

• Top : Aligns the tolerance text with the top of the main
dimension text.  When you select this option, the
DIMTOLJ system variable is set to 2.

• Middle : Aligns the tolerance text with the middle of
the main dimension text.  When you select this option,
the DIMTOLJ system variable is set to 1.

• Bottom : Aligns the tolerance text with the bottom of
the main dimension text.  When you select this option,
the DIMTOLJ system variable is set to 0.

Tolerance alignment
Controls the alignment of upper and lower tolerance values
when stacked.

Align decimal separators
Values are stacked by their decimal separators.

Align operational symbols
Values are stacked by their operational symbols.

Zero suppression
Controls the suppression of leading and trailing zeros and
of feet and inches that have a value of zero.  (DIMTZIN
system variable)

Leading
Suppresses  leading zeros in all decimal dimensions.  For
example, 0.5000 becomes .5000.

Trailing
Suppresses trailing zeros in all decimal dimensions.  For
example, 12.5000 becomes 12.5, and 30.0000 becomes
30.

0 Feet
Suppresses the feet portion of a feet-and-inches dimension
when the distance is less than 1 foot.  For example, 0*-6
½ " becomes 6 1/2".

0 Inches
Suppresses the inches portion of a feet-and-inches
dimension when the distance is an integral number of feet.
For example, 1*-0" becomes 1^.

Alternate unit tolerance
Formats alternate tolerance units.

Precision
Displays and sets the number of decimal places.
(DIMALTTD system variable)

Zero suppression

Controls the suppression of leading and trailing zeros and
of feet and inches that have a value of zero.  (DIMALTTZ
system variable)

Leading

Suppresses leading zeros in all decimal dimensions.  For
example, 0.5000 becomes  .5000.

Trailing

Suppresses trailing zeros in all decimal dimensions.  For
example, 12.5000 becomes 12.5, and 30.0000 becomes
30.

0 Feet

Suppresses the feet portion of a feet-and-inches dimension
when the distance is less than 1 foot.  For example, 0**-6
½ " becomes 6 1/2".

0 Inches

Suppresses the inches portion of a feet-and-inches
dimension when the distance is an integral number of feet.
For example, 1*-0" becomes 1^.

Preview

Displays sample dimension images that show the effects
of changes you make to dimension style settings.

Hads on -1

1 Open the given file plan.dwg. (Fig 21)
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2 Set the dimension style as plan. (Fig 22)

Fig 22

3 Set the layer DIMENSION as the current layer.
(Fig 23)

Fig 22

4 Dimension the distance P1 to P2 with linear dimension.

Command: dimlinear (Fig 24)

Specify first extension line origin or <select
object>:<pick on P1>

Specify second extension line origin: <Pick on P2>

Specify dimension line location or [Mtext/Text/Angle/
Horizontal/Vertical/Rotated]: <Drag and click on a
location> (Fig 25)

5 Repeat the steps to complete the dimensioning as
shown in the following image and save the file. (Fig 26)

Hands on - 2

1 Open the file model1.dwg. (Fig 27)

2 Set the dimension style as 'dimension'. (Fig 28)

Fig 28

3 Dimension model with linear dimension as shown in
Fig 29.

4 Use dimension baseline to complete the dimensions
as shown in Fig 30

CCM&RE : Architectural Assistant - Exercise 2.1.11



111CCM&RE : Architectural Assistant - Exercise 2.1.11



112

Command: dimcontinue

Select base dimension: <select the dimension with
text 2>

Specify a second extension line origin or [Undo/Select]
<Select>: <Click on P1>

Dimension text = 28

Specify a second extension line origin or [Undo/Select]
<Select>:<Click on P2>

Dimension text = 10

Specify a second extension line origin or [Undo/Select]
<Select>:<ESC>

5 Use the linear dimension to complete dimension as
shown in Fig 31.

6 Choose radius dimension and complete the
dimensioning like this. (Fig 32)

Command: dimradius

Select arc or circle: <Click on R1 and drag to a point>

Dimension text = 20

Specify dimension line location or [Mtext/Text/Angle]

Choose leader command and make a leader like this.

Command: LEADER

Specify leader start point: <Click on C1>

Specify next point: <Click C2>

Specify next point or [Annotation/Format/Undo]
<Annotation>: <Click C3>

Specify next point or [Annotation/Format/Undo]
<Annotation>: <Press enter>

Enter first line of annotation text or <options>: <In
command line type as 2 x 2>

Enter next line of annotation text: <Press enter>

Command: (Fig 33)

8 Save and exit the drawing file.

Transparency

Displays the transparency dialog box.

Layouts

• Choose the layout 1 TAB at the bottom of the screen.
(Fig 34)

Fig 34

• Change the name of the layout using the layout wizard.

• Change the remaining layout options for page setup
and plots. (Fig 35)

• Paper space layout with one view is shown in Fig 36.

Creating multiple layouts

• Choose the layout 2 TAB at the bottom of the screen.

• Right click on the layout tab, choose new layout.
(Fig 37)

• Change the remaining layout options for page setup
and plots.

CCM&RE : Architectural Assistant - Exercise 2.1.11
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Model space view ports

In large or complex drawings, displaying different views
reduces the time needed to zoom or pan in a single view.
Also, errors you might miss in one view may be apparent
in the others.  Viewports created on the model tab
completely fill the drawing area and do not overlap.  As
you make changes in one viewport, the others are updated
simultaneously.  Three model space viewports are shown
in the illustration.

Tiled viewports let you divide the drawing area into tiles
and display different parts of your drawing in each tile.
The major advantage with tiled viewports in that you can
draw from one viewport to another without missing a best,
expanding them for large drawings where you need to
alternate between working in detail in a small area and
working in a larger area.  In fact, through the use of one
viewport, you can have a view of the entire viewport, and
others for zoomed in details.

You can set up a wide variety of configurations of tiled
viewports, and set the view however you want in each one,
using standard zooming and panning.  But no matter how
you set them, they always occupy the entire drawing area,
unlike floating viewports.

Note : Floating viewports are useful for laying
out a drawing in paper space for plotting.
Whereas, tiled viewports are meant for drawing
and editing.

Only one tiled viewport can be active at a time, and the
crosshairs appear only in the active viewport.  To make a
viewport active, all you have to do is to click inside the
viewport you wish to open.  This being done, you can draw
or edit there, in the same way you usually do in a model
space, when you only have one viewport, which is the
default. (Fig 38)

You can divide a single drawing window into multiple tiled
windows (called viewports) on the model tab.  You can
control the number of windows created and the
arrangement of the windows.  You can also save and restore
named window configurations and display a list of the
current and saved window configurations.

Create multiple views

• Choose view => Viewports.

• In viewports menu, choose 1, 2, 3, or 4 viewports.

CCM&RE : Architectural Assistant - Exercise 2.1.11
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• Type h if you want the horizontal orientation or type v if
you want the vertical orientation.

Command line = VPORTS

You can divide a drawing window into two windows arranged
vertically (A) or horizontally (B); three windows arranged
left (C), right (D), above (E), below (F), vertically (G), or
horizontally (H); or four tiled windows (I). (Fig 39)

Join two views

• Choose view => Viewports => Join.

• Click anywhere inside the window you want to keep.

• Click anywhere inside the adjacent window you want
to join to the first window.

Command line = VPORTS

Name and save a window configuration

• Choose view => Viewports => Save viewports

• Type a configuration name, and then press enter.

The name can be up to 31 characters in length and can
contain letters, numbers, the dollar sign ($), hyphen (-),
and underscore (_).

Command line = VPORTS

Restore a named window configuration

• Type - vports and press ENTER.

• On the command line, type restore.

• Type the name of the window configuration you want to
restore.

Commands reference

VPORTS : Creates multiple viewports

System variables reference

Maxactvp : Sets the maximum number of viewports that
can be active at one time in a layout

Tilemode : Makes the model tab or the last layout tab
current

Cvport : Sets the identification number of the current
viewport

Viewctr : Stores the center of view in the current viewport

Viewsize : Stores the height of the view in the current
viewport.

Mview

The Mview command controls the size and position of
the mview viewports (from now on called mviews).

Mview is to tilemode = 0, as vports is to tilemode = 1.
You can use mview when you would like to have a view of
the model.  Yet for this, pspace mode must be active to
use mview.  AutoCAD will automatically switch to pspace
when you issue the mview command.  The default mview
option is "<<first point>>" to use this option, pick a point
which represents one corner of the mview.  At the "other
corner" prompt, pick a point which represents the opposite
corner of the mview.

• Choose view, Viewports, 1 viewport.

or

Type type Mview at the command prompt.

Command: Mview or Mv

ON/OFF/Hideplot/Fit/2/3/4/Restore/<<First point>>:

P1

Other corner: P2

TIP : Mviews should be created on their own layers in
order to be turned ON/OFF.

Irregular shaped viewports

• Draw a shape in paper space (e.g. circle, polygon,
ellipse)

• Choose view => viewports => object (Fig 40)

• Choose the object to make a viewport.

CCM&RE : Architectural Assistant - Exercise 2.1.11
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Model space and paper space

Mspace (model space) can be activated only when there
is a minimum of one mview.

To enter model space mode use "Mspace".

• Type Mspace at the command prompt.

Command: Mspace or Ms

or

Double - click the word "paper" on the status bar to
toggle to model space.

• Notice the ucs icon will appear in each of the mviews
when you enter modelspace.

Pspace mode should be entered to create a border, a
title, mviews, and annotations only. This environment is
used to lay out a 2 dimensional working drawing suitable
for plotting.  When you plot from pspace, you should plot
1 =1.

• Type Pspace at the command prompt.

Command: Space or Ps

or

Double - click the word "MODEL" on the status bar to
toggle to paper space.

• Notice the pspace icon. (Fig 41)

Scales - zooming in model space

Use zoom "XP" to zoom the model on a certain factor of
the paper.  If you enter a value followed by xp, AutoCAD
specifies the scale relative to paper space units.  For

example, entering .5xp displays model space at half the
scale of paper space units.  If you want to plot the model
at ¼ " = 1', type zoom ¼ 8xp.  If you want to plot a part at
3 times, type zoom 3xp.  Views can also be shown in 3D
by using the Vpoint command.

• Type MS at the command prompt to enter model space
for each individual viewport.

• Type zoom at the command prompt.  Command: Zoom

All/Center/Dynamic/Extents/Previous/Scale (X/XP)/
Window/<Realtime>: 3XP

You can also change the scale from the viewports
toolbar.

Scale1 = 1 scale2= 1Zoom ¼ XP (Fig 42)
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Command Button    Classic menu Ribbon /
alias Application

menu

 Page setup Application Output tab
menu => Print =>Plot panel

                                  => Page Setup =>Page setup

CCM&RE : Architectural Assistant - Exercise 2.1.11

Adding text in paper space

Title block text and miscellaneous text can also be added
in paper space. (Fig 43)

Plotting in paper space

Plotting of all mviews should be done from paper space,
and not from modelspace.  When you plot from pspace,
you should plot1 =1.  For hidden line removals, remember
to use the hideplot option in the mview command.  Once a
zoom scale has been defined, do not zoom again before
plotting.  You can change the display with the pan
command.

Layout wizard

Layout wizard helps to create a new layout with the
following assigned properties.

• Layout name

• Printer

• Paper size

• Paper orientation

• Title block

• Viewports

Viewport layers

Vplayer (Viewport layer) controls layers on and off, and
freeze and thaw, for each mview.  Layer controls the on
and off, freeze and thaw, globally.  Layers must be on and
thawed globally before they can be effected per mview
using vplayer.

• Click in the viewport to change layer status.

• Choose the layer dialog box.

• Highlight the layer to freeze or thaw in the current or
new viewport.

• The layer dialog box also allows control of layers for
each viewport. (Fig 43)

Page setup dialog box

Specifies page layout and plotting device settings.  The
page setup dialog box is displayed in the following cases.

• When you create a new page setup through the page
setup manager
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• When you modify an existing page setup through the
page setup manager

The page setup settings that you specify are stored with
the layout and can be applied to other layouts or imported
into other drawings.

The title of the page setup dialog box also displays the
name of the current layout or sheet set. (Fig 44)

Fig 43

Fig 44



118

Data :
Ground floor - Foyer

Verandah
1 bed room
Living
Stairs
Dining
Kitchen
Sitout
Utility

First floor - Family
Stairs
Terrace
2 bed room
2 attach toilet
1 dress

Note: There is no book of rules for design. The
original idea behind the sketch is called the
concept of design. The mental ideas helps to

1 Identify the purpose of the object (building)

2 Analyse the aesthetic and functional aspects

3 Think a good solution (design)

The trainer has to give a specific plot size
for design or the trainee can select a plot
size and indicate north point and road
selection.

The trainees must workout 2 or 3 such
options of bubble diagram for practice.

PROCEDURE

TASK 1 :

1 Firstly you have to determine the space requirements
based on your needs and requirements.

2 The second step is to plot the boundary baded on the
given plot size as shown in Fig 1 in 1:100 scale.

3 Mark the set backs based on the building byelaws.

4 Mark the Road direction and north point. (Fig 1)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.12

Design bubble diagram (manual)
Objectives: At the end of this exercise you shall be able to
• determine space requirements by gathering information
• develop alternative solutions for bubble diagram
• select the final solutions from the bubble diagram.
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TASK 2 :

1 Develop a spatial bubble flow diagram based on the
information gathered, and within the space left after
marking set backs.

2 Show the spatial relationship of the spaces between
each other, their relative size and patterns connecting
the spaces as shown in Fig 2 & 3

3 Several bubble diagram may be used to illustrate pos-
sible solutions.

4 You must make connections between rooms as per
circulation movement.

5 These should define the linkages between the different
spaces and you must differentiate between the more
public and private areas.

6 Develop ground floor and first floor in relation to the
spaces and position of staircase has to be same.

7 It is then best to convert the bubble diagram which
best suits you into the concept design. (Fig 2 & Fig 3)

You can also colour the different spaces with
different colours for better representation.

CCM&RE : Architectural Assistant - Exercise 2.1.12
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Data :
Ground floor - Foyer

Verandah
1 bed room
Living
Stairs
Dining
Kitchen
Sitout
Utility

First floor - Family
Stairs
Terrace
2 bed room
2 attach toilet
1 dress

PROCEDURE

TASK 1 :

1 Conceptual design should be started with respect to
the bubble diagram designed in the previous exercise.

2 To make the plan, put the established facts of the site
its shape and existing features-down on paper.

3 Use a simple scale, say 1:100 and you could use a
graph paper, which in fenths, or a grid of one me be
might be easier.

4 Plot the boundary, take guide lines from an established
point.

5 Mark the views you wish to keep, positon the spaces
according to the need for Pricacy, easy access, wind
movement, cross ventilation, circulation etc.

6 Now evolve a satisfactory pattern on a tracing paper
put over this plan in an amalgamation of the two.

7 Complete the concept design as shown in Fig 1&2.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.13

Development of conceptual design (Manual)
Objectives: At the end of this exercise you shall be able to
• orient the spaces according to the bubble diagram
• design the spaces considering the surrounding built and open spaces
• define the linkage between different spaces
• position the spaces according to the need for privacy easy access, wind movement, cross ventilation,

pathway, etc.
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PROCEDURE

TASK 1 : Design single line ground floor plan (Fig 1)

1 With reference to the conceptual plan, single line
ground floor plan has to be developed.

2 Make  the scheme over a 2 X 2 grid to define the plan
and to work from the inside out.

3 Adjustments to the rooms and spces have to be made
on the grid.

4 Natural ventilation to the rooms must be achieved by
designing windows and ventilators opposite to each
other.

5 The kitchen and dining room must be close to each
other.

6 The staircase must be approachable from the
maximum number of rooms.

7 The passage area must be minimum, well ventilated
and sufficiently well it.

8 Location of the main door has to be easily accessible
from the main road.

9 The visualisation of elevation should always be kept in
mind while preparing a plan.

10 While drawing the line plan, the elevation of all the 4
sides as well as the perspective view from the road
should be kept in mind.

11 An effect of spaciousness within comparatively limited
dimension can be achieved by skilful treatment of form,
colour natural and artifitial lighting and all the elements
of furnishing.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.14

Design single line ground floor plan(Manual) & first floor plan
Objectives: At the end of this exercise you shall be able to
• convert the conceptual design into a single line plan
• indicate the positions of doors and windows
• orient the spaces of individual rooms with proper dimensions
• check and modify the dimensions of units with reference to the consideration of roominess.
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TASK 2 : Design single line first floor plan

1 While designing first floor plan take reference from
ground floor for where ever walls can over lap.

2 All the areas and room spaces should be designed
taking into consideration the purpose for which they
will be used.

3 All the rooms should be well-ventilted.

4 Bed rooms may be with attach toilet and dress where
ever possible.

5 The line plan with reference to the site plan, shape of
the plot, north direction, wind and rain directions, main
road and surrounding views etc should be kept in mind
while designing bedrooms and terraces or balcony.

6 Complete the plan as shown in Fig 2.

CCM&RE : Architectural Assistant - Exercise 2.1.14
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PROCEDURE

TASK 1 : Assign layers and colours and line weight

1 Start the autocad applications and start a new
drawing.

2 Save the file as plans with some reference and in a
new folder.

3 Set  units in metric and make the plan in millimeters.

4 Before starting the drawing set all layers to the materi-
als used for the drawing.

5 For architectural drawing set layer as follows.

     Layer Colour    Line weight Line type

    A-Wall Red    0.35 Continous

A-DWV Green            0.15 Continous

A-Text Black    0.15 Continous

A - Above 08    0.15 Acad------

A-boundary Magenta    0.35 Continous

A-ele-1 Blue    0.20 Continous

A-Layout Black             0.20 Continous

TASK 2 : Draw the preliminary ground floor plan

1 Mark the plot as per the given site size.

2 Mark the offset as per building byelaws.

3 With reference to the single line diagram convert the
plan into wall diagram with 230mm as exterior wall
thickness and 115 as internal wall thickness. (Fig 1)

4 Draw the doors and windows in the marked positions.

5 Use appropriate layers for walls, DWV, Text etc.

6 Complete the ground floor plan as shown in Fig 2.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.15

Draw preliminary ground floor plan(CAD) and first floor plan
Objectives: At the end of this exercise you shall be able to
• assign layers and its colour and appropriate line weight to different materials used
• convert the single line plan into a conventional plan
• complete the preliminary ground floor plan in CAD with all doors and windows.
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TASK 3 : Draw the preliminary first floor plan

1 The first floor plan should be drawn with reference to
the walls given in the ground floor plan.

2 Draw the arrangement of rooms as designed in the
single line diagram. (Fig 3)

3 Wherever necessary the ground floor walls and first
floor walls need to the matched.

4 Mark all the doors and windows in positions.

5 The drawing in CAD has to be done in 1:1 scale.

6 Indicate the staircase up and down with proper break
lines.

7 Complete the first floor plan as shown in Fig 4.

CCM&RE : Architectural Assistant - Exercise 2.1.15
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PROCEDURE

TASK 1 : Organization of interior space (manual)

1 Print the previously drawn ground floor plan & first floor
plan.

2 Economic utilisation of space is very important in
designing interior.

3 Where should be minimum circulation area and best
use of avilable space for the activity to be performed.

4 Minimum number of doors and partitions should be
considered for free flow of space and spacious look.

5 To get a spacious look select limited variaty of
textures, patterns and colours.

6 The ‘Interior activity diagram’ should be drawn showing
the division of interior spaces with proper circulation.

7 Where should be acoustical and visual barries between
entry and private area.

8 While designing seating for living  room L-shaped or
U-shaped seating makes the most economical use of
space because it can accomodate a large group of
people, leaving ample circulation space.

9 Do not clutter a small space with more items than
needed.

10 Low seating helps in making  the room look larger.

11 The dining table could be circular or rectangular.

12 Work Triangles consists of the three essential elements
in the kitchen; the clean up or sink area, the cooking
centre, the mixing centre and the refrigeration centre.

13 Width of the kitchen plat form should be 600mm.

14 The position of the bed depends on a number of
factors. The window should be parallel to the bed
position.

15 The window should not be over the head.

16 The toilet can be divided into two types of areas-the
dry area including the sink and the toilet and a wet
area, which includes the bathing area. In well-planned
toilets, you must separate these two areas.

17 Some cabinets or open shelves must be placed in the
bathroom for storage.

18 With all consideration of furnitures and fixtures
complete the sketch of organisation of space planning
as Fig 1 & Fig 2.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.16

Draw final ground floor and first floor plans with furniture layout
rendered(CAD)
Objectives: At the end of this exercise you shall be able to
• design the interior layout for the residence plan
• render the plan and all furnitures with pleasing colours
• dimension and name the plan completely.
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TASK 2 : Rendering ground floor and first floor plan with furniture layout

1 With reference to the organisation plan, the detailed
furniture layout should be designed.

2 Choosing colour scheme should be considered care-
fully while rendering the plans and furnitures.

3 For the living room a single solid colour on the floor, or
unpatterned floors tend to sketch the space. These
include stone, tiles, wood etc.

4 Lighter the shade and the moe reflective the surface,
the more effective it will be in lightening up the room.

5 For dining avoid using carpet below the table.

6 Use the same flooring material as in the living.

7 For kitchen you can choose from a variety of tiles and
stones.

8 Any type of flooring can be used in the bedroom-from
carpet to wood flooring to tiles or ferazzo.

9 You must combine the shape, colour, texture for furni-
ture to provide a pleasing environment, which will truly
rejunvenate and refresh you.

10 Concrete, brick paving, slate, unpolished kota, sand-
stone are effective floor materials for the porch, out
door sit out, inner courtyard, terraces and balconies.

11 Plan the garden simultaneously with the house so that
the levels of drive way, terraces are co-ordinated.

12 The amount of soft surfacing (Lawn or ground cover)
should be considered in designing the landscape.

13 Complete the drawing in colour as per Fig 3 & 4.

CCM&RE : Architectural Assistant - Exercise 2.1.16
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Data :

Floor to floor height = 3000 mm

Plinth height      = 450 mm

Parapet height      = 1000 mm

Staircase headroom height = 2400 mm

PROCEDURE

TASK 1 : Design front elevation and side elevation(manual)

1 The first step in elevation design is to choose an
architectural style.

2 Sketch the outline of an exterior wall showing the roof
shape and the position of doors, windows and other
key features.

3 Create a series of progressive sketches to develope
an elevation design.

4 Experiment with different roof styles, doors and
window designs, siding materials for the exterior walls,
overhangs, roof materials, etc.

5 Sketches can also show various architectural styles
derived from the same floor.

6 Sufficient roof over hang should be provided to afford
protection from the sun, rain and snow.

7 The portion facing the road side is considered as front
elevation and any left or right side is considered as
side elevation.

8 Plan window height to allow for furniture and built in
components that are placed near windows.

9 Windows can be detailed to represent the exact type
of window called for in this design.

10 Door, windows or other openings should be uniform in
design and located to present a symmetrical
appearance to the elevation except where the variations
are an integral and necessary part of the exterior design.

11 Roof and roof lines should be continuous in design
except where there is a major change in an element of
a building elevation.  Such elements include wind walls,
fanwalls and interior building corners.

12 Roof line elements including parapet walls should be
developed along all elevations, regardless of
orientation away from sheets or towards a neighbouring
structure.

13 No mechanical equipment, dueting, meters or other
elements should be left exposed at the ground level or
on roofs.

14 Attachments in the form of pergolas, verandahs,
screens improve the visual look of a house through
layering and increasing perceived depth of facades in
their shadowing effects.

15 The general form and style of attachments should
enhance the visual look of the house and not detract
from it.

16 With consideration of all the element in to design
complete the sketches an per Fig 1 & Fig 2.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.17

Design development of front elevation and one side elevation(Manual)
Objectives: At the end of this exercise you shall be able to
• design the front elevation based on the designed plan
• design the side elevation based on the designed plan.
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PROCEDURE

TASK 1 : Draft the front elevation (CAD)

1 Using the floor plan, project the vertical lines that
represent the main lines of the building.

2 These lines show the overall length or width of the
building.

3 When projecting an elevation on a cad system, use
the grid pick junction to project the major lines from
the floor plan to the elevation plan.

4 Measure and project horizontal lines that represent the
height of the ground line, doors, top & bottom of
windows and other key features.

5 Add details and symbols, such as indicating door and
window bim, mullions, roofing materials, etc.

6 Represent textures or features as designed in front
elevation.

7 Complete the front elevation with all the details as shown
in Fig 1.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.18

Draft front elevation and side elevation (CAD)
Objectives: At the end of this exercise you shall be able to
• draft the front elevation in CAD
• draft the side elevation in CAD.

TASK 2 : Side elevation - CAD

1 During the drawing process floor plans can be rotated
900 to position for side elevation.

2 Follow the same procedure as TASK 1 and complete
the side elevation as shown in Fig 2.
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PROCEDURE

TASK 1 : Render fornt elevation and side elevation

1 A rendered elevation is often used as a presentation
drawing to help show the shape of the structure.

2 Using CAD you can add patterns representing building
materials or shading to your drawing.

3 For the main building light colours should be used since
dark colours make the building look dull and
condensed.

4 Feature elements should be identified and different
materials or colours may be choosen.

5 For doors and windows use shades of brown and for
glass use gradient of light blue.

6 The elevation can be enhanced by adding bees, shrubs,
people, sky, cars, etc.

7 The outline of the building needs to be dark and all the
hatches and colours need to light.

8 The use of texture in design must be carefully
considered in combination with the use of colour.

9 Different colours for hatches can also be used.

10 Prepare a layout individually for front elevation and side
elevation.

11 Complete the rendering of front elevation and side
elevation as shown in Fig 1 & Fig 2.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.19

Draw final front elevation and one side elevation with rendering (CAD)
Objectives: At the end of this exercise you shall be able to
• render the front elevation (CAD)
• render side elevation (CAD).
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PROCEDURE

TASK 1 : Section of the building

1 Mark the section plane in plan in such a way that max
details can be viewed through.

2 Once the section line is marked, project lines
perpendicular from the floor plan outline at each
corner.

3 Add ceiling lines and floor lines to give each wall its
specified height.

4 Once the features of the walls are projected to the
section from the floor plan, dimensions, instructional
notes and additional features can be added to the
drawing.

5 Interior elevations provide a great amount of detail the
height of all cabinets, shelving, ledges, railing, wall
lamps, fixtures, mirror, furnitures, etc.

6 The vertical dimensions are as important as horizontal
dimensions are on floor plan.

7 Many dimensions on a section drawings show the
vertical distance from a datum line.

8 Vertical dimensions should be read from the right side
of the drawing.

9 Levels to be dimensioned should be labeled with a note
or term.

10 Room heights are shown by dimensioning from the floor
line to the ceiling line.

11 The depth of the footing is shown as break in midway.

12 Heights of windows and doors are dimensioned from
the floor line to the top of the window or door.

13 Windows and doors may be indexed by a code or a
symbol to a door or window schedule.

14 Dimensions for small or obscure areas should be
indexed to a separate detail.

15 Floor and ceiling lines are shown with hidden lines.

16 Thickness of slabs are dimensionel.

17 Overall height are placed on the outside of sub
dimensions.

18 Complete the drawing as shown in Fig 1.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.20

Develop section of the building (CAD)
Objectives: At the end of this exercise you shall be able to
• develop the section of the building in CAD
• place the section in a layout.
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PROCEDURE

TASK 1 : Rendered section of the building

1 Using CAD you can add patterns representing various
building materials or shading to your drawing.

2 Slabs can be of solid hatch and black in colour.

3 Walls can be solid hatch of red colour or brick symbol.

4 The flooring concrete can be indicated by hatching
concrete symbol.

5 The colours for walls should be choosen with proper
considerations mostly light shades are preferred.

6 The furnitures should be hatched with patterns or
colours.

7 Elements like shrubs, lamp post, fan, vase etc. can
also be added to enhance the section.

8 For doors and windows use shades of brown and for
glass use gradient of light blue.

9 To enhance the section trees, shrubs, people, sky, etc.
can be added.

10 The use of texture in design should be considered in
combination with the use of colour.

11 Prepare a layout individually and place the drawing.

12 Complete the rendering of the section as shown in Fig.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.1.21

Draw final section of the building with rendering (CAD)
Objectives: At the end of this exercise you shall be able to
• render the section in CAD
• place the section in a layout.
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PROCEDURE

Exercise No 2.1 to 2.4

Draw the elevations of Flat arch semi circular arch, semi
elliptical arch and venetian arch.

Exercise No: 2.1 (Flat arch)

Draw the elevation of Flat arch (gauged type)

Width of opening = 1200 mm

The depth or height of arch = 300 mm

Angle of the skewback = 600

Rise of the arch at the middle = 12 mm

Width of each voussoir at extrados = 100 mm

Thickness of mortar joints = 10 mm

• Draw the opening to a width 1200 mm and to a conve-
nient height by indicating the break line.

• Draw the skewback at an angle of 600 on both sides of
opening.

• Draw a line parallel to the top of opening at a distance
of 300mm for fixing the height of the arch.

• Project the skewback lines backwards to findout the
centre ‘c’ of the arch.

• Mark the width of voussoirs on top of extrados. Join
these points with the arch centre to draw voussoirs.

• Draw the brick layers in elevation on both sides of the
opening and top of the arch.

• Complete the elevation of flat gauged arch as shown
in Fig 1.

Exercise No:2.2 (Semi circular arch):
Draw the elevation of semi circular arch
Width of opening = 1200 mm
The depth or height of arch = 2 rings. = 200 mm
Angle of skewback = 00 (i.e horizontal)
Rise of the arch at the middle = 1/2 span of opening

        = 600 mm
Width of each voussoir at extrados = 100mm
Thickness of mortar joints = 10mm
Procedure
• Draw the opening to a width of 1200 mm
• Draw the springing line and mark the centre of arch

• Draw the intrados with a radius of 600 mm and extrados
with  a radius of 800 mm from the arch centre.

• Draw the voussoirs as detailed in Fig 2 (Left side half
elevation is made with purpose made bricks with 2
rings and the right half elevation is made with gauged
bricks).The arch may be constructed with two rings of
purpose made bricks of single ring of structure.

• Draw the elevation of remaining wall and complete the
drawing as shown in Fig 2

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.01

Drawing of different types of arches
Objectives: At the end of this exercise you shall be able to
• Draw the elevation of

• flat Arch
• semi circular Arch
• semi Elliptical Arch (with five centres) and
• venetian Arch.
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Exercise No:2.3 (Semi Elliptical arch with five cen-
tres):

Draw the elevation of semi Elliptical arch with five centres

Width of opening = 1800 mm

The depth or height of arch = 300 mm

Angle of the skew back = 00 (ie horizontal)

• Draw the opening to a width of 1800 mm
• Draw the springing line AB and divide it into 5 equal

parts A1 = 1 C = CD = D5 = 5B
From the Centre A and B draw arc of radius equal to
the span, to intersect at 3.  Join the point 3 with C and
D.

• From the centres 1 and 5, draw arcs of radius equal to
3/5th of span, meeting each other at point E.

• Join points 1 and E. The point of intersection of lines
3C and E1 is 2. Similarly join 5 and E. The point of
intersection of lines 3D and E5 is 4

• The points 1,2,3,4 and 5 represent five centres of the
arch.

• Draw the left half elevation as axed arch and the right
half elevation as rough arch.

• Draw the arrangement of voussoirs and the remaining
elevation of wall as shown in Fig 3.

The depth or height or arch at skewback = 200 mm

• Draw the springing line AB to 1200mm length.

• From the midpoint of AB, mark the rise at C.

• Join AC and BC to complete the triangle ABC

• Draw the skewback AD and BE on eitherside to a
length 200 mm

• Draw DF parallel to AC and EF parallel to BC to Com-
plete the triangle DEF.

• Draw perpendicular bisectors for AC and BC. They meet
the springing line at r1 and r2 which are centre points
to draw intrados.

• Similarly draw perpendicular bisectors for DF and EF.
Let them meet the springing line at R1 and R2 which
are centre points to draw extrados.

• Draw intrados with centres r1 and r2 and extrados with
centres R1 and R2 as shown in the figure 4.

• Draw the voussoirs

Complete the remaining elevation as shown in Fig 5.

Exercise No. 2.4 (Venetian arch)

Draw the elevation of venetian arch

Width of opening = 1200 mm

Rise = 900 mm

CCM&RE : Architectural Assistant - Exercise 2.2.01
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PROCEDURE

Exercise No 2.1 to 2.4

Draw various views of wooden, stone, brick, steel and
R.C.C. lintel

• Draw a span of 1000mm

• Draw 100 mm thick wooden Lintel

• Draw bearing of Lintel 100 mm

• Draw three bolt and nuts in elevation

• Draw three courses of Brick masonry on the top of the
wooden Lintel

• Draw a section at AA

• Draw a section of wall 300 mm

• Draw and develop the section at AA

• Draw convensional symbols

• Complete the drawing as shown in Fig 1.

Exercise No: 2.2 Stone Lintel

The size of stone Lintel 220 mm

Draw the elevation of stone Lintel similar to wooden Lintel

Draw bearing of Lintel 250 mm (Fig 2)

• Draw the elevation of wall

• Draw brick Lintel width of brick 100 mm and depth of
brick 300 mm

• Draw and develop the brick Lintel as shown in Fig 3.

• Similarly Draw another form of brick Lintel as shown in
Fig 4

• width of brick 100 mm and

• depth of brick 150 mm.

Exercise No. 2.4

Steel Lintel :(Fig .5,6,7)

Size of Rolled steel Joist

Indian standard medium Weight beam (ISMB) 150 x 80 -
14.9 Kg - 1 No.

Indian standard Junior beam (ISJB)

175 x 50 - 8.1Kg.

• Draw a span of 2500 mm

• Draw ISMB 150 x 80 - 1No. at the middle of the wall.

• Draw Bearing 150 mm on both sides.

• Draw three courses of brick masonry on the top of the
lintel (Fig 5)

Exercise No.2.3 (Brick lintel)

• Draw the elevation of brick Lintel

• Draw a span of 1000 mm

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.02

Drawing of different types of lintels
Objectives: At the end of this exercise you shall be able to
• draw the elevation and section of wooden lintel
• draw the elevation of brick lintel
• draw the elevation and section of stone lintel
• draw the section of R.C.C lintel and details of bars.
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Exercise No: 2.5  R.C.C Lintel

• Draw a span of 2500 mm

• Draw a depth of beam 220 mm

• Draw a bearing of Lintel 200 mm

• Draw a bent up bar 300mm from L/7 both supports -
1 No.

• Draw straight bar at bottom of Lintel 16mm f - 2 Nos.

• Draw anchor bar at Top of Lintel 16mm  f - 2 Nos.

• Draw stirrup 6 mm  f uniformly spaced 360 mm c/c
Fig 8

• Draw a section view of steel beam. (Fig 6)

• Draw and develop multiple units of I - section connected
with pipe separator. (Fig 7)

• Draw a section at AA (Fig 9)

• Draw the details bar bending. (Fig 10)

• Complete the drawing.

CCM&RE : Architectural Assistant - Exercise 2.2.02
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PROCEDURE

TASK 1 : Draw the plan of a straight stair

Draw the plan and elevation of a straight stair from floor to
floor

Data

Height betweeen the floors : 3000

The rise and going : 150 and 300 respectively

Total no of steps in the flight : as per the rule

Width of the flight : 1000

Diameter of GI pipe handrail : 50

Diameter of newel post GI pipe : 25

Height of the baluster : 900

Width of the handrail : 50

Size of the window : 1000 x 1200

Note : No of risers -3 (min) & 12 maximum (all
dimensions are in mm).

1 Draw the plan of the with proper number of treads.

2 Draw the landing after twelve risers.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.03

Draw plan and elevation of  straight stairs
Objectives: At the end of this exercise you shall be able to
• draw the plan and elevation of a straight stair.

3 Draw the treads (8nos) after the landing.

4 Dimensions the drawing properly. (Fig 1)

TASK 2 : Draw the elevation of the straight stair

1 Draw  the projected vertical lines to mark the risers.

2 Draw the vertical lines to show the baluster.

3 Draw the handrail as per the drawing.

4 Draw the elevation of the window.

5 Dimension the drawing properly. (Fig 2)
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PROCEDURE

TASK 1 : Draw the plan of on open well stair

Size of teh window : 1900 x 1200

Size of the well : 2400 x 500

Note : No of risers - 3 (min) & 12 maximum (all
dimensions are in mm)

1 Draw the plan of the stair room with proper numbner of
treads.

2 Draw the landing.

3 Draw the treads in the reverse direction with open well.

4 Draw the window opening.

5 Dimensions and the drawing properly.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.04

Draw plan and elevation of open well stairs
Objectives: At the end of this exercise you shall be able to
• draw the plan and elevation of a open well stairs.

Data

Height between the floors : 3000

Rise and going 150 and 300 respectively

Total no of steps in the flight as per the rule

Width of the flight : 1000

Width of the wall : 300

Diameter of GI pipe handrail : 50

Height of the baluster : 900

Width of the handrail : 50
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TASK 2 : Draw the elevation of the open well stair

1 Draw the projected vertical lines to mark the sectional
elevatin of the first flight.

2 Draw the vertical lines to show the elevation.

3 Draw the handrail, nosing, window and reinforcement
details as per the drawing.

4 Complete the drawing with proper dimensioning.

CCM&RE : Architectural Assistant - Exercise 2.2.04
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PROCEDURE

TASK 1 : Draw the plan and elevation of a bifurcated stair from floor to floor

Data

Height between the floors : 3000

Rise and going 150 and 300 respectively

Total no of steps in the flight as per the rule

Width of the flight : 1000

Diameter of GI pipe handrail : 50

Height of the baluster : 900

Note : No of risers - 3 (min) & 12 maximum (all
dimensions are in mm)

1 Draw the plan of the stair with proper number of treads.

2 Draw the landing after risers.

3 Drawt the treads (8nos) after the landing in both right
and left sides.

4 Draw the handrail in plan.

5 Dimensions and the drawing properly. (Fig 1)

Draw the elevation of the bifurcated stair

1 Draw the  projected vertical lines to mark the risers.

2 Draw the vertical lines to mark the baluster.

3 Draw the handrail details as per the drawing.

4 Draw the elevation of the handrail in both directions.

5 Dimension the drawing properly. (Fig 1)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.05

Draw plan and elevation of bifurcated stairs
Objectives: At the end of this exercise you shall be able to
• draw the plan and elevation of bifurcated stair.
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PROCEDURE

TASK 1 : Draw the plan of geometrical stair

Data

Height between the floors : 3000

Rise and going 150 and 300 respectively

Total no of steps in the flight as per the rule

Width of the flight : 900

Diameter of GI pipe handrail : 50

Height of the baluster : 900

Width of the handrail : 50

Size of the window : 1000 x 1200

Note: No of risers - 3 (min) & 12 maximum (all
dimensions are in mm)

1 Draw the plan of the stair and treads.

2 Draw the radiating treads from the centre.

3 Draw the handrail and window in plan.

4 Complete the drawing with necessary dimensioning.

Draw the elevation of the geometrical stair

1 Draw the  projected vertical lines to show the risers.

2 Draw the vertical lines to show the baluster.

3 Draw the handrail, window as  per the drawing.

4 Draw the elevation of the window.

5 Dimension the drawing properly. (Fig 1)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.06

Draw plan and elevation of geometrical stair
Objectives: At the end of this exercise you shall be able to
• draw the plan and elevation of a geometrical stair.
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PROCEDURE

TASK 1 : Draw the plan of circular stair

2 Draw the radiating treads from the centre.

3 Draw the handrail in plan.

4 Complete the drawing with necessary dimensioning.
(Fig 1)

Draw the elevation of the circular  stair

1 Draw the  projected vertical lines to show the risers.

2 Draw the vertical lines to show the baluster.

3 Draw the handrail, and as per the details in drawing.

4 Draw the details of handrail and balusters in enlarged
scale.

5 Dimension the drawing properly. (Fig 2)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.07

Draw plan and elevation of circular stair
Objectives: At the end of this exercise you shall be able to
• draw the plan and elevation of a circular stair.

Data

Height between the floors : 3000

Width of the flight : 900

Diameter of GI pipe handrail : 50

Height of the baluster : 900

Width of the flight : 50

Rise and going 173.6 and 300 respectively

Total no of steps in the flight as per the rule.

Note : No of risers - 3 (min) & 12 maximum (all
dimensions are in mm)

1 Draw the plan of the stair with the given diameter.
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PROCEDURE

TASK 1 : Draw the plan of doglegged stair

Data

Height between the floors : 3000

Rise and going 150 and 300 respectively

Total no of steps in the flight as per the rule

Width of the flight : 1000

Diameter of GI pipe handrail : 50

Height of the baluster : 900

Width of the handrail : 50

Size of the window : 2000 x 1200

Note: No of risers - 3 (min) & 12 maximum (all
dimensions are in mm)

1 Draw the plan of the stair room with proper number of
treads.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.08

Draw the construction details of RCC dog legged stairs
Objectives: At the end of this exercise you shall be able to
• draw the plan and elevation of a RCC doglegged stair.

2 Draw the landing after twelve risers.

3 Draw the treads in the reverse direction after the landing.

4 Draw the window in plan.

5 Dimension the drawing properly. (Fig 1)

Draw the elevation of the doglegged stair

1 Draw the  sectional elevation of the stair as per the
drawing.

2 Draw the vertical lines showing the baluster.

3 Draw the handrail and sectional details as per the
drawing.

4 Draw the elevation of the window.

5 Dimension the drawing properly. (Fig 2 & Fig 3)
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PROCEDURE

TASK 1 : Draw the plan of a MS spiral stair

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.09

Draw the construction details of MS spiral stairs
Objectives: At the end of this exercise you shall be able to
• draw the plan and elevation of MS spiral stairs.

Data

Rise and going 150 and 250 respectively

Total no of steps in the flight 15

Diameter of the stair : 900

Diameter of the central post : 250

Height of the baluster : 900

Width of the handrail : 50

1 Draw the plan of the column of specified radius.

2 Draw the outer circle.

3 Draw the winders radiating from the centre.

4 Draw the handrail in plan.

5 Comlete the draing with necessary dimensioning.

Draw the elevation of the spiral stair

1 Draw the projected vertical lines to show the risers
around the central column.

2 Draw the vertical lines showing the baluster.

3 Draw the vertical  lines to show the baluster, handrail
as per the drawing.

4 Complete the elevation of the spiral stair.

5 Complete the drawing with necessary dimensioning.
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PROCEDURE

TASK 1 : Draw the plan and sectional elevation of wooden straight flight stair and also draw the details.

• Draw the length of stair case 2640mm

• Draw the width of stair 900mm

• Draw length of going 220 mm ( 1 to 13 Nos) (Fig 1,2)

• Draw projection of Nosing 16mm

• Draw one brick thick wall on both sides.

• Complete the drawing of plan (300 x 32mm)

• Draw strings on both sides of wall

• Draw section Elevation at KK (Fig 1)

• Draw tread and riser (220 to 200mm)

• Draw 1 to 13 steps (upto landing)

• Draw the ceiling height 2600mm

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.10

Draw details of wooden stairs
Objectives: At the end of this exercise you shall be able to
• draw plan and sectional elevation of wooden straight flight stair
• draw the details of steps, landing and hand rails
• draw plan and sectional elevation of wooden dog-legged stair
• draw the details of landing and steps.

• Draw the hand rails parallel to strings (height 840mm)

• Draw stud partition under the 5th step

• Draw R.C.C lintel 15cm thick below 13th step

• Draw a wooden joist (225 x 75mm) above R.C.C lintel.

• Complete the drawing of straight flight wooden stair
(Fig 1,2)

• Draw the details at ‘M’ (Fig 3)

• Draw the details at ‘L -L’ (Fig 4)

• Draw the details of Handrail (Fig 5,6)
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TASK 2 : Draw the plan and sectional elevation of Dog-logged wooden stair case

• Plan of Dog-logged stair case (Fig 7) • Draw the width of stair 1830 mm

• Draw the length of first flight 1575mm

• Draw 8 Nos going to size of 225mm

• Draw Two Newel post 100 x 100 mm

• one at starting place another at landing

• Draw the width of Half space landing of size 1140mm

• Draw the another flight in opposite direction.

• Draw Half space landing 1090 mm

• Draw 7 steps in second flight of length 1350mm

• Draw 6 Nos Joist in half space landing (100 x 50mm)

• Draw 6 Nos Floor joist (225 x 50)

• Draw a trimmer joist below the floor joist (225 x 75)

• Draw wall thickness 300mm thick. (Fig 8)

• Draw and develop sectional elevation at KK (Fig 7)

• Draw and develop section at ‘LL’ (Fig 4,9)

• Draw and develop section Tread and Rise. (Fig 3,8)

CCM&RE : Architectural Assistant - Exercise 2.2.10
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PROCEDURE

TASK 1 : Components of ground floor

• Draw 230mm wall with 2.5cm DPC at plinth level along
with stone foundation 450mm thick below.

• Draw sub floor total  depth of 925 mm.

• Bottom soling is 40mm aggregate/random rubble of
150mm.

• Rammed earth filling 600mm thick.

• Flat brick soling 75mm thick (when black cotton soil is
present).

• Base of 100mm  thick cement concrete in 1:4:8 and
smeared with 1:2: 4 concrete.

• Draw floor covering or flooring of 20mm thick of clossed
tile granite / marble.

• Draw  skirting of same flooring. (Fig 1)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.11

Draw the different components of floor
Objectives: At the end of this exercise you shall be able to
• draw the detail of floor, components.

TASK 2 : Draw the isometric view of flooring (Fig 2)

• Data : Stone size - 300 x 50 x 20mm  bedjoint - 15mm
thick.

• Draw the isometric view of  flooring.
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PROCEDURE

TASK 1 : Details of cement concrete floor

TASK 2 : Detail of wooden suspended floor (ground floor)

• Draw 230mm wall with foundation detail. (Fig 2 & Fig
3)

• Draw base concrete bed 1:2:4 15cm to 20cm thick
which laid below 1m level from ground

• Draw a layer of mastic asphalt through out the width of
wall immediately below wall plate and also on sleeper
wall

• Draw sleeper walls of one brick thickness constructed
at centre to centre  distance of 1:2m to 1.5m.

• Draw the bridging joists should rest on wall plates 125
x 75mm.

• Carity space 25mm for expansion of material

• Draw floor boarding 18mm thick as covering with
widening joints

• Air bricks and voids in sleeper walls provide ventilation.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.12

Draw the details of cement concrete floor
Objectives: At the end of this exercise you shall be able to
• draw the detail of cement concrete floor
• draw section of supported type timber floor along with isometric view.

• Draw the section of wall at plinth level

• Draw the base of flooring with

• Cement concrete bed of 1: 4: 8 100mm thick

• Draw  40mm thick finished floor covering of 1:2:4 cement
concrete. (Fig 1)
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TASK 1 : Plan showing arrangements of supporting boarding in a wooden double floor

• Draw the plan of 4.0 meter width room.

• Consider 230mm wall thickness and hatch the wall.

• Draw the binders of size 75 x 150mm with a gap of
900mm.

• Draw the bridging joist of 60 x 100mm at 300 mm c/c
distance.

• Indicate the boarding as shown in Fig 1 and complete
the drawing.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.13

Draw the details of wooden floor (Upper floor)
Objectives: At the end of this exercise you shall be able to
• draw the plan showing arrangements of supporting boarding in a wooden double floor
• details showing different methods of supporting bridging joists
• section through a framed floor.

TASK 2 : Sections at AA & BB

• Mark the section AA and BB in plan

• Draw the section at AA showing wall plate, binders,
fillets next to binders etc

• Draw the ceiling joist and bridging joists

• Draw the boarding on top of the bridging joist as shown
in Fig 2a and complete the drawing

• Draw the section at BB showing the bridging joist in
section

• Draw the stone bed plate fixed in the wall for supporting
the binders

• Draw the ceiling joist, fillets, boardings etc as shown
in Fig 2b and complete the drawing.
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TASK 1 : Draw the section of lean to roof

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.14

Draw lean to roof details
Objectives: At the end of this exercise you shall be able to
• draw the elevations of lean to roof.

Draw the section of lean- to roof to a scale of 20

Data required

Span of the roof  : 2400 mm

Thickness of the main wall : 230mm

Cross section size of wall plate  : 150 x 100 mm (verandah
wall)

Cross section size of rafter : 125 x 75 mm

Cross section size of battens : 50 x 30 mm at 350 mm C/
C

Cross  section size of eave boards : 25 x 125mm

Eave projection : 300 mm

Pitch of the roof : 30° or 1/3rd of the span

• Draw the main wall and verandah wall with the given
span.

• Draw the wall plate on the top of the verandah wall.

• Draw the rafter at angle 30° to the horizontal.

• Draw the corbel in themain wall at the meeting point of
the rafter and the wall.

• Draw the battens above the rafter at angle 30° to the
horizontal.

• Draw the corbel in the main wall at the meeting point of
the rafter and the wall.

• Draw the battens above the rafter.

• Draw the roof tiles above the battens.

• Draw the eave board and gutter at the end of the rafter.

• Complete the drawing with proper dimensioning.
(Fig 1)
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TASK 1 : Draw the section of flat roof with brick tile flooring

1 Painting the roof slab uniformly with a layer of hot
bitumen spread at the rate of 1.70 kg of bitumen per sq
m of roof surface.

2 Spreading immediately coarse sand at the rate of 0.6
cu.m. of sand per 100 sq m of roof surrface,  when the
bitumen is still hot.

3 Laying 10cm thick (average) mud phuska  the slope
for the proper drainage of roof  being given to this layer.
The slope should not be less than I  in 40.

4 Plastering the consolidated layer of mud phuska with
a 13 mm thick coat of mug gobri mortar  3:1 (3 mud : 1
cowdung).  (Fig 1)

5 Laying tile bricks flat on the plastered surface and
grouting the joints with cement mortar 1:3.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.15

Draw flat roof details
Objectives: At the end of this exercise you shall be able to
• draw the section of flat roof with brick tile flooring
• draw the section of flat roof with file flooring & mud phuska.

TASK 2 : Draw the section of flat roof with brick tile flooring and mud phuska

1 Painting the top of roof uniformly with layer of hot
bitumark

2 Spreading immediately, coarse sand at the rate  of 0.6
cu.m of sand per 100 sq m of roof surface when the
bitumen is still hot.

3 Laying lime concrete in an average thickness of 10cm.
The slope for proper drainage of roof being given to the
lime concrete layer

4 Laying two courses of tiles (with breaking joints) over
the compacted later of lime concrete in cement  mortar
1:3 Thickness of each course of tile varies from 13 to
20mm.  Instead of the flat tiles,  precast  concrete tiles
or 25mm thick Shahabad stone  can also be used
depending upon availability and cost.
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TASK 1 :

Data

Spacing between the purlins 1:65m maximum

Minimum endlap : 16 cm

Overhang at the ridges  : 75

Side lap    : 1/2 corrugation minimum (All dimensions in
mm)

• Draw the purlins at the given spacing.

• Draw the corrugated sheets as per the drawing.

• Complete the drawing with proper dimensioning as
shown in Fig 1.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.16

Draw the fixing details of AC sheets and corrugated sheets
Objectives: At the end of this exercise you shall be able to
• draw the planning fixing details of asbetos sheet and corrugated sheets
• draw the section of fixing of asbestos sheet
• draw the fixing of screws and bolts.

TASK 2 : Draw the section of fixing of Asbestos sheet

• Draw the section of purlins.

• Draw the asbestos and corrugated sheets as shown in
Fig 2.

• Complete the drawing with proper dimensioning.
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TASK 3 : Draw the section of fixing of Asbestos sheet

• Draw the 6.1 hook  bolt with bitumen washers

• Draw the J-hook bolt with Asbestos washers and lead
washers

• Draw the 6.1 croach screw

• Complete the drawing as shown in Fig 3.

CCM&RE : Architectural Assistant - Exercise 2.2.16



183

PROCEDURE

• Draw the view of king post Truss Fig 1

• Draw given span length Details of king post truss

• Draw Details of Joint in King post Fig 1

• Draw sectional view of king post truss Fig 1.

Draw the view of King post truss (Fig 1)

• Draw a horizontal line take some else and its ends of
support a draw vertical line to below the horizontal line.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.17

Draw details of king post truss
Objectives: At the end of this exercise you shall be able to
• draw line diagram of king post truss
• draw king post truss 8m span length
• draw detail of each joint in king post truss.

• Draw a pitch of 30’ inclined at both ends horizontal
line.

• Draw the inclined line to parallel certain interval.

• Draw a vertical line to middle of horizontal line.

• Draw a inclined line to vertical line pitch of 30’ at both
side.

• Draw a ridge pices at end of  top (or) crown To show
Roof covering, cleat, sectional view of purlin. Principal
rafter and common rafter as an shown in Fig.

Draw details at ‘B’ of king post

• Draw the exercise  as  same.

• Draw Dimentional sketch of each part of king post truss
strut and tie beam (Fig 2)
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• Draw the detail of stirrup strap (Fig 3)

• Complete the drawing.

• Draw the detail at ‘C’ of King post Truss (Fig 4)

• Draw wall thickness

• Draw Tie beam and principle rafter

• Draw common rafter and setaing of mangalore tiles

• Draw connection of Bolt

• Complete the drawing as shown in Fig 3.

• Draw the details at ‘A’

• Draw King post and principal rafter

• Draw common rafter and ridges

• Complete the drawing as shown in Fig 5.

• Draw the details at ‘D’

• Draw the drawing as shown in Fig (5a)

CCM&RE : Architectural Assistant - Exercise 2.2.17
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PROCEDURE

Diagram of span length 8000 to 12000 mm

• Draw the elevation of Queen post truss of span length
8000 to 12000 mm

• Draw the details drawing of Queen post truss. Span up
to length 11000 mm

Data:

Span 11,000 mm

Wall thickness 500 mm

Bed plate 400 x 300 x 150

Parapet 300 mm

Rain water pipe f 20 mm

Tie beam 150 x 250 mm

Queen Post 180 x 150 mm

Straining sill 50 x 150 mm

Straining beam 180 x 150 mm

Strut 100 x 150 mm

Cleat 180 x 80 mm

Roof Boarding 25 x 150 mm

Purlin 100 x 180 mm

Dia of Bolt 20 mm

• Draw Horizontal line 11000 mm to draw two wall thick-
ness.

• Draw 300 inclined to pitch of horizontal line to both ends.
it will form a triangle shape

• Horizontal line to divide three equal points 1,2 put mark
it. Draw vertical line above it. The vertical line cut in the
inclined line in both side, That it cutting point connect
a horizontal line. This line is called springer beam and
below it called tie beam. It will shown in Fig 26.1

• Complete the drawing as shown in Fig 1.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.18

Draw details of queen post truss
Objectives: At the end of this exercise you shall be able to
• draw queen post truss elevation
• draw queen post truss detail.
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• Draw Gutter and rain water pipe as shown in Fig 2.

• Details of Queen post truss at ‘B’.

• Draw the length of straining beam

• Draw inclined member of common rafter and principal
rafter

• Draw connection of stirrup and purlin

• Complete the drawing as shown in Fig 3.

•  Draw the details at ‘C’ of Queen post truss

•  Draw the length of tie beam

•  Draw vertical Queen post

•  Draw straining sill

•  Draw incline member of strut

•  Draw the connection of strap

•  Complete the drawing as shown in Fig 4.

Draw details at ‘A’ of Queen post truss

• Draw a Horizontal member of tie beam and inclined
member of principal rafter and common rafter.

• Draw wall thickness and bed plate.

CCM&RE : Architectural Assistant - Exercise 2.2.18
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PROCEDURE

Draw Elevation of steel Roof Truss of span 6000 mm

Data

Tie beam 60 x 60 x 6mm

Principle Rafter 75 x 75 x 6mm

Purlin 100 x 75 x 10mm

Gusset plate 10mm thick

Bearing plate 20mm thick

Lewis Bolt 30mm f, 200mm long

Pitch of Roof 300

Wall thickness 300mm

• Draw a horizontal centre line 6300 mm

• Draw on both side 300 pitch to form a traingle

• Draw a 600 line from ridge towards Tie beam

• Draw a 900 line from principle rafter on both sides

• Complete the shape of central line

• Draw the thickness of each member

• Draw the Riveted joints with gusset plate

• Draw purlin on each side at on the top of the principle
rafter at ridge, Junction of strut and at bottom of prin-
ciple rafter.

• Draw the support of wall thickness

• Draw c.c Block, Bearing plate, gusset plate

• Draw a line roof covering sheet on both side.

• Complete the Drawing of steel Roof Truss (Fig 1)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.2.19

Draw details of steel roof truss
Objectives: At the end of this exercise you shall be able to
• draw the elevation of steel roof truss
• draw the details of steel roof truss
• draw the elevation of north light roof truss
• draw the elevation tabular steel roof truss
• draw the details of tubular steel roof truss.

• Draw and develop the following Details of joints at fixed
end (Fig 2, 3, 4)

• Draw the elevation of North Light Roof Truss (Fig 27.5)
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Data

All L angle 50 x 50 x 6mm

Gusset plates 10mm thick

• Draw a span of 7200 mm as Centre line

• Draw Rise of Roof 3600 mm as centre line

• Draw and complete the Triangle

• Draw inclined line from ridge to Tie beam at an angle of
600

• Draw inclined line from Tie beam to principle rafter at
angle of 600

• Draw parallel line to Tie beam at point B

• Draw perpendicular line from principle raftes to the point
C and D

• Complete the drawing of North light Roof truss (Fig 5)

• Draw enlarged Details at B,C and D

• Draw the elevation of Tubular Roof Truss

Data

Dia of principal rafter 150mm

Dia of Tube 50mm (All strut)

Dia. of Tube 60mm (Tie beam) plate 6mm thick

Size of (R.S.J) ISMB 550 x 190 - 103.7Kg/m

• Draw a span of 10000mm length

• Rise of Roof 1/4 of span.

• Complete the Drawing of tubular steel Roof Truss

• Draw the symbol of welded Joints (Fig 6)

• Draw the enlarge details of at A,B,C and at E (Fig 7, 8,
9 and 10)

CCM&RE : Architectural Assistant - Exercise 2.2.19
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PROCEDURE

Draw  an overhead tank on the terrace of size  1500x200
(size varies according to the number of occupancy of
residence/building). This water over head water tank meets
demand of water of domestic consumption as well as fr
fire fighting requirments Fig 3.

Water supply from the municipal is first collected in under
ground tank 400 x 800 x 1250 of capacity  4000 litres then
the water is pumped to overhead tank for distribution  to
various  floors by gravity (Fig 1)

Draw  a pump house of size 3000 x 300 from where water
is pumped up to the overhead tank for distribution to different
floors (Fig 2)

Draw GI pipe (down take pipe) from overhead tank to various
floors connecting to every floor to supply water is toilets
and kitchen.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.3.01

Water supply for toilet and kitchen
Objectives: At the end of this exercise you shall be able to
• draft the details of underground as well as overhead water tank
• draft the plan showing the pipes connecting the tank and distributing water to  respective floors.
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PROCEDURE

Draw the floor trap under the wash basin to collect waste
water

Draw the dia pipe connecting floor trap to gully trap

Draw 100 dia CI pipe connecting W.C to the man hole

Draw 75 dia pipe  (rain water pipe from terrace)to the gully
trap which the gets connected to man hole.

Draw a man hole of size 900 x  800 x 700 deep where all
soil and waste water gets tollected which the connects to
main man hole and then to the main sewer line (refer Fig 1
& Fig 2)

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.3.02

Water supply for toilet and kitchen
Objectives: At the end of this exercise you shall be able to
• connection of pipes (soil and waste pipes)
• location of floor traps
• connectivity of all pipes to main man hole.
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PROCEDURE

TASK 1 :

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.3.03

Draw gully trap, detail
Objectives: At the end of this exercise you shall be able to
• draft  the gully trap detail with referance to waste water pipe brick work  slope maintained  in the pipes also

PCC structure.

Requirements

Tools/Instruments

• Drawing board
• T square
• Set squares

• Drawing sheet
• Pencil
• Eraser
• Metric  scale

Draw 300 x 300mm size of gully trap with brick wall of 115
thick. The trap again connects to IC  (Inspection  chamber
or man hole)

TASK 2 :

Draw section at “AA” of gully trap the depth of the trap is
675 mm which has the fixtures of 75mm HCI or PVC)
waste and vent pipe, 300 x 300mm CI cover), cast iron
(CI) covering.
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PROCEDURE

TASK 1 : Metric Scale

Draw the sectional plan of chamber of size 180 x 180cm
and depth of the 150 cm depth. The portion of the chamber
may be made smaller by controlling the brick mansory by
laping 5cm (1/4th)(20 x 10 x 10) Brick  mason  of walls a
shown in the drawing.

The manhole cover is put on the RCC slab covering the
hole so reduced in size of 50cms thickness of the brick
masonry all round the manhole is of (20 x 10 x10) brick.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.3.04

Draw manhole detail
Objectives: At the end of this exercise you shall be able to
• draft the manhole details with main sewers.

Requirements

Tools/Instruments

• Drawing board
• T square
• Set squares

• Drawing sheet
• Pencil
• Eraser
• Metric  scale

Alternatively this  may be done by concreting or using a
pre fabricated concrete elements of this square shape or
circular type also. (Fig 1)

TASK 2 : Draw the sectional  elevation with the depth of 150cm.

Draw the section of refilled pit for recharging
borewell of different layers.

a) 40 mm aggregate : 1.5m depth

b) 20 mm aggregate : 0.60 m

c) Course sand : 0.60 m

d) Fine sand : 0.30 m

Draw the casing pipe 0.15m should be left to ground.

Draw isometric view of percolation pit (Fig 2)

Man hole of depth 1.5m

Full shallow manholes a chamber with vertical walls and
covered with a slab, shall suffice. When the depth
increases to 1.5m,  the entry  portion of the chamber may

be made smalled by corbeling the brick  masnory of the
walls, as shown in this drawing. The method of corbelling
involves projecting the bricks  of successive  courses by a
distance not exceeding 1/4 of its length and reducing the
opening as shown. The manhole cover  is put on the RCC
slab covering the hole,  so reduced in size.

The sectional  plan shows the chamber of size 120cm x
50 cm opening for the  manhole. The corbelling is done on
three sides. The fourth side is the verical wall, on which
the rungs are fixed. The two  sections of the manhole give
details of the construction, arranged of rungs and the
position of drains with benching. The  corbelling of brick is
the easiest method of reducing the size of the opening.
Alternatively this may be done by  concreting or using a
prefabricated concrete element of this shape. (Fig 3)
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PROCEDURE

• Draw siteplan with toilet, kitchen firtures.

• Draw plumbing service lines of soild  pipe vent pipe
which  laid in slope.

• Draw gully traps along with Inspection chambers
(manhole) every junction.

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.3.05

Draw site plan showing building services
Objectives: At the end of this exercise you shall be able to
• draw siteplan showing manhole, I.C. and building service.

Requirements

Tools/Instruments

• Drawing board
• T square

• Pencil

• Draw the connecting line to main sewer line.

• Draw gas pipe line which supply from out source.
(Fig 1)
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PROCEDURE

TASK 1 :

• Draw rain water storage tank size of 2100 x 1800 of
brick work with water proof.

TASK 2 : Draw rainwater harvest, structure recharging borewell.

• Draw the section of refilled pit for recharging borewell
of different  layers

40mm aggregate : 1.5 m depth

20mm aggregate : 0.60.m depth

Construction, Construction Material & Real Estate
Architectural Assistant            Exercise 2.3.06

Draw rainwater harvesting details
Objectives: At the end of this exercise you shall be able to
• detail rainwater harvest pit and recycling the water.

Requirements

Tools/Instruments

• Drawing board A3 size
• T square

• Pencil
• Eraser

• Draw sectional detail of tank with filter and out let.

course sand : 0.60 m

Fine sand : 0.30m

• Draw the casing pipe 0.15 m should be  left to ground

• Draw Isometric view of per location pit.
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